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絵表示の例 

 
△記号は注意（警告を含む）を促す内容があることを告げるものです。 

 ○記号は禁止の行為であることを告げるものです。 

 図の中に具体的な禁止内容（左図の場合は分解禁止）が描かれています。 

●記号は行為を強制し指示する内容を告げるものです。図の中に具体的な指示内容（左

図の場合は電源プラグをコンセントから抜け）が描かれています。 

 

 

 

 

 

 

 

 

警告 

■ 仕様の電源電圧以外の電圧で使用しない 

仕様の電源電圧以外の電圧で使用しないで下さい。火災・感電の原因となります。 

この表示を無視して、誤った取扱いをすると、人が傷害を負う可能性が想定される内容 

および物的損害の発生が想定される内容を示しています。 

■ 適さない設置場所 

次のような場所に置かないで下さい。火災、感電やけがの原因となることがあります。 

・調理台や加湿器のそばなど油煙や湯気があたる場所 ・湿気やほこりの多い場所 

・ぐらついた台の上や傾いた所など不安定な場所 ・直射日光があたる場所 

■ 通風孔をふさがない 

通風孔をふさぐと内部に熱がこもり、火災の原因となることがあります。 

注意 

■ 長期間ご使用にならないときは 

長期間この機器をご使用にならないときは、安全のため電源の供給を絶って下さい。 

電源コードの上に重いものをのせ、コードが本機の下敷きにならないようにして下さい。コードを傷つけたり、加工した

り、無理に曲げたり、ねじったり、引っ張ったり、加熱したりしないで下さい。火災・感電の原因となります。 

この表示を無視して、誤った取扱いをすると、人が死亡または重傷を負う可能性が想定される内容を示しています。 

■ 異常が起きたら 

万一、煙が出ている、変なにおいや音がするなどの異常状態のまま使用すると、火災・感電の原因となります。すぐに

機器本体の電源スイッチを切り、電源の供給を絶って下さい。煙が出なくなるのを確認して当社サービス部門に修理

をご依頼下さい。 

■ カバーを開けない 

この機器のカバーは絶対に外さないで下さい。感電の原因となります。内部の点検・修理は当社サービス部門にご依

頼下さい。この機器を改造しないで下さい。火災・感電の原因となります。 

■ 内部に異物や水などを入れない 

この機器の通風孔などから内部に金属類や燃えやすいものなどを差し込んだり、落とし込んだりしないで下さい。また、

花びんや水などの入った容器をこの機器の上に置かないで下さい。こぼれて中に入った場合、火災・感電の原因となり

ます。 

■ 電源コードを傷つけない 

 



 

 

 

 

 

 

 

 

 

 

 

 

本装置に生じた故障または不具合につきましては、ティアック株式会社（以下、

弊社といいます）所定のサービス基準に基づき、修理若しくは交換させて頂きま

す。本装置の故障または不具合に起因する弊社の損害賠償責任は、いかなる

場合も、本装置の修理若しくは交換に限らせて頂きます。但し、製造物責任法

に基づき製造者が負うべき賠償責任には、上記制限は適用されません。 

 

ここに記載されております製品に関する情報、諸データは、あくまで一例を示すも

のであり、これらに関します第三者の知的財産権、およびその他の権利に対して、

権利侵害がないことの保証を示すものではございません。従いまして、上記第三

者の知的財産権の侵害の責任、又は、これらの製品の使用により発生する責

任につきましては、弊社はその責を負いかねますのでご了承ください。 

 

この取扱説明書に記載されております図や内容は、2010 年 1 月現在のもので、

LX Navi Ver3.18 をもとに記述されています。 

 

 

注 意 

この装置は、情報処理装置等電波障害自主規制協議会（VCCI）の基準に

基づくクラス A 情報技術装置です。この装置を家庭環境で使用すると電波妨

害を引き起こすことがあります。この場合には使用者が適切な対策を講ずるよ

う要求されることがあります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

● その他、記載されている会社名、製品名は各社の商標または登録商

標です。 

● 本書の内容については将来予告なしに変更することがあります。 

● TAFFMAT はティアック株式会社の登録商標です。 

● Microsoft, Windows, Windows Vista および Windows 7 は、米国 
Microsoft Corporation の、米国、日本およびその他の国における登

録商標または商標です。 

● インテル および Pentium は、アメリカ合衆国およびその他の国における 
Intel Corporation の商標です。 

 



 

 

 

 

本製品に付属のソフトウエアは、お客様が以下のソフトウエア使用契約の条件に同意されることを前提とし

て、ティアック株式会社（以下、弊社といいます）よりご使用を許諾するものです。万一、同意頂けない場合

は、パッケージ全てをご購入店へご返却下さい。購入代金を返金させて頂きます。お客様が以下のソフトウ

エア使用契約の条件に違反されますと、弊社の権利を侵害することになり、以降のご使用の停止、また、損

害賠償等の請求対象となりますことをご承知おき下さい。 

 

 

 

 

 

 

 

 

 

■ ソフトウエア使用契約 
 

1. 本契約は、お客様が本ソフトウエアのインストールを開始したときから発効します。 

ご同意頂けない場合は、インストールをしないで下さい。既にインストール済みの場合は直ちにソフトウエアの

実行を終了し、アンインストールして下さい。 

2. 弊社は、本ソフトウエアを弊社製レコーディングユニット LX シリーズと組み合わせて「使用」する権利をお客様

に許諾します。 

3. お客様が本ソフトウエアを取得されたことは、本ソフトウエア契約に規定された以外に本ソフトウエアのいかなる

権利、権原若しくは利権の取得を意味するものではありません。お客様は、本ソフトウエアが弊社に帰属する

著作物として、「万国著作権条約」または「文学的および美術的著作物保護に関するベルヌ条約」の加盟

国の著作権法に基づき保護されることをご認識下さい。本ソフトウエアの著作権は、弊社または弊社への供

給者に帰属しております。 

4. (1) お客様は、本ソフトウエアをバックアップ以外の用途で複製することはできません。 

(2) お客様は、本ソフトウエアの解析をしたり、コンパイラ言語やアセンブラ言語に変換したりすることはできま

せん。 

(3) お客様は、本ソフトウエアを弊社の事前承諾無く、第三者に譲渡することはできません。 

5. 弊社は、本ソフトウエアが所定の環境下において、弊社が明示した動作をすることは確認しておりますが、本

ソフトウエアが、お客様の特定の使用目的に適合するか否か、また、本ソフトウエアの動作が中断しないことや

誤りの無いことを保証するものではありません。 

6. 弊社は、本ソフトウエアの使用や使用不能から生じたいかなる損害（事業上の損失、営業の中断、営業上

の情報の損失、その他の金銭上の損害等）についても責任を負いません。たとえその損害の可能性が弊社に

事前に知らされていたとしても同様です。 

 

上記契約に関し、ご不明な点等ございましたら、下記宛にご連絡下さい。 

 

 
ティアック株式会社 情報機器事業部 BS ビジネスユニット 営業部 

 〒206-8530 東京都多摩市落合 1-47  
 

 
 TEL ： 042-356-9161 

 
 FAX ： 042-356-9185 
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リビジョン 章 タイトル 変更内容 

D00986300A   （初版） 

D00986300B 2 プログラムの起動／ 

LX Network ダイアログを表示せず

直接 Navi を起動する 

Navi が直接立ち上がる条件及び、LX Network ダイアログを強制的

に表示する方法の記述を追加。 

－ ソフトウエア使用契約 本社の住所・電話番号 変更。 

4 入力アンプの設定／ 

PA アンプ AR-LXPA100 

Bal/Unbal のボタンについての注意で、”Unbal が選択されると、DC 

OFF FLAT の選択のみ有効です。”という内容を削除し、”AC 結合

で 4mA が設定されている時は Bal の設定はできません。” という内

容を追加。 

D00986300C 

7 ユーザー登録のおすすめ 本社の住所・電話番号 変更。 

D00986300D 1 サンプリング周波数とチャネル数 最大アナログ記録チャネル数修正。 

D00986300E 1 使用上の注意 動作検証済みのコンパクトフラッシュカードの更新。 

1 使用上の注意 動作検証済みのコンパクトフラッシュカードの更新。 

2 PC の要件 OS の条件に Windows Vista 追加。 

D00986300F 

2 LX-100 シリーズ (IEEE 1394 モ

デル)のインストール 

Windows Vista の場合の記述を追加。 

2 PC の要件 PC の要件の注意事項の内容追加。 

5 PC 記録する場合の記録先指定

の注意 

PC 記録する場合の記録先指定の注意を追加。 

D00986300G 

5 リピートモードの設定 Repeat Count の最大値を 65534 に修正。 

2 
PC の要件 

推奨要件のメモリー: 1 GB 以上に変更 

OS の条件に Windows 7 追加。 

2 LX-100 シリーズ (IEEE 1394 モ

デル)のインストール 

LX-Series 1394 Driver のインストール方法の変更。 

D00986300H 

4 TEDS 機能を利用した感度設定 TEDS 情報の一覧表画面にセンサタイプの項目追加、およびセンサ

感度の情報を小数点表記から指数表記に変更。対応している

TEDS テンプレートの表を追加。 

2 PC の要件 OS の条件に Windows 7 64Bit 版 [LAN モデル限定] を追加。 D00986300 I 

5 データを音で聞く 記録中のモニターチャネルのデータを本体内蔵スピーカから再生する

機能を追加 
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第1章 はじめに 
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概要 

 概要 
LX-100 シリーズ計測用レコーダは、16 ビット AD の場合、最大 48 kHz サンプリング、8 チャネルの信号を PC カードメディア

に記録し、再生することができます。8 チャネルカードタイプの入力アンプカードの組み合わせにより、本体で最大 16 チャネル、

さらにオプションの拡張ユニットを使用して最大 32 チャネル記録ができます。記録データは、内蔵メモリー、または PC カードに

記録できる他、PC と接続することでPC ファイルとして保存することができます。ファイルのフォーマットは弊社レコーダに共通の

TAFFmat 形式で、市販の解析ソフトウエアで読み込むことができます。 

 

入力レンジやサンプリング周波数など記録条件の設定は、付属のソフトウエア LX Navi を用いて PC から行います。PC との

インタフェースは IEEE 1394 ですので、設定後に電源を入れたまま LX 本体を切り離し、本体のボタンで記録を開始・停止

することができます。また、PC とのインタフェースとして 100BASE-TX LAN を選択することもできます。記録条件設定後、イ

ンタフェース経由で PC と接続したまま LX Navi で記録・再生の操作をすることも可能です。 

 

設定・記録・再生操作・バーグラフによるモニターのできるカラーLCD 付きリモートコントロールユニットをオプションとして用意

いたしました。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PC カードアダプタ + コンパクトフラッシュ 

PC カードスロット

IEEE1394 

または LAN 

Test0001.dat 

入力 

出力 

リモートコントロールユニット 

〈システム概念図〉 

LX-100 シリーズ 

入力アンプ 

出力アンプ 

メモリー 

PC カード 

ダイレクト 
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特長 

 特長 
■ 入出力アンプ 

本体に 2 スロット、オプションの拡張ユニットを使用してさらに 2 スロット入出力アンプカード用のスロットが用意されています。 

入出力アンプカードは 8 チャネル単位で次の選択ができます。 

DC 入力アンプカード:  電圧入力、または外付けアンプからの電圧出力を入力する場合に使用します。 

PA アンプ入力カード:  電圧入力の他、聴感補正フィルタを内蔵した電圧出力型加速度センサ等の直結が可能な 

アンプカードです。 

ST アンプ入力カード:  歪みゲージ（フルブリッジ）や、ゲージタイプのセンサに対応したアンプカードです。電圧入力も 

      可能です。 

アナログ出力アンプカード: アナログ信号再生を行うためのアンプカードです。 

 

■ 記録モード 

本体には、PC カードドライブの内蔵が可能です。 

メモリー記録: 64MB(オプションで拡張メモリーを追加して最大 576MB)の内蔵メモリーに記録します。 

   記録後にメディアまたは PC にデータを転送することができます。 

PC カード記録: PC カード（コンパクトフラッシュ+PC カードアダプタ）に記録したデータは、そのまま PC の PC カードスロット

から読み込むことができます。FAT32 のサポートにより PC カードは最大 16GB までのメディアが使用可能

です。 

PC 記録:  直接 PC にデータを転送し記録します。 

メモリーまたはメディアに記録しながら PC にデータを転送することや、メモリーに記録後、自動的にメディアに保存することもで

きます。 

 

■ 量子化ビット数 

100dB のダイナミックレンジを実現する 24 ビット AD と従来よりの 16 ビット AD の選択が可能です。 

 

■ サンプリング周波数系列 

96 kHz、低速サンプリングの 2 つのサンプリング周波数系列に対応した LX-110 に加えて、102.4 kHz、100 kHz、96 kHz、

65.536 kHz、低速サンプリングの 5 つのサンプリング周波数系列に対応した LX-120 を用意しました。 

 

■ PC とのインタフェース 

高速データ転送が可能な IEEE1394、またはネットワーク環境で使用可能な 100BASE-TX LAN を選択することができま

す。 

 

■ リアルタイムモニター 

記録中のデータを PC 画面上でリアルタイムにモニターすることができます。波形、バーグラフ、ディジタル値の表示が可能です。

メモリーまたはメディアからの再生データも表示できます。 

 

■ さまざまな記録トリガ 

マニュアル:  手動で記録を開始します。 

レベルトリガ: 指定チャネルのレベル変化を検知して記録を開始します。 

外部トリガ:  外部の接点信号をトリガにして記録を開始します。 

プリトリガ:  レベルトリガ、外部トリガにより記録開始条件が成立する前のデータもバッファにたくわえて記録します。 

ポストトリガ:  レベルトリガ、外部トリガにより記録停止条件が成立してからも、一定時間記録を続けます。 

インターバル動作: 指定時刻に記録を開始・停止することを指定回数だけ繰り返します。 
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特長 

■ イベントマーク 

記録中のデータに目印となるマークをつけられます。再生時にこのマークをサーチすることもできます。 

 

■ メモ音声の録音・再生 

マイクロホンアンプとスピーカを内蔵していますので、メモ音声を録音・再生することができます。 

 

■ 複数台の同期記録（オプション） 

オプション機能として同期接続することにより最大 4 台（マスター機 1 台、スレーブ機 3 台）での同期記録が可能です。 

 

■ カメラ映像の同期記録（オプション） 

4ch のカメラ映像を収録できるビジュアルレコーダー”AQ-VU”を接続することにより映像との同期記録が可能です。 
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TAFFmat について 

 TAFFmatについて 
TAFFmat は Teac data Acquisition File Format の略で、A/D 変換したデータを書き込むデータファイル（バイナリ形式、拡

張子「dat」）と、記録条件などを書き込むヘッダファイル（テキスト形式、拡張子「hdr」）からなります。 

 

本機で記録を開始してから一時停止または停止するまでに取り込むひとまとまりのデータを本書では「ID」と呼びます。この ID

ごとにデータファイルとヘッダファイルがそれぞれ１つずつ記録されます。さらに、メモ音声を録音した場合はメモ音声ファイル（拡

張子「wav」）が記録されます。 

 

これらのファイル名は共通で、このファイル名に「ID番号」がつきます。このID番号は新たなファイル名を指定すると「1」になり、

記録を開始するたびにこの番号が１つずつ自動的にインクリメントします。 

 

 

 

 

 

 

 

 

AD 変換されたデータは 16 ビット AD の場合－32768～＋32767 の 2 バイト整数値、24 ビット AD の場合－8388608～＋

8388607 の 4 バイト整数値として記録されます。負数は 2 の補数で表わされます。バイト順は下位バイト→上位バイトの順

です。データの順は第 1 サンプリングのチャネル順→第 2 サンプリングのチャネル順→ … →最終サンプリングのチャネル順と

なります。 

LX-100 シリーズでは、入力レンジの±100%が、16 ビット AD 値で±25000、24 ビット AD 値で±6400000 に相当します。 

 

１回のサンプリングで取り込まれるひとかたまりのデータを本書では「スキャン」と呼びます。データファイルはこのスキャンの繰り

返しです。 

 

【例】サンプリング周波数 6 kHz 時の１スキャンのデータ 

 

 

 

 

 

 

 

 

 

 

記録待機 

REC 
開始 

FWD 
一時停止 

PAUSE 
再開 停止 

FWD STOP

Aaaaa002.dat 
Aaaaa002.hdr 

Aaaaa001.dat 
Aaaaa001.hdr 

データの順序 

ch 1 
ch 2 
ch 3 
ch 4 
ch 5 
ch 6 
ch 7 
ch 8 

1/6000 秒 
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使用上の注意 

 使用上の注意 
■ UPS 使用のおすすめ 

AC アダプタで使用される場合は、停電から大切なデータを守るために、UPS（無停電電源装置）の使用をおすすめします。

メディアがドライブに入っている状態で電源が切れると、そのメディアに記録したデータを読めなくなることがあります。 

オプションのバッテリユニットを使用すると瞬停時の動作バックアップが可能です。 

 

■ 指定メディアについて 

PC カードの場合、当社にて検証済みの PC カードおよびコンパクトフラッシュカード(当社までお問い合わせ下さい)をご使用

下さい。 これ以外のメディアでは正常に記録・再生できないことがあります。 

 

動作検証済みのコンパクトフラッシュカード (2009 年 2 月現在) 

シリーズ 容量 型番 シリーズ 容量 型番 

サンディスク株式会社 レキサー・メディア株式会社 

スタンダード 4GB SDCFB-4096-J60NS 1GB CF1GB-80-380 

1GB SDCFH-1024-903 2GB CF2GB-133-810 

SDCFH-2048-903 

Professional 

4GB CF4GB-133-380 
2GB 

SDCFH-002G-J61 PlatinumⅡ 2GB CF2GB-80-810 

4GB SDCFH-4096-903 株式会社アイ・オー・データ機器 

Ultra II 

8GB SDCFH-008G-J61 CFX 256MB CFX-256M 

1GB SDCFX3-1024-903 CF40 1GB CF40-1G 

SDCFX3-2048-903 8GB CF115-8G 
2GB 

SDCFX3-002G-J21A 4GB CF115-4G 

SDCFX3-4096-903 

CF115 

2GB CF115-2G 

SDCFX3-004G-J31 株式会社バッファロー 4GB 

SDCFX3-004G-J31A 256MB RCF-G256M 

SDCFX3-8192-903 
RCF-G 

1GB RCF-G1G 

SDCFX3-008G-J31 RCF-R 2GB RCF-R2G 8GB 

SDCFX3-008G-J31A 株式会社ハギワラシスコム 

SDCFX3-016G-J31 1GB HPC-CF1GZP 

Extreme III 

16GB 
SDCFX3-016G-J31A 

Z-Pro 
2GB HPC-CF2GZP 

Extreme IV 4GB SDCFX4-4096-903  

■ メディアを取り出してから電源を切る 

LX 本体の電源を切る前に PC カードを取り出して下さい。もし書き込み中に電源を切ると、そのメディアに記録したデータを

読めなくなることがあります。また、LX 本体を移動する場合はメディアを取り出して下さい。挿入したまま持ち運ぶと故障の

原因になります。 

 

■ メディアの取り出し 

メディアの挿入および取り出しは、必ず REC モードの STOP 状態で、MEDIA READY と表示されている事を確認して行っ

て下さい。 

 

■ Windows のファイル操作で記録されたファイルの一部削除や名前の変更は行わない 

Windows のファイル操作で、ファイルの一部を削除したり、ファイル名を変更したりすることは絶対行わないで下さい。ファイル

操作でファイルやフォルダを削除、移動したり、名前を変更したりすると、データファイルとヘッダファイルとのリンクが失われて

PCでデータを読み込めなくなったり、規定したメディアへのその後の記録レートが保証できません。また、変更されたメディアを

ふたたび LX 本体に入れたときにデータを読み込めなくなります。PC 記録したファイルを LX 本体で再生する場合は、「5 章

PC に記録したファイルを LX 本体で再生する場合の注意」を参照下さい。 
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使用上の注意 

■ PC カードの取扱 

PC カードに保存されたデータの、静電気による破損を防ぐため、本体に触れる前に必ず身近な金属に手を触れて身体の

静電気を取り除くようにして下さい。また、記録中や再生中は PC カードスロットの中のメディアに触れないで下さい。 

 

■ PC カードへのデータ記録に関する諸注意 

 認識するファイルシステムは FAT16, FAT32 です。NTFS 及び FAT12 は認識しません。(通常、容量が 16MB 

以下のメディアをフォーマットすると FAT12 となります) 

 LX でPCカードをご利用の場合は、まず Windows 搭載PCで FAT16 か FAT32 にフォーマットした後ご利用下さ

い。LX 本体では未フォーマットの PC カードをフォーマットする事はできません。 

 FAT32 でフォーマットされた PC カードを LX でご利用の際、認識や書き込み等に長い時間がかかる場合があります。

その場合は、LX 本体のフォーマット機能で再度フォーマットしなおすと改善される事があります。 

 何度もファイルの書き込みや削除などをした PC カードをご利用の際、空き容量がまだ多く残っているはずなのにデータ

を記録できなくなる場合があります。その場合はデータを他のメディア等にバックアップした後、一度 PC カードをフォーマ

ットしなおして下さい。 

 LX Navi 等で表示される PC カードの空き容量は最大 4GB です。% 表示の場合は正しく表示されます。 

 LX が PC カードに作成するファイルの最大サイズは FAT16 では 2GB、FAT32 では 4GB です。ただし、実際のフ

ァイルサイズはデータの単位に依存して少し小さくなります。 

 最大サイズを超えてデータを記録し続けた場合は、自動的に新しいファイルを作成して記録を続行します。この時、ヘ

ッダファイルや音声ファイルも自動的に新しいファイルに移行します。このように分割して記録されたファイルの組(データ、

ヘッダ、音声)は、各々独立して再生できます。 

 ただし、記録条件が以下に該当する場合、連続して記録できるデータの記録サイズは最大合計 4GB となります。

(それ以上記録できる場合もありますが、保証できません) 

1. 同期記録（マスター、スレーブの設定がされている場合） 

2. タイマー[記録開始時間・記録時間指定・タイムアウト]記録 

3. トリガ[レベル・外部トリガ]記録 

 PC カードに多数のファイルを作成された場合、データ再生時のファイル一覧取得等に時間がかかる場合があります。

その場合はデータを他のメディア等にバックアップした後、一度 PC カードをフォーマットしなおして下さい。 

 PC カードに作成して正常に操作できるフォルダ及びデータファイルの数の合計は最大 10,000 個です。 

10,000 個を超えての記録は可能ですが、10,000 個を超えて記録したファイルのコピー、再生は行えません。 

 書き込み速度の遅い PC カードを使用した場合、データ書き込みが間に合わず記録が停止してしまうことがあります。

必ず推奨品をご使用ください。 

 

■ LX 本体のボタンの操作について 

付属のソフトウエア LX Navi を接続した状態で LX 本体のボタンを操作する場合、2 秒以上の間隔をおいて操作して下さ

い。 

 

■ PC カードドライブのないモデルをお求めのお客様へ 

ドライブは実装されていませんので、本書で説明するメディアにかかわる機能はすべて動作しません。 

 

■ アナログ出力アンプのないモデルをお求めのお客様へ 

出力アンプは実装されていませんので、本書で説明するアナログ出力アンプにかかわる機能はすべて動作しません。ただし、

PC 画面上の再生は可能です。 

 

■ 電源の投入および再投入について 

電源投入後、３秒以内に電源断しないで下さい。また電源断のあと電源を再投入するまで、最低 5 秒以上時間をおいて

下さい。 
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各部の名称 

 各部の名称 
 フロント 

1 2 3 

4 

5 

8 7 6 12 11 10 9 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 ドライブ  

このふたを開けるとディスクスロットがあります。 

 

2 入力レベル LED 

いずれかのチャネルの入力信号が、設定された入力レンジの±10%を超えると緑色に、±115%を超えると赤く点灯します。 

 

3 入力コネクタ 

測定する信号を入力します。 

 

4 電源スイッチ 

スイッチの上側を押すと電源が入ります。下側を押すと電源が切れます。 

 

5 音量つまみ 

メモ音声の再生音量を調節します。 

 

6 EARPHONE ジャック 

メモ音声の再生音をイヤホンで聴くときに接続します。イヤホンを差し込むとスピーカから音声は出ません。 

 

7 MEMO IN ジャック 

メモ音声用のマイクロホンを接続します。 

 

8 USAGE（使用率）LED 

記録デバイスの使用率を示します。メモリー記録では、メモリーの全容量に対する使用率を示します。メディア記録では、そ

のメディアの全容量に対する使用率を示します。PC 記録では、データを転送するためのバッファとしてのメモリーの使用率を

示します。左から 5、10、20、35、50、70、90、100％を示します。 

これらの LED は低電圧アラームも兼ねており、電源電圧が 11 V 以下になると点滅します。 

そのとき記録、再生は停止します。 
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各部の名称 

9 出力コネクタ(このスロットにアナログ再生アンプカードが実装されている場合) 

再生信号を出力します。記録待機中、記録中は入力信号を出力します。出力レンジは 1 V から 5 V まで 0.1 V ステップで

設定することができます。 

 

10 出力レベル LED(このスロットにアナログ再生アンプカードが実装されている場合) 

いずれかのチャネルの出力信号が、設定された出力レンジの±10%を超えると緑色に、±115%を超えると赤く点灯します。 

 

11 P LOCK ボタン 

3 秒間押すとランプが点灯し、左の STOP、REC、FWD、PAUSE、EVENT の 5 つのボタンが無効になります。解除するには

同様に 3 秒間押します。 

 

12 録再操作ボタン 

記録、再生の操作をするためのボタンです。詳細は後述します。 
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各部の名称 

 リア 
 

LX-110 IEEE 1394 モデル 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LX-110 LAN モデルの場合は、7 の部分が下図のタイプとなります。 

 

 

LX-120 LAN モデル 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LX-120 IEEE 1394 モデルの場合は、11 の部分が上図のタイプとなります。 

 

 

1 2 3 4 4 5 6 

10 7 

12 

8 8 9 

11 

RECORDING UNIT

12-28V ,

LX-110

6.0-2.6A

TEAC CORPORATION

BATTERY UNIT:BU-81

SERIAL NO.

MADE IN JAPAN

SERIAL NO.

MADE IN JAPAN

RECORDING UNIT

12-28V ,

TEAC CORPORATION

LX-120

6.5-2.8A

BATTERY UNIT:BU-81
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各部の名称 

1 FG 端子 

アース線をつなぎます。 

 

2 MON OUT コネクタ 

記録待機時、記録時、再生時に任意のチャネルの信号をアナログで出力します。モニターチャネルは付属ソフト LX Navi で

選択します。出力レンジは 1 V から 5 V まで 0.1 V ステップで設定することができます。このモニター出力には出力アンプと同

様のフィルタがかけられます。（低速サンプリング周波数系列を使用している場合のアナログ出力には対応しておりません。） 

LX-120 の場合、ジェネレータ信号を出力することもできます。 

 

3 EXT TRIGGER IN コネクタ 

外部からの接点信号をトリガにして記録を開始する際のトリガ信号を入力します。 

 

4 冷却ファン 

本体を冷却するための排気ファンです。吹き出し口をふさがないで下さい。 

 

5 BU-81 コネクタ （オプション） 

オプションのバッテリユニットを接続するときに使用します。 

 

6 DC IN コネクタ 

＋11～30 V の電源を入力します。 

 

7 IEEE 1394 コネクタ (IEEE 1394 モデルの場合) 

PC と接続します。PC 側には推奨のインタフェースカードをご使用下さい。 

 

8 同期記録用のコネクタ （オプション） 

同期記録を行う場合に使用します。同期記録を行わない場合は何も接続しないで下さい。 

 

9 AQ-VU 同期コネクタ （オプション） 

AQ-VU の記録スタート・ストップコントロール及び時刻合わせを行います。 

 

10 DIGITAL CONTROL コネクタ 

接点信号で記録・再生をコントロールする場合や、リモートコントロールユニット（オプション）を接続する場合に使用します。 

 

11 100BASE-TX コネクタ (LAN モデルの場合) 

PC と接続します。コネクタの横にある LED は通信中に点滅します。 

 

12 PULSE IN A/B コネクタ (LX-120 モデルの場合) 

タコパルス信号を入力する場合に使用します。 

 

 

1-11 



記録時間 

 記録時間 
■ メモリー記録 8 チャネル記録 16 ビット AD 時 64 MB 標準メモリー(メモ音声を録音しない場合） 

 

 

 

 

 

 

 

 

 

サンプリング周波数（カッコ内は記録帯域、許容差±0.5 dB） 記録時間 

96 kHz （40 kHz） 40 秒 

48 kHz （20 kHz） 80 秒 

24 kHz （10 kHz） 160 秒 

12 kHz （5 kHz） 320 秒 

6 kHz （2.5 kHz） 640 秒（約 10 分） 

3 kHz （1.25 kHz） 1,280 秒（約 21 分） 

1.5 kHz （625 Hz） 2,560 秒（約 42 分） 

 

 

 

■ PC カード記録 8 チャネル記録 16 ビット AD 時 1 GB PC カード(メモ音声を録音しない場合） 

※ 48 kHz サンプリング時、記録時間はフォーマット直後の未記録 PC カードの場合 

 

 

 

 

 

 

 

 

サンプリング周波数（カッコ内は記録帯域、許容差±0.5 dB） 記録時間 

48 kHz （20 kHz） 1,230 秒（約 20 分）※ 

24 kHz （10 kHz） 2,470 秒（約 41 分） 

12 kHz （5 kHz） 4,940 秒（約 82 分） 

6 kHz （2.5 kHz） 9,890 秒（約 164 分） 

3 kHz （1.25 kHz） 19,790 秒（約 329 分） 

1.5 kHz （625 Hz） 39,360 秒（約 11 時間） 

 

■ メディアへの概算記録時間は次の式により計算できます。(下記は目安の記録時間です。) 

記録時間 (秒)  

= (メディア容量(Byte) x 0.9) / [(アナログ記録チャネル数 + タコパルス入力チャネル数) x サンプリング周波数(Hz) x AD

幅) + 8000 ] 

メディア容量 x 0.9: メディアのオーバヘッドやヘッダファイル記録容量を考慮して 90%として計算します。 

AD 幅: 16 ビット AD の場合 2, 24 ビット AD の場合 4 

 

各記録モードにおける設定できるサンプリング周波数とアナログ記録チャネル数の組み合わせについては、次項の「サンプリン

グ周波数とチャネル数」を参照して下さい。 

タコパルス入力チャネル数は、16 ビット AD の場合、タコパルス入力 16 ビットモードのときは 2、32 ビット 1 チャネルモードのと

きは 2、32 ビット 2 チャネルモードのときは 4 となります。24 ビット AD の場合、タコパルス入力 16 ビットモードは選択不可、32

ビット 1 チャネルモードのときは 1、32 ビット 2 チャネルモードのときは 2 となります。(タコパルス入力チャネルは LX-120 のみ対

応) 

メモ音声を使用しない場合は、8000 を 0 にして計算して下さい。 
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サンプリング周波数とチャネル数 

 サンプリング周波数とチャネル数 
LX Navi で設定できるサンプリング周波数とチャネル数の組み合わせは、選択された記録メディアやタコパルス入力モード選

択の有無などの記録条件により下記のようになっています。 

 

 LX-110 は、表のサンプリング周波数系列の中では、96 kHz 系列のみサポートしています。他の系列については、

LX-110 のオプション機能として別途搭載することもできます。 

(16ビットAD / 24ビットAD)

102.4 kHz系列

サンプリングレート(kHz) 帯域(kHz) タコ入力無し タコ入力2ch(16bits) タコ入力1ch(32bits) タコ入力2ch(32bits)

*102.4 42 4 / 2 2 / 記録不可 2 / 記録不可 記録不可

*51.2 21 8 / 4 4 / 記録不可 4 / 2 4 / 2
25.6 10 16 / 8 8 / 記録不可 8 / 4 8 / 4
12.8 5 32 / 16 24 / 記録不可 24 / 8 24 / 8
5.12 2 32 / 32 32 / 記録不可 32 / 24 32 / 24

2.56 1 32 / 32 32 / 記録不可 32 / 32 32 / 32
1.28 0.53 32 / 32 32 / 記録不可 32 / 32 32 / 32

100 kHz系列

サンプリングレート(kHz) 帯域(kHz) タコ入力無し タコ入力2ch(16bits) タコ入力1ch(32bits) タコ入力2ch(32bits)

*100 41 4 / 2 2 / 記録不可 2 / 記録不可 記録不可
*50 20 8 / 4 4 / 記録不可 4 / 2 4 / 2
20 8 16 / 8 8 / 記録不可 8 / 4 8 / 4
10 4.1 32 / 16 24 / 記録不可 24 / 8 24 / 8

5 2 32 / 32 32 / 記録不可 32 / 24 32 / 24
2 0.8 32 / 32 32 / 記録不可 32 / 32 32 / 32
1 0.4 32 / 32 32 / 記録不可 32 / 32 32 / 32

96 kHz系列

サンプリングレート(kHz) 帯域(kHz) タコ入力無し タコ入力2ch(16bits) タコ入力1ch(32bits) タコ入力2ch(32bits)

*96 40 4 / 2 2 / 記録不可 2 / 記録不可 記録不可
*48 20 8 / 4 4 / 記録不可 4 / 2 4 / 2
24 10 16 / 8 8 / 記録不可 8 / 4 8 / 4

12 5 32 / 16 24 / 記録不可 24 / 8 24 / 8
6 2.5 32 / 32 32 / 記録不可 32 / 24 32 / 24
3 1.25 32 / 32 32 / 記録不可 32 / 32 32 / 32

1.5 0.625 32 / 32 32 / 記録不可 32 / 32 32 / 32

65.536 kHz系列

サンプリングレート(kHz) 帯域(kHz) タコ入力無し タコ入力2ch(16bits) タコ入力1ch(32bits) タコ入力2ch(32bits)

*65.536 27 4 / 2 2 / 記録不可 2 / 記録不可 記録不可
*32.768 13 8 / 4 4 / 記録不可 4 / 2 4 / 2

16.384 6 16 / 8 8 / 記録不可 8 / 4 8 / 4
8.192 3 32 / 16 24 / 記録不可 24 / 8 24 / 8
4.096 1.7 32 / 32 32 / 記録不可 32 / 24 32 / 24
2.048 0.8 32 / 32 32 / 記録不可 32 / 32 32 / 32
1.024 0.4 32 / 32 32 / 記録不可 32 / 32 32 / 32

タコ入力の有無による最大アナログ記録チャネル数

タコ入力の有無による最大アナログ記録チャネル数

タコ入力の有無による最大アナログ記録チャネル数

タコ入力の有無による最大アナログ記録チャネル数

 

記録条件 1 

記録モード:PC カードへのメディア記録、メディア記録と同時に PC へのデータ転送 

メモ音声: ON または OFF 

PC データ転送に使用する本体インタフェース: IEEE1394 または LAN 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

注意） *印のサンプリングレートでは移動平均"1"以外は設定できません。 

    24 ビット AD の場合、タコパルス入力 2ch(16bits)は選択できません。 

PC の仕様や OS の動作状況によっては、最大記録チャネル数を設定した時、継続的な記録動作が出来ない場合

（記録途中メモリーフルで停止）や LX Navi による波形表示がリアルタイムで表示出来ない場合があります。その場合

はサンプリング周波数を 1/2 に下げる、または記録チャネル数を 1/2 に減らすなどして転送レートを下げてご使用下さ

い。 
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サンプリング周波数とチャネル数 

記録条件 2 

記録モード: 内蔵メモリーへの記録、または PC へのダイレクト記録 

メモ音声: ON または OFF 

PC データ転送に使用する本体インタフェース: IEEE1394 または LAN 

(16ビットAD / 24ビットAD)

102.4 kHz系列

サンプリングレート(kHz) 帯域(kHz) タコ入力無し タコ入力2ch(16bits) タコ入力1ch(32bits) タコ入力2ch(32bits)

*102.4 42 8 / 4 4 / 記録不可 4 / 2 記録不可

*51.2 21 16 / 8 8 / 記録不可 8 / 4 8 / 4
25.6 10 32 / 16 24 / 記録不可 24 / 8 24 / 8
12.8 5 32 / 32 32 / 記録不可 32 / 24 32 / 24
5.12 2 32 / 32 32 / 記録不可 32 / 32 32 / 32

2.56 1 32 / 32 32 / 記録不可 32 / 32 32 / 32
1.28 0.53 32 / 32 32 / 記録不可 32 / 32 32 / 32

100 kHz系列

サンプリングレート(kHz) 帯域(kHz) タコ入力無し タコ入力2ch(16bits) タコ入力1ch(32bits) タコ入力2ch(32bits)

*100 41 8 / 4 4 / 記録不可 4 / 2 記録不可
*50 20 16 / 8 8 / 記録不可 8 / 4 8 / 4
20 8 32 / 16 24 / 記録不可 24 / 8 24 / 8
10 4.1 32 / 32 32 / 記録不可 32 / 24 32 / 24

5 2 32 / 32 32 / 記録不可 32 / 32 32 / 32
2 0.8 32 / 32 32 / 記録不可 32 / 32 32 / 32
1 0.4 32 / 32 32 / 記録不可 32 / 32 32 / 32

96 kHz系列

サンプリングレート(kHz) 帯域(kHz) タコ入力無し タコ入力2ch(16bits) タコ入力1ch(32bits) タコ入力2ch(32bits)

*96 40 8 / 4 4 / 記録不可 4 / 2 記録不可
*48 20 16 / 8 8 / 記録不可 8 / 4 8 / 4
24 10 32 / 16 24 / 記録不可 24 / 8 24 / 8

12 5 32 / 32 32 / 記録不可 32 / 24 32 / 24
6 2.5 32 / 32 32 / 記録不可 32 / 32 32 / 32
3 1.25 32 / 32 32 / 記録不可 32 / 32 32 / 32

1.5 0.625 32 / 32 32 / 記録不可 32 / 32 32 / 32

65.536 kHz系列

サンプリングレート(kHz) 帯域(kHz) タコ入力無し タコ入力2ch(16bits) タコ入力1ch(32bits) タコ入力2ch(32bits)

*65.536 27 8 / 4 4 / 記録不可 4 / 2 記録不可
*32.768 13 16 / 8 8 / 記録不可 8 / 4 8 / 4

16.384 6 32 / 16 24 / 記録不可 24 / 8 24 / 8
8.192 3 32 / 32 32 / 記録不可 32 / 24 32 / 24
4.096 1.7 32 / 32 32 / 記録不可 32 / 32 32 / 32
2.048 0.8 32 / 32 32 / 記録不可 32 / 32 32 / 32
1.024 0.4 32 / 32 32 / 記録不可 32 / 32 32 / 32

タコ入力の有無による最大アナログ記録チャネル数

タコ入力の有無による最大アナログ記録チャネル数

タコ入力の有無による最大アナログ記録チャネル数

タコ入力の有無による最大アナログ記録チャネル数

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

注意） *印のサンプリングレートでは移動平均"1"以外は設定できません。 

    24 ビット AD の場合、タコパルス入力 2ch(16bits)は選択できません。 

PC の仕様や OS の動作状況によっては最大記録チャネル数を設定した時、継続的な記録動作が出来ない場合

（記録途中メモリーフルで停止）や LX Navi による波形表示がリアルタイムで表示出来ない場合があります。その場合

はサンプリング周波数を 1/2 に下げる、または記録チャネル数を 1/2 に減らすなどして転送レートを下げてご使用下さ

い。 
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接続 

 

 接続 
 入力信号 

 

オシロスコープなどを

接続 

 

 

 

 

 

 

 

 

 

 
付属マイクロホン

(メモ音声を録音する場合)

付属イヤホン 

(メモ再生音をイヤホンで聴く場合) 
 

 

 

 

2pin NC 

3pin RESERVED 

4pin + 

1pin – 

 

 

 

 

 

PC に接続 100BASE-TX LAN 

インタフェース (LAN モデル) 

モニター出力 

オシロスコープなど 外部トリガ入力(接点信号) 

DC 電源※  

(+11 ～ 30 V) 

ま た は 、 指 定 の AC  

アダプタ 

オプション 

2pin - タコパルス入力(LX-120 のみ) 

リモートコントロール

ユニット 同期記録用 

 接続端子 

（オプション機能）

AQ-VU  

接続端子 

（オプション機能） 

SERIAL NO.

MADE IN JAPAN

RECORDING UNIT

12-28V ,

TEAC CORPORATION

LX-120

6.5-2.8A

BATTERY UNIT:BU-81

PC との同時接続は

できません。 

バッテリユニット  

BU-81 

1pin + 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
PC に接続 IEEE 1394 インタフェース 

 (どちらでも可。弊社推奨の IEEE 1394 イン

タフェースカードをご使用下さい。)  
(1394 モデル)  

※ DC 電源電圧が＋11 V 以下になると 

電源電圧が 11 V 以下になると USAGE LED が点滅し、記録、再生は停止します。メモリー記録の場合は、すみやかにデ

ータをメディアまたは PC にコピーして下さい。 
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LxNavi のインストール 

 

 PCの要件 
下のシステム要件を満たす PC を推奨します。 

CPU: Pentium4  2GHz 以上 

画面解像度: 1024×768 ドット以上 

メモリー: 1 GB 以上 

HDD の空き容量: 2 GB 以上 

CD-ROM ドライブ: プログラムインストール用 

IEEE 1394 モデルの場合: 指定 IEEE 1394 インタフェースカード 

ノート PC 用（PC カードタイプ） ラトックシステム（株）製 CBFW3 

デスクトップ PC 用（PCI バス用） ラトックシステム（株）製 PCIFW3 

LAN モデルの場合: PC オンボードの 100BASE-TX インタフェース 

 

注意：上記の要件を満たす全ての PC の動作を保証する訳ではありません。また常駐ソフトや他ドライバ・アプリ

ケーションの動作状態および HDD の速度等の関係によっては高速のサンプリング速度での記録が継続的

に維持できない場合があります。 

 

OS の条件 

Windows XP......... 32 ビット版 (日本語版 / 英語版) 

Windows Vista .... 32 ビット版 (日本語版 / 英語版) 

Windows 7 ............ 32 ビット版 (日本語版 / 英語版) 

Windows 7 ............ 64 ビット版 (日本語版 / 英語版)  [LAN モデル限定] 

 

Windows 7 の 64 ビット版の OS では、IEEE 1394 モデルの LX シリーズは動作しません。 

上記以外の OS のバージョンは動作保証対象外です。 

 

■ IEEE 1394 インタフェースカードは上記の指定品をご使用下さい。これらのカードは弊社でのみ扱っていますので、入手方

法についてはお問い合わせ下さい。他の製品では正常に動作しないことがありますのでご注意下さい。インタフェースカードの

導入に際しては、次ページ以降の説明にしたがってセットアップを行って下さい。 

■ PC 側の 100BASE-TX インタフェースは PC カードタイプのものは使用せずオンボードタイプのものを使用して下さい。 

■ ファイルシステムにより PC 上で取り扱えるファイルサイズやファイル数が制限されることがあります。 
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LxNavi のインストール 

 LX Naviのインストール 
次の手順で付属ソフト LX Navi を最初にインストールして下さい。インストール作業は、インストールする PC の管理者権限

を持っている方が行って下さい。旧バージョンの LX Navi がインストールされている PC 環境の場合、旧バージョンの LX Navi

をアンインストールしてから実行して下さい。 

 

1. 付属 CD-ROM 中のルートディレクトリ上の「Setup.exe」を実行します。 

 

2.画面に表示されるメッセージにしたがってセットア

ップを進めます。[Next]ボタンをクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

3.セットアップの選択画面が表示されます。インスト

ールを行う項目にチェックを入れて[Next]ボタンを

クリックします。 

 

1394 モデルの LX の場合は、必ず LX-Series 

1394 Driver Installer の項目のチェックボックスに

チェックを入れて下さい。 

 

 

 

 

 

 

 

4.インストール先を指定する画面が表示されます。

インストール先を指定する場合は[Browse…]

ボタンをクリックしてインストール先を指定して下

さい。特に変更する必要がない場合は、そのま

ま[Next]ボタンをクリックします。 
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LxNavi のインストール 

2-5 

5.インストールを開始する確認画面が表示されま

す。そのまま[Next]ボタンをクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

6.インストールが開始されます。インストールの途

中の画面でしばらく時間がかかる場合がありま

すが、そのまま次の画面が表示されるまでお待

ち下さい。 

 

Windows Vista、Windows 7 の場合でユーザー

アカウント制御が有効な場合、インストールの

途中でユーザーアカウント制御のダイアログが

表示されますのでインストールを続行する処理

をして下さい。 

 

 

 

 

 

7.正常にインストールが完了すると右記の画面が

表示されます。[Close]ボタンをクリックして終

了します。 

 

PC を再起動するメッセージが表示されている

場合はインストール終了後、PC を再起動して

下さい。 

 

 



LX-100 シリーズ (1394 モデル)の初期設定 

 LX-100 シリーズ (IEEE 1394 モデル)のインストール 
LX-100 シリーズ (IEEE 1394 モデル)のインストールの概要を下記に示します。IEEE 1394 に必要なドライバのインストール

は後述する各 OS のインストール手順に従って下さい。 

1.インタフェースカードを装着する 
2.LX シリーズ 1394 Driver をプリインストールする 
3.PC と LX-100 シリーズを接続する 
4.修正プログラムを実行する  (Windows XP Service Pack 2 の場合のみ) 
5.ドライバソフトウエアを確認する 

 

 接続に際しての注意 
■ IEEE 1394 ケーブルへのコアの取り付け (IEEE 1394 モデル) 

不要電波の放射を軽減するために、IEEE 1394 ケーブルの PC 側と LX 本体側との両端に、付属のフェライトコアを取り付け

て下さい。 

 

 

 

 

 

 

 

 

 

■ IEEE 1394 コネクタには PC のみ (IEEE 1394 モデル) 

リアパネルの IEEE 1394 コネクタは PC との接続のみに使用して下さい。他の機器をデイジーチェーンで接続すると、仕様の性

能を満たさないことがあります。 

 

■ アースの接続 

ノイズの混入を防ぐため、接続するすべての測定器と共通のアースをリアパネルの FG 端子に接続して下さい。 

 

 インタフェースカードを装着する 
ノートPCに取り付ける 

IEEE 1394 インタフェースカード CBFW3 を CardBus 対応の PC カードスロットに挿入します。 

PC カードスロットの位置や PC カード挿入方法については、PC の説明書をご覧下さい。 

■ 他の PC カードと同時に装着できない場合があります。 

■ 上側スロットに装着できない場合があります。 

■ 無理に挿入した場合、CBFW3 や PC 本体が破損する恐れがありますので、十分に注意して挿入して下さい。 
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LX-100 シリーズ (1394 モデル)の初期設定 

デスクトップPCに取り付ける 

PCI タイプインタフェースカード PCIFW3 を PC の PCI スロットに装着します。 

PCI スロットへの位置や装着方法については、PC の説明書をご覧下さい。 

■ デスクトップ PC に PCI タイプインタフェースカード PCIFW3 を装着する場合は、PC の電源を OFF にしてから行って下

さい。 

■ PCIFW3 を PC の Low Profile PCI スロットに装着する場合には、標準ブラケットを添付の Low Profile 用ブラケット

に付け替えて下さい。 

■ 無理に挿入した場合、PCIFW3 や PC 本体が破損する恐れがありますので、十分に注意して装着して下さい。 

 

CBFW3 を CardBus 対応の PC カードスロットに挿入、もしくは PCIFW3 を装着して PC を起動すると、Windows 標準のドライ

バが自動的にインストールされます。デバイスマネージャの画面より、ドライバソフトウエアが正常にインストールされたことを確

認できます。 

 

 

 LXシリーズ 1394 Driverをプリインストールする 
1394 モデルの場合、LX を制御するための、1394 Driver が必要になりますので、1394 Driver を Windows にプリインストール

します。この操作を行うことにより、1394 Driver を Windows に登録し、LX-100 シリーズを接続した時に、付属 CD-ROM が

なくてもドライバが自動的にインストールされます。（Windows XP の場合のみ、”新しいハードウェアの検索ウィザード”を実行

する必要があります）この時点ではまだ、PC と LX-100 シリーズに 1394 ケーブルを接続しないで下さい。 

 

1. Windows のスタートメニューより LX-Series 

1394 Driver Installer を起動すると右図の画

面が表示されますので [次へ]のボタンをクリック

します。 

 

”すべてのプログラム→TEAC→LX Navi→Tool→

LX-Series 1394 Driver Installer”で起動しま

す。 

 

Windows Vista、Windows 7 の場合でユーザ

ーアカウント制御が有効な場合、最初にユーザーア

カウント制御のダイアログが表示されますのでインスト

ールを続行する処理をして下さい。 

 

2. 1394 Driver を Windows に プリインストール

する処理が開始され右図のような画面が表示さ

れます。自動的に次の項目の画面になります。 

 

Windows Vista 、 Windows 7 の 場 合 、

Windows セキュリティのダイアログが表示されます

ので ”このドライバーソフトウェアをインストールしま

す” を選択し、インストールを続行して下さい。 
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LX-100 シリーズ (1394 モデル)の初期設定 

 

3. LXシリーズ 1394Driverのプリインストールが完

了すると右図のような画面が表示されます。[完

了]ボタンをクリックして終了します。 

 

 

 

 

 

 

 

 

 

 PC とLX-100 シリーズを接続する 
LX-100 シリーズの電源を ON にして、PC と LX-100 シリーズに 1394 ケーブルを接続して下さい。前項目でプリインストール

した、1394 Driver がインストールされます。Windows Vista、Windows 7 の場合は、自動的にデバイスドライバがインストール

されすぐに使用可能状態になりますのでインストール作業はこれで終了です。”ドライバソフトウエアを確認する”の項目に移

行して下さい。 

Windows XP の場合は、”新しいハードウェアの検索ウィザードの開始”の画面が立ち上がりますので以下の手順で操作して

下さい。 

(Windows XP の場合のみ) 

1. LX-100 シリーズを初めて PC に接続する

と下の画面が表示されます。"ソフトウェア

を自動的にインストールする”の項目にチ

ェックを入れ［次へ］をクリックします。 

 

 

 

 

 

 

 

2. ドライバの検索画面が表示されます。自

動的に次の項目の画面になります。 
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LX-100 シリーズ (1394 モデル)の初期設定 

 

3.インストールの実行画面が表示されます。

自動的に次の項目の画面になります。 

 

 

 

 

 

 

 

 

4.1394 デバイスドライバのインストールが完

了すると右図のような画面が表示されま

す。[完了]ボタンをクリックして終了しま

す。 
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LX-100 シリーズ (1394 モデル)の初期設定 

 

修正プログラムをインストールする 
(Windows XP Service Pack 2 の場合のみ) 

Windows XP Service Pack 2 をご利用の場合は、次に Microsoft 社より公開されている 1394 記憶装置の修正プログラム

を導入する必要があります。この修正プログラムにより、1394 デバイス (S400 の転送速度を使用する機器) が、想定され

ている性能で動作しない問題点が修正されます。下記の手順で更新を行います。Windows XP Service Pack 2 をご利用

の場合は、必ず実行してください。 

 

1. Microsoft 社の Microsoft Update のページを

起動して下さい。下記の画面が現れます。 

 

 

 

 

 

サイトの検索で”KB885222”と入力し検索を実行

し、Microsoft 社の Windows XP 用の更新プロ

グラム (KB885222)のページを見つけて開いてく

ださい。（上記画面は Microsoft 社の 2009 年 7 月

時点のものです。） 

 

 

 

2. Microsoft 社の Windows XP 用の更新プロ

グラム (KB885222)の実行 
 

上記 Microsoft 社の Windows XP 用の更新プロ

グラム (KB885222)の内容に従って更新プログラ

ムのインストールを実行してください。（上記画面は

Microsoft 社の 2009 年 7 月時点のものです。）この

更新プログラム (KB885222)は、Microsoft 社の

Update の自動更新機能では、インストールされま

せんので手動でインストールする必要があります。 

 

 

 

※Windows XP Service Pack 2 をご利用の場合、この更新プログラムをインストールしないと LX Navi を起動した時に警

告が表示されます。Windows XP Service Pack 2 以外の場合は更新プログラムのインストールは必要ありません。 
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 ドライバソフトウエアを確認する 
 

1. デバイスマネージャの画面を表示させます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. ［1394 バスホストコントローラ］の項目をダブルクリックし、「Texas Instruments OHCI Compliant IEEE 1394 Host 
Controller」が正常に表示されていれば、1394 インタフェースのドライバソフトウエアは正常にインストールされています。 

 
1394 インタフェースのドライバソフトウエアが正常にインストール出来ていない場合は、PC を一旦シャットダウンし、

CBFW3 もしくは PCIFW3 を再装着して再度 PC を起動して下さい。 
 

3. [TEAC Device］の項目をダブルクリックし、「TEAC Corporation Recording Unit LX-Series」が正常に表示されていれ

ば、LX シリーズ 1394 Driver のドライバソフトウエアは正常にインストールされています。 
 

LX シリーズ 1394 Driver のドライバソフトウエアが正常にインストール出来ていない場合は、デバイスマネージャの ”ドラ

イバの更新” 機能で LX シリーズのドライバが保存されているフォルダを直接指定する方法によって実行してください。付

属 CD-ROM の場合、ルートディレクトリ直下の”Driver”フォルダにドライバが保存されています。 

 



LX-100 シリーズ (LAN モデル)の初期設定 

 LX-100 シリーズ (LAN モデル)のインストール 
LX-100 シリーズ (LAN モデル)のインストールの概要を下記に示します。 

1. PC および LX-100 シリーズの IP アドレスの設定を行う。 
 
■PCのオンボードの100BASE-TX LANインタフェースを使用して下さい。 

 

 PCおよびLX-100 シリーズのIPアドレスの設定について 
LX-100 シリーズと PC を接続するためには PC と同一のサブネットマスクを設定し、PC と同一グループの IP アドレスを設定す

る必要があります。必要に応じて LX-100 シリーズ側または PC 側の IP アドレスなどの設定を行って下さい。設定は IPv4 で

設定してください。LX-100 シリーズをネットワーク接続して使用する場合は、下記の情報を元にネットワーク管理者様にご相

談の上、設定を行って下さい。 

 

■ LX-100 シリーズは工場出荷時には以下のように設定されています。必要に応じて PC および LX-100 シリーズの IP ア

ドレスなどの設定を行って下さい。LX-100 シリーズ側の変更方法は LX Network ダイアログで表示される address が表示さ

れている部分をクリックすると LX Property ダイアログが表示され、IP アドレスのパラメータやレコーダ名(Name)などの設定が

行えます。（設定の詳細は次項の”プログラムの起動”の項目を参照下さい） 

IP アドレス    192.168.0.10 

サブネットマスク   255.255.255.0 

ゲートウェイ    0.0.0.0 

DHCP クライアント  DISABLE 

■ お使いの PC にファイアウォールやウィルスチェック等のセキュリティソフトウエアがインストールされている場合、接続できない

場合があります。その時には、ソフトウエア側のセキュリティレベルを確認して下さい。LX Navi(LAN モデル)で使用するポート

は下記のとおりです。 

コントロールポート  49408 (TCP) 

データ転送ポート   49664 (TCP) 

UDP ポート   49920 (UDP) 

■ LX-100シリーズ (LAN モデル)の場合、IPアドレスが正常に設定した場合でも、デバイスマネージャの画面にデバイス表

示はされません。 

■ 100 Mbps での通信を行うためには、LX-100 シリーズから制御 PC までの経路に存在する全ての機器が 100 Mbps に

対応している必要があります。また、ケーブルもカテゴリ 5 以上のものをご使用下さい。なお、通信品質の確保のために STP

ケーブル、並びに同ケーブル対応のスイッチングハブのご使用をお薦めします。 

■ ご利用のネットワーク環境によっては、データの転送に遅れや輻輳処理が生じる可能性があります。この場合、以下のよ

うな対策で、改善を試みて下さい。 

1. リピーターハブを使用している場合には、スイッチングハブに交換する 

2. ブロードキャストパケットをできる限り減らす 

3. できる限りルーターを経由しない通信経路で用いる 

■ 遠隔地に設置した場合など、低速な経路を挟む場合にはサンプリング周波数を下げる、記録チャネル数を減らすなどし

て転送レートを下げてご使用下さい。 

■ LX-100 シリーズの LAN I/F では TCP のコネクション持続型通信を行っていますが、120 秒程度に渡り通信相手からパ

ケットが到着しなかった場合には、タイムアウトによる自動切断を行います。このため、PC のハングアップやケーブルの切り離し

等、不測の事態により正常終了できなかった場合には、120 秒程待ってから再接続を試みて下さい。 

■ LX-100 シリーズの LAN I/F では DHCP（Dynamic Host Configuration Protocol）クライアントとして動作させることがで

きますが、起動後 30 秒以内に IP アドレスを取得できなかった場合には、固定の IP アドレスで通常の動作を開始します。 
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 プログラムの起動 
インストール終了後、PC と LX 本体を接続し LX Navi を立ち上げます。 

■ LX Navi と、大量にメモリーを使うアプリケーションソフトとを同時に実行しないで下さい。 

■ インストール後初めて LxNavi を立ち上げると Windows のセキュリティの警告画面が表示される場合がありますので、ファ

イアウォールのブロックを解除してください。(Windows 標準のファイアウォールの場合は、”ブロックを解除する”のボタンをクリッ

クする) 

次の手順で LX Navi を立ち上げて下さい。 

1. LX 本体の電源スイッチの上側を押します。 

電源を入れると自動的に入力アンプを校正します。校正中は入力アンプの LED が点滅し、校正が終わると消灯します。 

入力アンプの LED が消灯したら、 

 

2. LX Navi を起動します。 

LX-100 シリーズの場合、LX Navi を立ち上げてから LX 本体の電源を切ったり、ケーブルを抜いたりすると、LX Navi はエラ

ーメッセージを出して終了します。その場合は電源を再度投入し、接続し直してから LX Navi を再起動すると、LX 本体を

ふたたび認識することができます。 

LX-100 シリーズでは、LX Navi の使用中に LAN ケーブルを引き抜いた場合 LX 本体との通信フェーズが停止してしまうだ

けでなく、ネットワーク上の輻輳処理を引き起こす要因ともなります。LX 本体をネットワークから切り離す場合には、必ず接

続しているアプリケーションを終了してから行って下さい。同様に、LX Navi 起動中には LX 本体の電源を切らないで下さい。 

 

■ LED が消灯するまでの時間が異常に長いときは 

本体の電源を入れてから入力アンプの LED が消灯するまでの時間が異常に長い場合は、アンプが認識されていないことが

あります。その場合は電源を入れ直して下さい。 

■ PC をスタンバイ・スリープ・休止状態にしない 

LX Navi 使用中に PC がスタンバイ・スリープ・休止状態に入ると通信が途絶えてしまうため、タイムアウトによりコネクションが

切断されてしまいます。LX Navi 使用中は、Windows の電源オプションの設定で、スタンバイ・スリープ・休止状態にならない

ような設定にして下さい。特にノート PC の場合、購入直後の電源オプションの初期設定で条件によってスタンバイ・スリー

プ・休止状態になるよう設定されているものがありますので、ご注意下さい。 

 

LX-100 シリーズ (IEEE 1394 モデル)の場合 

 

 

 

 

 

 

 

 

 

 

 

 

 

LX Network ダイアログが表示されたら、接続対象の LX 本体のシリアル番号が正しく表示されていることを確認して、serial

のフィールドにあるチェックボックスをクリックしチェックマークを付け、OK をクリックします。なお前回実行したシリアル番号の機

械には、自動的にチェックマークを付けられています。IEEE1394 モデルの場合レコーダ名(name)は、”Recording Unit 

LX-Series”と固定の名前で変更は出来ません。 
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プログラムの起動 

LX-100 シリーズ (LAN モデル)の場合 

LX Navi 起動時には次のようなダイアログボックスが表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

LX Network ダイアログが表示されたら、接続対象の LX 本体のシリアル番号が正しく表示されていること、かつ serial のフィ

ールドにあるボックスが白抜き表示となっていることを確認して、チェックボックスをクリックしチェックマークを付け、OK をクリックし

ます。なお前回実行したシリアル番号の機械には、自動的にチェックマークを付けられています。 

 

チェックボックスが白抜きになっていない場合は、次の内容に沿って確認して、適切な設定を行って下さい。 

 

ダイアログの上部は同一セグメント内に存在する LX-100 シリーズのリストです。リストの address か name が表示されている

部分をクリックすると下図のような LX Property ダイアログが表示され、IP アドレスのパラメータやレコーダ名(name)などの設定

が行えます。ご利用のネットワーク環境に合わせて IP アドレスパラメータの設定を行って下さい。LAN モデルの場合、name は

半角 32 文字までお客様が任意に設定できる文字列で、起動時のリスト表示にも反映されますので、複数台から目的の

LX-100 シリーズを識別する場合にご利用下さい。ご利用のネットワーク環境が DHCP に対応している場合は、IP アドレスの

パラメータを自動で取得できます。IP アドレスのパラメータを自動取得する場合 DHCP のチェックボックスにチェックを入れて下

さい。ご利用のネットワーク環境が DHCP に対応しているかどうかは、ネットワーク管理者様にお問い合わせ下さい。 
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プログラムの起動 

OK ボタンをクリックしてアドレスパラメータを LX-100 シリーズにセットした場合、LX-100 シリーズ自体の再起動は必要ありま

せんが、実際に変更が反映されるまで数秒を要しますので、5 秒以上待ってから、接続を行って下さい。また、リストが更新

されない場合やリストから消えた場合には Update List ボタンをクリックして、リストを更新して下さい。 

 

LAN モデルの場合、すでに他の PC から使用されている場合には、赤色のチェックマークと共に status のフィールドに USE が

示されます。この時、対象機器への接続はできません。IEEE1394 モデルの場合、すでに他の PC から使用されていても特に

USE の表示は示されません。 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAN モデルの場合、同一セグメントとして正しくない IP アドレスなど、TCP 接続できない場合にはグレーのチェックボックスと共

に status のフィールドに IP ERR が示されます。この場合、適切な IP アドレスの設定をしてから接続を行って下さい。LX-100

シリーズの IP アドレス設定と、接続する PC の IP アドレス設定(サブネットマスク、ゲートウェイ設定など)に矛盾がないことを確

認して下さい。 
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LAN モデルの場合で、ルーターを超えるなど、異なるセグメントに存在する LX-100 シリーズに接続する場合には、下部の IP 

Direct チェックボックスをクリックしチェックマークを入れ、接続先の IP アドレスを入力してから OK をクリックして下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

同一セグメント上に複数の LX-100 シリーズが見つかった場合には次のように表示されます。この場合、接続を行う機器のチェッ

クボックスにマークをつけて OK をクリックして下さい。 

 

リアルタイム PC 記録した場合、PC の仕様、OS の動作状況、ネットワークのトラフィック状況、収録設定等によっては単位

時間あたりの収録量に対して、転送が追いつかない場合があります。このとき、本体のメモリーバッファには未転送データが蓄

積され、バッファに空き領域が無くなった時点で自動的に記録動作を終了します。記録条件で示された上限の設定でのリ

アルタイム PC 記録には不向きな場合がありますので、予めご了承下さい。 

 

IEEE 1394 モデルか LAN モデルかに関係なく、1 台の PC で同時に複数の LX Navi を起動した場合、波形画面の表示色

やフォルダの設定など、一方の LX Navi から保存された設定内容が他方の LX Navi に波及する場合があります。これは LX 

Navi が利用する保存領域が共通なためで、予期せぬ事態を引き起こす可能性がありますので、1 台ごとにそれぞれ異なる

PC でご使用になることをお勧めします。  

 

接続が正しく完了すると LX Navi が起動し、メイン画面が表示されます。 

「第 3 章 LX Navi 入門」を参照して下さい。 

 



プログラムの起動 

 LX Networkダイアログを表示せず直接Naviを起動する 

下記の方法を参考に LX Navi を起動するときに “ /D” オプションを指定してください。前回起動したシリアル番号の LX が

I/F 上に接続されている場合、LX Network ダイアログが表示されず直接、Navi が立ち上がります。前回起動したシリアル

番号の LX が I/F 上に接続されていない場合は、LX Network ダイアログが表示されます。なお前回起動したシリアル番号

の LX が I/F 上に１台のみ接続されている場合は、“ /D” オプションを指定していなくても LX Network ダイアログが表示さ

れず直接、Navi が立ち上がります。LX Network ダイアログを強制的に表示したい場合は、”Shift キー”を押下した状態で

プログラム起動して下さい。 

 

(例１) LX Navi のショートカットを作成しプロパティを開き、リンク先の指定にオプションの “ /D”を追加指定する。 

(次の画面例は、Windows XP のものです。) 

リンク先   "C:\Program Files\TEAC\LX Navi_3\LxNavi.exe" /D 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(例 2) [スタート]メニューから[ファイル名を指定して実行...]を選択し、実行する LxNavi.exe を指定しその後ろにオプションの” 

/D” を指定した後、[OK]ボタンを押してください。(次の画面例は、Windows XP のものです。) 

名前   "C:\Program Files\TEAC\LX Navi_3\LxNavi.exe" /D 
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メディアの挿入とイジェクト 

 メディアの挿入とイジェクト 
 メディアの挿入 
■ メディアの挿入および取り出しは、必ず REC モードの STOP 状態で行って下さい。 

■ PC カードの場合、静電気によるデータ破損を防ぐため、本製品に触れる前に必ず身近な金属に手を触れて身体の静

電気を取り除くようにして下さい。また、記録中や再生中は PC カードスロットの中のメディアに触れないで下さい。 

 

1. LX 本体の電源を入れます。STOP ランプが点灯したら、 

2. ドライブの蓋を開けます。 

3. メディアのラベル面を上にしてメディアをスロットに挿入します。 

4. ドライブの蓋を閉じます。 

 

■ 本体の記録性能を保証するため 1-6 項に記載された 動作検証済みのコンパクトフラッシュカード をご使用ください。 
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メディアの挿入とイジェクト 

PCカード 

PC 上で FAT16 か FAT32 にフルフォーマット（クイックフォーマットのチェックを外した設定）してからご使用下さい。2GB 超の

PC カードの場合は FAT32 でフォーマットしてください。LX Navi の File メニューから Format 実行はクイックフォーマットの動作

になります。ボリューム名を入力し、Format をクリックして下さい。 

 

  
 

 

 

 

 

 

 

 メディアのイジェクト 
■ メディアを取り出してから電源を切る 

LX 本体の電源を切る前にメディアを取り出して下さい。もし書き込み中に電源を切ると、そのメディアに記録したデータを読

めなくなることがあります。また、メディアを挿入したまま LX 本体を持ち運ぶと故障の原因になります。 

■ メディアの挿入および取り出しは、必ず REC モードの STOP 状態で行って下さい。 

■ PC カードの場合、静電気による破損を防ぐため、本製品に触れる前に必ず身近な金属に手を触れて身体の静電気

を取り除くようにして下さい。また、記録中や再生中は PC カードスロットの中のメディアに触れないで下さい。 

 

1. ドライブの蓋を開けます。 

2. PC カードは、ドライブのイジェクトレバーを押して下さい。PC カードが出ます。 

3. メディアを引き出します。 

4. ドライブの蓋を閉じます。 

 

■ 記録中、読み取り中にはメディアのイジェクト操作は絶対に行わないで下さい。データが破損します。 

 

 

 メディア内のデータについて 
メディアに記録したデータは PC の PC カードスロットで TAFFmat ファイルとして認識できますので、そのまま市販の解析ソフト

ウエアで読み込めます。ただし、PC 上のファイル操作でファイルやフォルダを削除、移動したり、名前を変更したりすると、デー

タファイルとヘッダファイルとのリンクが失われて PC でデータを読み込めなくなります。PC 上では、ファイルのコピー動作以外の

操作は行わないでください。 
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拡張ユニットについて 

 拡張ユニットについて 
拡張ユニット AU-LX100EPIO 増設時に可能な入力アンプ、出力アンプの組み合わせ例は以下のとおりです。 

 

入力 16 チャネル＋出力 16 チャネルの場合 

（上のスロットから） 

スロット 1: 入力アンプを実装 

スロット 2: 入力アンプを実装 

スロット 3: 出力アンプを実装 

スロット 4: 出力アンプを実装 

 

入力 32 チャネルの場合 

全スロットに入力アンプを実装します。 

 

 各スロットの設定について 

拡張ユニット増設で 

追加されたタブ 

拡張ユニットを増設すると LX Navi の System ダイアログにタブが追加されますので、それぞれのタブで設定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 拡張ユニット使用時のサンプリング周波数の上限について 
AD データ長 記録チャネル数 メモリー記録 メディア記録(PC カード) 

16 ビット AD 2 ch 96 kHz 96 kHz 

16 ビット AD 4 ch 96 kHz 96 kHz 

16 ビット AD 8 ch 96 kHz 48 kHz 

16 ビット AD 16 ch 48 kHz 24 kHz 

16 ビット AD 32 ch 24 kHz 12 kHz 

24 ビット AD 2 ch 96 kHz 96 kHz 

24 ビット AD 4 ch 96 kHz 48 kHz 

24 ビット AD 8 ch 48 kHz 24 kHz 

24 ビット AD 16 ch 24 kHz 12 kHz 

24 ビット AD 32 ch 12 kHz 6 kHz 
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メイン画面のあらまし 

 メイン画面のあらまし 
LX Navi プログラムを起動するとメイン画面が表示されます。 

 

ステータスダイアログ表示エリア     メニューバー      ツールバー    ステータスバー表示 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
波形表示時間軸スケーラー 

ステータスダイアログ表示エリア 

波形表示エリア

 

 
記録モード(REC)、再生モード(VIEW)の切り替え 

 

 

記録先ディレクトリ名の確認、再生するディレクトリの選択・確認 

記録先のデバイスの確認、再生先のデバイスの確認 (MEMORY, CARD, PC) 

 

 

 
記録ファイル名の確認、再生するファイルの選択・確認 

 

 設定したコメント内容の確認 

 

メモ音声録音の ON／OFF の設定・確認 

記録・再生のサンプリング周波数の設定・確認 
 

 

 

 モニターチャネルの選択・確認 

 

 選択されている LX 本体のデバイスに記録出来る残時間（時：分：秒）とメディアの残割合（％）

 ※この残時間の表示がシアン色で表示されている場合、メディアに 4GB 以上の

空き容量があり表示している時間より多い残時間がある事を示しています。  

 PC に記録出来る残時間（時：分：秒） 

 ※PC のデータ転送能力が遅い場合、この項目の表示が黄色または赤の

リバース表示になり、PC へのデータ転送が遅れていることを示しています。

この場合 LX 本体内のメモリーがフルとなる可能性があり、表示されている

記録可能な時間より早く記録が終了する可能性があります。 

 

 

 
ユニット名または、LX 本体のシリアル番号 

3-2 



メイン画面のあらまし 

 

 

 メインメニュー 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

メニューバー 

New: データを記録するデバイス

の選択、ファイル名の指定 

All Clear: 設定初期化 

Zero Balancing: ゼロバランス 

Channel Unit: オートオフセット 

           キャリブレーション 

TEDS Property: TEDS 情報読み込み 

Params: Property: 設定の保存、読み込み

Trigger: トリガ動作の設定 

System: 動作、記録条件、再生条件の設定

Exit: アプリケーションの終了 

Format: メディアのフォーマット 

Copy: データのコピー 

Open: 再生データの選択 

Back: 後にスキップ 

Next: 前にスキップ 

Search Property: スキップの設定 

Event: イベントマーク書込み 

Eject: (イジェクト) 

Pause: 一時停止 

Rec/Play: 記録/再生開始 

RecStandby: 記録スタンバイ 

Stop: 停止 

 

 

 

 

 

 

 

 

 

 

Status Bar： ステータスバーの表示、消去

Toolbar： ツールバーの表示、消去 

Hdr： 再生ヘッダ情報の表示、消去 

Bar： バーグラフの表示、消去 

Digit： ディジタル値の表示、消去 
 

Fan： ファンの強制停止の On/Off 

Speaker： データを音で再生 On/Off 

Amp Calibration： キャリブレーション実行 

About LXNavi： ヘルプ（バージョンの表示） 
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メイン画面のあらまし 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ステータスバー表示 

ファン停止の残り時間 モード表示 

記録モード時は RECORD、 

再生モード時は VIEW 

日時表示 

記録モード時は現在の日時、

再生モード時は記録日時 

イベントマーク数 

動作モード表示 

STOP: アイドル状態 

RECSTANDBY: 記録待機状態

REC: 記録中 

PLAY: 再生中 

PAUSE: 再生一時停止中
経過時間 

メディアのステータス表示 

MEDIA READY: メディア Ready 

NO MEDIA: メディアなし 

BAD MEDIA: 不正なメディア 

RUNNING: 動作待機中 

READING: DATA 読込中 

WRITING: DATA 書込中 

FORMATTING: FORMAT 中 

EJECTING: EJECT 中 

MEDIA ERROR: メディアリード／ライトエラー

UNFORMAT: 未フォーマット 

PROTECTED: 書込み禁止 

MEDIA FULL: メディアフル 

ファンの強制停止の On/Off 

データを音で再生 On/Off 

バーグラフの表示、非表示 

ディジタル値の表示、非表示 

キャリブレーションの実行 

ツールバー 

データを記録するデバイスの選択、

ディレクトリ・ファイル名の指定 
再生データの選択 

データのコピー 

動作、記録条件

生条件の設

再

定 

再生ヘッダ情報の表示、非表示 

トリガ動作の設定 
設定の保存、読み込み 

TEDS 情報読み込み 

オートオフセット 

実入力キャリブレーション 
スキップの設定

前にスキップ

後にスキップ

停止 

記録スタンバイ 

開始 

一時停止 

イベントマーク書込み

(イジェクト)

ゼロバランス 

メディアのフォーマット 
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 設定値の初期化 

メニューバーから All Clear を実行した場合、LX 本体のアンプ構成が変更された場合など、LX 本体で保持している設定値が初期化さ

れた場合下記のメッセージが表示されます。 

設定値の確認・変更を行って下さい。 

 

 

 

 

 

 

 

 

 



記録・再生のながれ 

 記録・再生のながれ 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

再生モードになる 

LX Navi 起動 

記録 
File, New 

再生 
File, Open 

記録デバイス、ファイル名指定

記録モードになる 

記録の操作 

メモリー記録停止後、メディアまたは PC に保存 

再生ファイル選択 

特定の記録データの項目をダブルクリックする

と記録されたデータの詳細情報が下記のダイ

アログの様に表示されます。 

再生の操作 

メモリー記録が 

選択された場合 
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システムの設定 

 システムの設定 
Setup メニューから System を選択して LX 本体の動作を設定します。 

 

LX-1１0 の場合 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LX-１20 の場合 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
AD Width 
量子化ビット数の指定で 16Bit か,24Bit のいずれかを選択します。 

 

Sample 
サンプリング周波数を選択します。上段で設定したいサンプリング周波数が含まれるサンプリング周波数系列を選択し、下

段で表示されるサンプリング周波数を選択します。選択可能なサンプリング周波数は、選択された記録メディア、タコパルス

入力チャネルモードの選択により制限を受けます。「1-13 サンプリング周波数とチャネル数」を参照して下さい。 

 

設定項目のタブ 

サンプリング周波数の設定 

パネルロック 

記録中にファンを止める 

メモ音声を録音する 

時計合わせ 

モニター出力チャネルの設定 

スロット 1 の使用チャネル数の設定 

スロットを有効にする 

モニター出力のレンジ設定 

量子化ビット数の指定  

キャリブレ-ション 

変更したチャネル

以降のチャネル設

定を同様にする 
ST アンプの設定時にゼロバランスを自動的に行う。 

REC STANDBY 時に PC の時刻に合わせる。 

設定項目のタブ 

サンプリング周波数の設定 

パネルロック 

記録中にファンを止める 

メモ音声を録音する 

時計合わせ 

モニター出力のレンジ設定と 

ジェネレータ出力の詳細設定

スロット 1 の使用チャネル数の設定 

スロットを有効にする 

タコパルス入力チャネル設定概要 

モニター出力チャネルの設定 

量子化ビット数の指定  

キャリブレ-ション 

変更したチャネル

以降のチャネル設

定を同様にする 
ST アンプの設定時にゼロバランスを自動的に行う。 

REC STANDBY 時に PC の時刻に合わせる。 
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システムの設定 

 

 

 

 

 

 

 

 

 

 

 

 

 

LX-1１0 の場合 

LX-110 では、上段では<96k-1.5k>と<1k-1/60>系列のみ選択可能で、下段で設定できるサンプリング周波数は

<96k-1.5k>の場合 96 kHz、48 kHz、24 kHz、12 kHz、6 kHz、3 kHz、1.5 kHz、<1k-1/60>の場合、1 kHz、500 Hz、200 

Hz、100 Hz、50 Hz、20 Hz、10 Hz、5 Hz、2 Hz、1 Hz、1/2 Hz、1/5 Hz、1/10 Hz、1/30 Hz、1/60 Hz のいずれかとなり

ます。 

LX-１20 の場合 

LX-120 では、<96k-1.5k>>と<1k-1/60>系列に加えて更に、<100k-1k> (100 kHz、50 kHz、20 kHz、10 kHz、5 kHz、2 

kHz、1 kHz から選択)、<102.4k-1.28k> (102.4 kHz、51.2 kHz、25.6 kHz、12.8 kHz、5.12 kHz、2.56 kHz、1.28 kHz から

選択)、<65.536k-1.024k> (65.536 kHz、32.768 kHz、16.384 kHz、8.192 kHz、4.096 kHz、2.048 kHz、1.024 kHz から

選択)の 5 つのサンプリング周波数系列の中から選択できます。 

Memo 
メモ音声を録音するときは<ON>に設定して下さい。メモ音声のデータはメモ音声ファイルとしてデータファイル、ヘッダファイルと

は別に記録され、毎秒 8,000 バイトです。このデータはマイクロホンをジャックから抜いても増えますので、ご注意下さい。 

 

■ LX 本体のメディア(MEMORY か CARD)と PC の両方を記録先に指定した場合でメモ音声の録音を<ON>に設定した

場合、LX 本体のメディアのみにメモ音声のデータファイルが作成され、PC 側にはメモ音声のデータファイルは作成されま

せん。 

■ プリトリガ区間のメモ音声は録音されません。また、再生時はメモ音声の先頭とデータの先頭とが一致して再生されます

ので、タイミングがずれます。 

 

 

 

 

 

Fan 
<OFF>に設定すると記録開始から 10 分間 LX 本体の冷却ファンを止めることができます。騒音などを記録する場合に便利

です。一度ファンを止めて記録したら、次にまたファンを止めて記録するまでは約 10 分間以上時間をおいて下さい。 

<ON>に設定した場合、冷却ファンは動作しますが、ツールバーの FAN 強制停止ボタンをクリックすると、記録中にファンを強

制的に停止することができます。もう一度クリックするとファンは動作します。ファンを停止できる時間は、一つの記録開始から

停止までで、合計 10 分間で、<ステータス表示>に残り時間が表示されます。(「3-3 メイン画面のあらまし ツールバー・ステ

ータス表示」参照) 

 

Panel 
<Lock>に設定すると、本体のフロントパネルの操作ボタンを無効にすることができます。 

プリトリガ 
データ再生 

音声再生 
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Calibration 
<ON>に設定すると本体の電源立ち上げ時に、自動的にキャリブレーションを実行します。 

<OFF>に設定して 1 度キャリブレーションを実行すると、それ以後は本体の電源立ち上げ時にキャリブレーションを実行しま

せん。 

手動でキャリブレーションを実行する場合はマニュアルキャリブレーションを実行してください。 

 
Clock 
本体の内蔵時計を修正します。ここには内蔵時計による現在日時が表示されています。日付を変更するには、日付の右

の▼をクリックするとカレンダーが現れますので、希望の日付をクリックして選んで下さい。時刻を変更するには、変更したい桁

をクリックして反転させてから数を入力するか、右の▲、▼をクリックして数を増減させて下さい。最後に時報に合わせて Set
をクリックすると、その瞬間に時計が修正されます。 

PC をクリックすると、接続された PC の時刻が LX 本体にセットされます。 

 

Slot Use 
記録、再生に使用するスロットをチェックして有効にして下さい。Slot 1 に対しては、記録に使うチャネル数を 2、4、8 チャネル

から選択することができます。 

ここで有効にした各スロットにインストールされた入出力アンプの設定は、System ダイアログの各スロットのタブをクリックして

行います。 

LX-120 でタコパルス入力チャネルを有効にするには、Tacho をチェックして下さい。 

 

■ タコパルス入力とジェネレータ出力機能を同時に使用することはできません。 

 

Same Setting 
アンプの各チャネルの設定をする場合、ボックスをチェックすると設定チャネル以下のチャネルも同一の内容が設定されます。 

 

Auto Zero Balance 
ST アンプが装着されている場合、ボックスをチェックすると設定終了後に自動的にゼロバランスを実行します。 

 
Adjust to PC Clock Before REC STANDBY 
ボックスをチェックすると REC スタンバイ時に PC の時刻に本体の時刻を合わせます。 

 

 



システムの設定 

 
Monitor/Generator 
Signal では背面の MON OUT コネクタから出力するモニターチャネル、または、ジェネレータ出力信号(LX-120 の場合のみ)

を選択します。出力しない場合は<NONE>に設定して下さい。 

Property をクリックして、モニターチャネルの出力レンジや、ジェネレータ出力の詳細設定を行います。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Signalでは、モニターチャネルの選択、または、ジェネレータ出力信号の種類(LX-120のモニター出力よりsine、sweep sine、

pulse、pink noise、または white noise を出力することができます。) を選択することができます。 

ジェネレータ出力が選択された場合、このダイアログで設定できる内容は下記となっています。(選択された信号種類により

設定できる内容が自動的に選択されます。) 

Sin/Sweep 
Start Freq: Signal で<sine>、<sweep sine>が選択されたときの開始周波数を 0～43000(Hz)の範囲で設定しま

す。但しモニター出力される周波数はサンプリング周波数の 1/2．4 が上限となります。 

Stop Freq: Signal で<sweep sine>が選択されたときのスイープ終了周波数を 0～43000(Hz)の範囲で設定します。

但しモニター出力される周波数はサンプリング周波数の 1/2．4 が上限となります。 

Rate: Signal で<sweep sine>が選択されたときのスイープレートを 0～80(Sec)の値で設定します。この値が大きい

場合、Start Freq、Stop Freq で指定した周波数がモニター出力されるまでに時間がかかる場合があります。 

Pulse 
Pulse Width: Signal で<pulse>が選択されたときのパルス幅を 0～65535 (mSec)の範囲で設定します。 

Pulse Interval: Signal で<pulse>が選択されたときのパルスインターバルを 0～65535 (mSec)の範囲で設定しま

す。 

 

Range では出力レンジを設定します。レンジは 1 V から 5 V まで 0.1 V ステップで選択することができます。 

 

ジェネレータ出力の仕様については、6 章を参照して下さい。 

■ タコパルス入力とジェネレータ出力機能を同時に使用することはできません。 

■ 低速サンプリング系列(1 kHz ～ 1/60 Hz)で記録時、モニター出力からのアナログ出力は使用できません。 

■ ジェネレータ出力で設定できる sine、sweep sine の周波数はサンプリング周波数の 1/2．4 までとなります。 

■ サンプリング周波数が 102.4kHz に設定されている場合、ジェネレータ出力は使用できません。 
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入力アンプの設定 

 

 入力アンプの設定 
System ダイアログで、入力アンプが取り付けられているスロットのタブをクリックして入力アンプの設定を行います。 

各スロットに取り付けられているアンプの種類により設定内容が異なります。 

 

 DCアンプ AR-LXDC100 
Slot タブに<DC100>と表示されます。アンプの仕様については、6 章を参照して下さい。 

 
入力レベルを確認する 

 入力レンジの選択 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

レンジの設定 

±0.5、1、2、5、10、20、50 V から選択できます。AD 変換値は選択したレンジの±131%の範囲をとり得ますが、入力余裕

度は約±120%です。入力が±120%を超えないようにレンジを選択して下さい。信号を入力し、右の  ボタンをクリックして

レベルを確認しながら設定して下さい。 

 

Auto 
信号を入力してクリックすると自動的に最適な入力レンジに設定することができます。 

 

全チャネルの入力レベルを確認する 

入力レベルの確認を止める 

入力レンジを自動的に設定する 
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入力アンプの設定 

 PA アンプ AR-LXPA100 
Slot タブに<PA100>と表示されます。 

AR-LXPA100 は、電圧出力型加速度センサ等の入力に対応したアンプです。 

アンプの仕様については、6 章を参照して下さい。 

 

PA アンプ使用上の注意 

 

■ キャリブレーション 

入力レンジ 0.01 V で測定される場合は、測定を始める前に 10 分間以上ウォームアップしてからマニュアルキャリブレーション

を実行することをおすすめします。キャリブレーションを実行するには付属ソフト LX Navi でツールバーの     ボタンをクリック

します。これにより、高精度の測定が可能となります。高精度測定を行うときは、平衡モードで測定することをおすすめしま

す。 

 

■ 接続・接地について 

バッテリ駆動センサを使用する場合 

入力モード: 平衡（Bal）モード 

LX 本体のフレームグランド（FG）をできるだけ接地して下さい。 

 

AR-LXPA100 

GND

FG

LX本体

- 

++

- 

Vs 

 

 

 

 

 

 

 

 

 

 

交流電源駆動センサアンプを使用する場合 

入力モード: 平衡（Bal）モード 

入力信号源のフレームグランド（FG）と LX 本体のフレームグランド（FG）を必ず接地して下さい。 

 

FG

Vs 

+

- 

LX本体

AR-LXPA100

+

- 

 

 

 

 

 

 

 

 

 
GND GND

 

 

■ 未使用入力端子の取り扱い 

入力アンプの入力インピーダンスは 1MΩとハイインピーダンスですので、外乱ノイズﾞが混入し波形表示が乱れたり、バーグラ

フ表示が振り切れたりする事がありますので入力レンジを最大にセットしてご使用していただいくか、入力をショートして戴く事

によって外乱ノイズによる影響を防止することが出来ます。 
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入力アンプの設定 

一般的な交流電源駆動信号出力装置やIEPEセンサを使用する場合 

入力モード: 不平衡（Unbal）モード 

入力信号源のフレームグランド（FG）を接地した場合は、LX 本体のフレームグランド（FG）は接地しないで下さい。 

入力信号源のフレームグランド（FG）がない場合は、LX 本体のフレームグランド（FG）を接地して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

GND 

FG

Vs 

- 

+ +

- 

LX本体

AR-LXPA100

AR-LXPA100

FG

Vs 

- 

+ +

- 

LX本体

GND 
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入力アンプの設定 

AR-LXPA100 設定画面 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AR-LXPA100 設定画面 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ウェイティングの選択を行います。 

A: A 特性 

C: C 特性 

FLAT: フラット 

HPF 選択を行います。 

OFF: なし 

10Hz: 10 Hz 

20Hz: 20 Hz 

入力レンジを選択します。(0.01 V、0.0316 V、0.1 V、

0.316 V、1 V、3.16 V、10 V、50V) 

入力レンジを自動的に設定する 

入力レベルの確認を止める 

全チャネルの入力レベルを確認する 

センサに電源を供給するか否かを選択します。 

OFF: 供給しない 

4mA: 4 mA の定電流を供給する 

平衡/不平衡モード選択 

Bal: 平衡 

Unbal: 不平衡 

不平衡モードのときは 8 チャネルすべて

DC 結合となります。 

AC 結合か DC 結合かを選択します。 

AC: AC 結合 

DC: DC 結合 

 

 

Bal/Unbal: AC 結合で 4mA が設定されている時は Bal の設定はできません。 

 

■ AR-LXPA100 アンプの場合、センサ供給電源は、標準では 28 V DC の設定となっています。24 V DC への設定に関して

は、弊社までお問い合わせ下さい。 
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入力アンプの設定 

 STアンプ AR-LXST100 
Slot タブに<ST100>と表示されます。 

AR-LXST100 は、歪みゲージおよび歪みゲージタイプの各種センサと DC 電圧に対応した入力アンプです。 

アンプの仕様については、6 章を参照して下さい。 

 

ST アンプ使用上の注意 

 

■ キャリブレーション 

測定を始める前に 20 分間以上ウォームアップしてからマニュアルキャリブレーションを実行することをおすすめします。キャリブレ

ーションを実行するには付属ソフト LX Navi でツールバーの     ボタンをクリックします。これにより、高精度の測定が可能と

なります。 

 

■ 接続・接地について 

トランスデューサを使用する場合 

入力モード: 平衡（Bal）モード 

LX 本体のフレームグランド（FG）をできるだけ接地して下さい。 

 

AR-LXST100

FG

LX本体

- 

+ +

- 

Vs 

 

 

 

 

 

 

 

 

 

GND 

交流電源駆動センサアンプを使用する場合 

入力モード: 平衡（Bal）モード 

入力信号源のフレームグランド（FG）と LX 本体のフレームグランド（FG）を必ず接地して下さい。 

 

AR-LXST100

FG

LX本体
++ 

- - 

Vs 

 

 

 

 

 

 

 

 

 

GND GND 

 

 

■ 未使用入力端子の取り扱い 

入力アンプの入力インピーダンスは 1MΩとハイインピーダンスですので、外乱ノイズﾞが混入し波形表示が乱れたり、バーグラ

フ表示が振り切れたりする事がありますので入力レンジを最大にセットしてご使用していただいくか、入力をショートして戴く事

によって外乱ノイズによる影響を防止することが出来ます。 
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入力アンプの設定 

 

AR-LXST100 設定画面 

 

入力レンジを選択します。  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ローパスフィルタの設定を行います。 

ブリッジ電圧を切り替えます。 

OFF にすると DC 電圧の入力レンジ設定ができます。 

uST ⇔ mV/V 

入力レンジ表示を切り替えます。 

右下の uST をクリックすると mV/V 表示に切り替わります。 

全チャネルの入力レベルを確認する 

入力レベルの確認を止める 

ST100 アンプの場合入力レンジを

自動的に設定する機能は使用出

来ません。 
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TEDS 機能を利用した感度設定 

 TEDS機能を利用した感度設定 
AR-LXPA100 アンプに、IEEE Std 1451.4 A SMART TRANSDUCER INTERFACE に準拠したトランスデューサが接続さ

れた場合、そのトランスデューサの Transducer Electronic Data Sheet (TEDS)と呼ばれる個別情報を読み取り、情報の表

示や感度係数の設定を自動的に行うことができます。 

 

■ トランスデューサ情報が、IEEE 標準の TEDS テンプレートに準拠していない場合は、正しい情報を読み取り表示を行う

ことはできません。 

■ 対応している TEDS テンプレートは以下の通りです。 

Template ID Type TEDS Version 

0 - 3 Accelerometer 

12 - 23 Microphones 

24 Accelerometer 

IEEE P1451.4 (ver0.9) 

25 Accelerometer/Force transducer w. const. curr. ampl. 

27 Microphones w. built-in preamp. 
IEEE 1451.4 (ver1.0) 

 

 

1. メイン画面のツールバーアイコンの          をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 
2. TEDS ダイアログが表示されます。 

TEDS トランスデューサを接続後、LX 本体を立ち上げた場合は、起動時のキャリブレーション時に自動的に TEDS 情報が

読み込まれ、この画面は表示されず、次の Update ボタンがクリックされた画面となります。 
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TEDS 機能を利用した感度設定 

4-13 

3. Update をクリックすると、アンプに接続された TEDS 対応のトランスデューサの情報を読み込みます。 

TEDS トランスデューサを接続後、LX 本体を立ち上げた場合は、起動時のキャリブレーション時に自動的に TEDS 情報が

読み込まれ、この画面となります。 

 

 

 

 

 

 

 

 

 

 

 

4. Update TEDS information メッセージが表示されますので、OK をクリックします。 

各チャネルに接続された TEDS 対応のトランスデューサの、校正感度(sensitivity)、物理量単位(unit)、軸名(axis)、セ

ンサタイプ(type)、シリアル番号(serial)、型番（model）、製造者名(manufacturer)、校正日付(cal date)が一覧でき

ます。 

 

 

 

 

 

 

 

 

 

 

 

 

読み取られた感度情報を係数として感度設定を行うチャネル番号の左のボックスをクリックして、チェック状態にします。 

 

 チェックボックス 
 

 

 

 

 

 

 

 

 

 
5. OK をクリックすると、チェックされたチャネルの感度値に対応した値 (読み込まれた感度値の逆数)がヘッダファイルの

SLOPE の値として記録され、ダイアログが閉じられます。メイン画面のチャネルプロパティリストを開いて、チェックされたチャネ

ルの SLOPE の値が更新されていることを確認します。(「5 章 チャネルのプロパティ」参照) 

 



実入力によるキャリブレーション 

 オートオフセット 
LX Navi のオートオフセット機能は、オートオフセットボタンがクリックされたときの状態を計測し、そのときの電圧値をオフセット

値として自動的にヘッダファイルに記録する機能です。オフセット値が設定された場合は、LX Navi のモニター表示は、この電

圧値で Y 軸のゼロオフセットを行い波形データ表示します。 

 

1. LX 本体が停止状態のときに、ツールバーアイコンの         をクリックします。 

 

2. Channel Unit テーブルが表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. オフセットを行うタイミングで、Channel Unit テーブルの Auto Offset をクリックします。そのときの各チャネルの電圧値

が測定され percent フィールドにレンジのフルスケールに対するパーセント値で表示されます。確認のダイアログが表示されま

すのでオフセット値を表示されている値に更新するときは、[はい(Y)]をクリックします。offset フィールドにオフセット値が表示さ

れます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.表示されているオフセット値で設定を行う場合は、チャネル横のチェックボックスをチェックして、OK をクリックします。 
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実入力によるキャリブレーション 
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 実入力によるキャリブレーション 
PA アンプでは、キャリブレータまたはピストンホンを用いて接続されたセンサの実校正係数を自動設定することができます。 

 

 

1. LX 本体が停止状態のときに、ツールバーアイコンの         をクリックします。 

 

2. Channel Unit テーブルが表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Calibration をクリックします。 

 

4. Cal. Sound/Vibration ダイアログが表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. キャリブレーション終了後、Exit をクリック、または       をクリックしてメイン画面に戻ります。 

 

キャリブレーションを行うセンサの

種類を選択します。 

チャネルを選択します。 

キャリブレーションを RMS 値で行う 

か Peak 値で行うかを選択します。 

キャリブレーションを実行します。 

使用するキャリブレータに合わせて出

力レベルを選択します。 

キャリブレーション結果を校正係数として反映します。 

キャリブレーションの進行状況が表示されます。 

 



ゼロバランス 

 ゼロバランス 
ST アンプでは、電源を入れるたびにゼロバランスをとってください。 

 

1. LX 本体が停止状態のときに、ツールバーアイコンの          をクリックします。 

 

2. Zero Balancing ダイアログが表示されますので、ゼロバランスを実行するチャネルにチェックを入れ”Execute”ボタンを

押すと ゼロバランスを開始します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. ゼロバランスの実行中は下記のダイアログが表示され、終了するとダイアログが消え、結果が表示されます。 

 

 

 

 

 

 

 

4. 各チャネルのゼロバランスの結果が”State”の項目に表示され、正常なら”OK” 異常なら”NG” が表示されます。信号

が無入力のチャネルはレンジ設定を最大 (100000uST／50mV/V) にして下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
5. ゼロバランスを終了する場合は、Exit をクリック、または       をクリックしてメイン画面に戻ります。 
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タコパルス入力の設定 

 タコパルス入力の設定 
LX-120 では、アナログ入力チャネルとは別に、タコパルス用に A,B 2 つの入力チャネルを備えています。タコパルス入力用の

BNC コネクタはリアパネルにあります。 

タコパルス入力チャネルでは、16 ビットモード、または 32 ビットモードのいずれかの選択が可能です。16 ビットモードが選択さ

れた場合は、A､B 両方のタコパルス入力チャネルが使用できます。A､B いずれかのチャネルのみの指定は出来ません。32 ビ

ットモードでは A､B いずれかまたは両方のチャネルを選択し使用できます。但し 24 ビット AD に指定している場合、16 ビット

モードの指定は出来ません。 

 

なお仕様については、6 章を参照して下さい。 

 

■ タコパルス入力チャネルは、16 ビットモードのときは、 タコパルス入力 １チャネルが アナログ入力 １チャネル分に、32 ビッ

トモードのときは、タコパルス入力１チャネルがアナログ入力 2 チャネル分に相当します。タコパルス入力チャネルを ON とした

場合、同じアナログ入力チャネル数の記録を確保するためには、選択されたタコパルス入力チャネルに応じて、サンプリング

周波数を低く設定します。 

 

■ 102.4 kHz、 100 kHz、96 kHz、 65.536 kHz、 51.2 kHz、 50 kHz、48 kHz、または、32.768 kHz サンプリング周波数

選択時 Moving Average は[1]以外は設定しないで下さい。 

 

■ 102.4 kHz、100 kHz、96 kHz、または、65.536 kHz サンプリング周波数を選択しタコパルス入力チャネル 32 ビットモード

で使用する場合は、1 x タコパルス入力チャネルのみ使用可能です。 

 

■ LX Navi ではタコパルス入力チャネルを波形表示することはできません。入力値をモニターする場合はディジタル表示画

面を開いてディジタル値でモニターを行って下さい。〔5-17 参照〕 

 

■ 記録されたタコパルス入力の信号を再生することはできません。ディジタルデータとして処理して下さい。 

 

■ タコパルス入力とジェネレータ出力機能を同時に使用することはできません。 

 

■ エイリアシングが発生する場合があります。 

 

■ アナログデータとタコパルスデータのサンプリングは非同期です。 

 

■ 収録時途中よりタコパルス入力が無い場合最後のタコパルスデータが保持されます。 

 

 

 

 

 

 

 

 

 

 

 

タコパルス入力 

Ach   Bch 

 

SERIAL NO.

MADE IN JAPAN

RECORDING UNIT

12-28V ,

TEAC CORPORATION

LX-120

6.5-2.8A

BATTERY UNIT:BU-81
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タコパルス入力の設定 

System ダイアログで、Tacho と表示されたタブをクリックしてタコパルス入力チャネルの設定を行います。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

使用するチャネルにチェックをつけ、16bit または32bit を選択します。それぞれのチャネルに異なるビット数を選択することはで

きません。設定できるその他のパラメータは次の内容です。また 24 ビット AD に指定している場合、16bit の指定は出来ませ

ん。 

 

設定項目 (ただし、前述の制限事項にご注意下さい。) 

設定項目 内容 

Measurement  計測モード 

pulse (gate) ゲート時間内のパルス数カウントモード 

pulse (total) 計測のスタートからストップまでのトータルカウント 

Period 周期カウントモード 

Frequency 周波数計測モード 

Rpm 回転数計測モード 

Range  測定レンジ 

pulse (gate) モード時 サンプリング周期の 1～255 倍 

period モード時 1m、5m、10m、50m、100m、500m、1 sec 

frequency モード時 10、20、50、100、200、500、1k、2k、5k、10k、20 kHz 

rpm モード時 1500、3000、6000、9000、12000、15000、18000、24000 rpm 

Threshold Level スレショルドレベル設定 ±0.5、±1、±2.5、±5、±10、±20 V

（信号の立ち上がり・立ち下がりを UP・DOWN で選択） 

Divide Rate 分周比設定 1～255 

Moving Average 移動平均設定 1～16 

Pulse per Rev. 一回転あたりのパルス数 1～255 
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出力アンプの設定 

 出力アンプの設定 
System ダイアログで、出力アンプが取り付けられているスロットのタブをクリックして出力レンジを設定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

出力レンジの設定 

出力レンジは 1 V から 5 V まで 0.1 V ステップで選択することができます。 

 

■低速サンプリング系列(1 kHz ～ 1/60 Hz)で記録・再生時、出力アンプからのアナログ出力は出来ません。 

 

■ チャネル拡張を行い入力アンプが複数存在する場合には、必ず Output Slot で出力するスロットを設定して下さい。 

 

■ LX シリーズでは、入力レンジの±100% の AD 値が、16 ビット AD で±25000、24 ビット AD で ±6400000 に相当しま

す。ここで設定された出力レンジを±100%として記録された入力信号の AD 値に対応する電圧の出力を行います。 

例えば、入力レンジ 1 V、出力レンジ 2 V の設定で+1V の信号を入力し記録、再生すると+2V が出力されます。 

 

出力レンジの選択 

出力を行う対象の入力ア

ンプスロットの選択 
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トリガ動作のあらまし 

 トリガ動作のあらまし 
マニュアル操作による以外に、次のようなモードで自動的に記録を開始・停止させることができます。 

 

 リピートモード 
下図のような記録動作を指定回数だけ繰り返します。1 回だけの記録も可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

〈記録開始条件〉 

■ レベルトリガ 

指定チャネルのレベル変化をトリガとします。 

■ 外部トリガ 

背面の EXT TRIGGER IN コネクタが L レベル（0.6 V 以下）になると開始します。記録待機状態になった時にすでに L レベ

ルであった場合は、メモリー記録、メディア記録ではすぐに開始します。PC 記録の場合は記録待機状態になった後に H から

L に変化して初めて記録開始します。 

■ タイムアウト 

指定した記録開始条件が一定の時間内に成立しなかった場合に、強制的に記録を開始します。 

■ プリトリガ 

上記の記録開始条件が成立する前のデータもバッファにたくわえて記録します。この区間のメモ音声は録音されません。 

 

<記録停止条件〉 

■ レベルトリガ 

指定チャネルのレベル変化をトリガとします。 

■ 外部トリガ 

背面の EXT TRIGGER IN コネクタへの接点信号が H レベル（オープンまたは 2 V 以上）になると停止します。 

■ 記録時間 

指定時間だけ記録します。 

■ ポストトリガ 

上記の記録停止条件が成立してからも、一定時間記録を続けます。マニュアル操作で記録を停止させた場合、ポストトリ

ガは記録されません。 

 

ポストトリガ プリトリガ 

開始 停止 

記録開始条件成立 

レベルトリガ 

外部トリガ 

タイムアウト 

記録停止条件成立 

レベルトリガ 

外部トリガ 

記録時間 

■ トリガ動作をさせるにはトリガの設

定後、ツールバーの●ボタンをクリック、

または本体の REC ボタンを押して記録

待機状態にして下さい。 

■ トリガ動作を有効に設定しても、ツ

ールバーまたは本体のボタンは無効には

なりません。 

 

4-20 



トリガ動作のあらまし 

 インターバルモード 
指定時刻に記録を開始・停止することを指定回数だけ繰り返します。1 回だけの記録も可能です。 

 

 

 

 

指定記録時間
開始 停止

指定ポーズ時間 指定記録時間 指定記録時間
開始 開始 停止停止 

指定ポーズ時間 

 

 

 指定時刻 
(3 回繰り返しの例) 
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リピートモードの設定 

 リピートモードの設定 
トリガ動作の設定は Setup メニューから Trigger を選択して行います。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上図の設定例ではレベルトリガで記録開始し、外部トリガで記録停止します。10 秒のプリトリガを指定してあり、記録回数

は 1 回です。 

 

Pre/Post 
プリトリガまたはポストトリガを有効にする場合にチェックします。ここをチェックするとプリトリガ・ポストトリガが有効になります。

（ツールバーまたは本体のボタン操作による記録停止に対しては、ポストトリガは無効です。） 

 

Start PreTrig 
プリトリガの長さを秒またはスキャンの単位で指定します。単位を切り替えるには右のボタンをクリックします。「0」に設定すると

無効になります。下記のプリトリガ設定上限値を超えないように設定して下さい。 

 

プリトリガで設定できる上限値は次の式で計算できます。 

上限値 （スキャン） 

= (63MByte x 0.6) / [((アナログ記録チャネル数 + タコパルス入力チャネル数) x AD 幅) ] 

上限値 （秒） 

= 上限値 （スキャン） / サンプリング周波数(Hz) 

  

※ 63MByte x 0.6: プリトリガに使用できるメモリー容量は 63MByte の 60%です。 

（オプションで拡張メモリーを追加しても、プリトリガに使用できるメモリー容量は変わりません。） 

※ AD 幅: 16 ビット AD の場合 2, 24 ビット AD の場合 4 

秒⇔スキャンの切り替え 

プリ/ポストトリガを有効にする 

プリトリガの長さを指定 

レベルトリガで記録開始 

リピートモードを有効にする 

外部トリガで記録停止 

繰り返し回数 

記録時間の設定 

レベルトリガの設定(次ページ) 

 

タコパルス入力チャネル数は、16 ビット AD の場合、タコパルス入力 16 ビットモードのときは 2、32 ビット 1 チャネルモードのときは

2、32 ビット 2 チャネルモードのときは 4 となります。24 ビット AD の場合、タコパルス入力 16 ビットモードは選択不可、32 ビット 1

チャネルモードのときは 1、32 ビット 2 チャネルモードのときは 2 となります。(タコパルス入力チャネルは LX-120 のみ対応) 
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リピートモードの設定 
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※ 96kHz 系列のサンプリング周波数とチャネル数によるプリトリガ上限値（秒） 1MByte = 1048576Byte で計算 
(16ビットAD / 24ビットAD)

96kHz系列
サンプリングレート(kHz) 2 4 8 16 24 32

96 103 / 51 51 / 25 25 / 設定不可 設定不可 設定不可 設定不可
48 206 / 103 103 / 51 51 / 25 25 / 設定不可 設定不可 設定不可
24 412 / 206 206 / 103 103 / 51 51 / 25 34 / 設定不可 25 / 設定不可
12 825 / 412 412 / 206 206 / 103 103 / 51 68 / 34 51 / 25
6 1651 / 825 825 / 412 412 / 206 206 / 103 137 / 68 103 / 51
3 3303 / 1651 1651 / 825 825 / 412 412 / 206 275 / 137 206 / 103

1.5 6606 / 3303 3303 / 1651 1651 / 825 825 / 412 550 / 275 412 / 206

チャネル数によるプリトリガ上限値 (秒)
  

 

 

 

 

 

 

 

注意： (アナログ記録チャネル数 + タコパルス入力チャネル数) x サンプリング周波数(Hz) x AD 幅 ≧ 524288 

の条件でプリトリガを設定した時、継続的な記録動作が出来ない（記録途中メモリーフルで停止）場合があ

ります。 

 

 

 

Stop PostTrig 
ポストトリガの長さを秒またはスキャンの単位で指定します。単位を切り替えるには右のボタンをクリックします。「0」に設定す

ると無効になります。下記のポストトリガ設定上限値を超えないように設定して下さい。 

 

ポストトリガで設定できる上限値は次の式で計算できます。なお記録先のメディアの容量がフルになった場合は、ポストトリ

ガの設定値にかかわらずメディアの容量がフルになった時点で停止します。 

上限値 （スキャン） 

= 999999999 

上限値 （秒） 

= 999999999 / サンプリング周波数(Hz) 

  

 

 



リピートモードの設定 

Repeat 
リピートモードを有効にする場合にチェックします。 

 
Start Condition 
記録開始条件を指定します。複数の条件を指定すると、それらのうちいずれか先に成立した条件で記録開始します。 

Level: レベルトリガを有効にする場合にチェックします。レベルトリガの詳細は Level Trig - Property をクリックすると現れ

るダイアログで設定します。（次ページ） 

External: 外部トリガを有効にする場合にチェックします。 

Timeout: レベルトリガ、外部トリガを有効にした場合、指定の記録開始条件が一定の時間内に成立しなかった場合に、

強制的に記録を開始します。その時間を秒の単位で設定して下さい。「0」に設定すると無効になります。最大値は

4294967295 秒です。 

 
Stop Condition 
記録停止条件を指定します。複数の条件を指定すると、それらのうちいずれか先に成立した条件で記録停止します。 

Level: レベルトリガを有効にする場合にチェックします。レベルトリガの詳細は Level Trig - Property をクリックすると現れ

るダイアログで設定します。（次ページ） 

External: 外部トリガを有効にする場合にチェックします。 

RecTime: 記録開始から指定時間後に停止します。その時間はここをクリックすると現れるダイアログで設定します。設定

するとここに時間が表示されます。 

 

■ 外部トリガ信号を記録スタートトリガ、さらに REC TIME を使用してリピート記録する場合には、次のスタートの前に、一

旦トリガ信号レベルを H 状態にして下さい。 

 

Repeat Count 
以上で設定したトリガ記録動作の繰り返し回数を指定します。指定した回数分のファイルができます。1 回だけの記録も可

能です。「0」に設定すると無限回（手動で停止するまで繰り返し）の設定になります。最大値は 65534 回です。複数回また

は無限回の指定の場合、記録終了後次の記録開始までに、同期記録（「5 章 同期記録機能」参照）を行わない場合

は、3 秒以上、同期記録を行う場合は、5 秒以上必要です。(メディア記録の場合等、それ以上の秒数が必要となる事が

あります)。 
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レベルトリガの設定 

 レベルトリガの設定 
レベルトリガの詳細は Trigger ダイアログで Level Trig - Property をクリックして設定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上図の設定例では、第 2 チャネルの入力信号が指定した入力レンジの＋50％より低い方から高い方向にクロスし、なおか

つ第 3 チャネルの信号も同様に＋50％より低い方から高い方にクロスした時に記録開始し、第 2 チャネルの入力信号が指

定した入力レンジの－20％より高い方から低い方にクロスした時に停止します。 

 

チャネルの選択 

チャネルのリストから希望のチャネルをクリックします。または、下のドロップダウンリストから選択します。 

 

クロス方向の選択 

Up: 入力信号が指定レベルより低い方から高い方にクロスした時に条件成立とみなします。記録待機状態にした時にすで

に指定レベルを超えていた時は成立と見なしません。 

Down: 入力信号が指定レベルより高い方から低い方にクロスした時に条件成立とみなします。記録待機状態にした時に

すでに指定レベルを下回っていた時は成立と見なしません。 

Ignore: レベルトリガの監視対象チャネルになりません。 

 

レベルの設定 

指定した入力レンジのフルスケールをプラス側、マイナス側それぞれ 100％とし、それに対する監視レベルを－99～＋99%の

範囲で設定します。マイナスの値には符号「－」をつけて下さい。上図の例では入力レンジが±10 V レンジの場合、50％は

+5 V、－20％は－2 V に相当します。 

 

ロジック 

Start、Stop のそれぞれで複数のチャネルを監視対象にした場合に、それらの AND をとるか OR をとるかを指定します。 

■ ロジックで AND を指定した場合は、監視対象のチャネルは同一スロット内として下さい。 

 

条件成立回数 

上記で指定した条件（ロジックを含めて）が何回満たされたら成立と見なすかを指定します。 

最大値は 32767 回です。 

ロジックの切り替え 条件成立回数 

設定するチャネルをクリック 

ここでもチャネル選択可能 

クロス方向の選択 

レベルの設定 
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インターバルモードの設定 

 インターバルモードの設定 
トリガ動作の設定は Setup メニューから Trigger を選択して行います。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上図の設定例では、2001 年 8 月 15 日正午から、毎正時から 5 分間記録することを 4 回繰り返します。 

 

Interval 
インターバルモードを有効にする場合にチェックします。 

 

Start Time 
インターバル動作を開始する日時を指定します。 

 

Rec Time 
記録時間を、ここをクリックすると現れるダイアログで設定します。設定するとここに時間が表示されます。 

 

Interval Time 
記録と記録の間の待機時間を設定します。（記録動作の周期ではありません。）ここをクリックすると現れるダイアログで設定

します。同期記録（「5 章 同期記録機能」参照）を行わない場合は、3 秒以上、同期記録を行う場合は、5 秒以上に設

定してください(メディア記録の場合等、それ以上の秒数が必要となる事があります)。設定するとここに時間が表示されま

す。 

 

Repeat Count 
記録動作の繰り返し回数を指定します。指定した回数分のファイルができます。1 回だけの記録も可能です。「0」に設定す

ると無限回（手動で停止するまで繰り返し）の設定になります。最大値は 65534 回です。 

 

インターバルモードを有効にする 

インターバル動作開始日時 

記録時間 繰り返し回数 

ポーズ時間 
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設定の保存と読み込み 

 設定の保存と読み込み 
Setup メニューの System、Trigger で設定したパラメータをファイルとして保存し、必要なときに読み込むことができます。

Setup メニューから Params Property を選択すると、下図のダイアログが現れます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

設定の読み込み 

設定の保存 

読み込まれたファイル名の表示 

設定パラメータファイルの 

読み込み先、保存先の選択

システム設定情報 

チャネルごとの 

設定情報 

 設定を保存する 
設定したパラメータをファイルとして保存します。ファイルの拡張子は「.prm」です。不測の事態に備えて保存することをおすす

めします。 

 

1. Params Property ダイアログで Save をクリックします。 

 

2. 保存先として LX を選択した場合 (LX 本体に挿入されたメディア)は、LX Parameter File List ダイアログが表示さ

れます。パラメータ保存を行うファイル名を下部に入力、または保存内容の変更を行うファイル名を選択して、OK をクリックし

ます。 

 

 

 

 

 

 

 

 

2. 保存先としてPCを選択した場合は、<名前を付けて保存>ダイアログが表示されます。保存先とファイル名を指定して

[保存(S)]をクリックします。 

 

■ 設定ファイルはテキスト形式ですのでワードパッドなどのアプリケーションで開くことができますが、書き換えないで下さい。

書き換えると読み込めなくなることがあります。 
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設定の保存と読み込み 

 設定を読み込む 
保存した「.prm」ファイルを読み込みます。 

 

1. Params Property ダイアログで Load をクリックします。 

 

2. 読み込み先として LX を選択した場合 (LX 本体に挿入されたメディア)は LX Parameter File List ダイアログが表示

されます。パラメータの読み込みを行うファイル名を選択して、OK をクリックします。 

 

 

 

 

 

 

 

 

読み込んだファイルのファイル名が Params Property ダイアログに表示されます。 

 

3. 読み込み先としてPCを選択した場合は、<ファイルを開く>ダイアログが表示されます。読み込み先とファイル名を指定し

て[開く(O)]をクリックします。 

 

読み込んだファイルのファイル名が Params Property ダイアログに表示されます。 

 

4. Params Property ダイアログで OK をクリックします。 

読み込んだファイルの内容で LX 本体が設定されます。 

 

 

■ パラメータファイルの読み込みについての注意 

パラメータファイルは、同じ機械でパラメータ保存したファイルを指定して下さい。他の機械で保存したファイルを指定した場

合、動作が不定になる場合があります。 
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記録デバイスとファイル名の指定 

 記録デバイスとファイル名の指定 
記録のおおまかな手順は次のようになります。 

1. File → New で、記録デバイスとファイル名を指定する。（記録モードになります。） 

2. ツールバーまたは本体のボタンの操作により記録する。 

3. メモリー記録の場合は、Copy ダイアログでメディア (PC カード)または PC にコピーする。 

 

■ 各記録デバイスで設定可能なサンプリング周波数の上限は、設定された記録チャネルや入力モードにより異なります。

「1-13 サンプリング周波数とチャネル数」を参照して下さい。 

 

File → New 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

保存先の選択 

PC の場合のファイル名 

ファイル名 

5 文字 

メディアのディレクトリ指定 

保存先の履歴 

コメント(128 文字) 

PC のディレクトリ指定 

ID 番号の桁数の指定 

チェックをすると 

メモリー記録停止後にメディアに自動保存チェックをすると PC に記録 
ここでも記録デバイスを選択可 
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記録デバイスとファイル名の指定 

■ ファイル名について 

メモリー/メディアに記録する場合 

ファイル名は半角英数字で5文字まで指定できます。（使用できない記号 ．，；：<>[]*?="/\|   ）この5文字に001から始

まる3桁のID番号がつき、合計で8文字になります。4文字以内にすると、3桁の番号との間は「0」で埋められ、合計で8文字

になります。 

 

PCに記録する場合 

メモリー記録/メディア記録で PC に同時に記録する場合、または PC 記録の場合には半角英数字で指定できます。ファイル

名の長さに制限はありません。（使用できない記号 ．，；：<>[]*?="/\|   ）そのファイル名に何桁のID番号をつけるかをファ

イル名の右のフィールドで指定します。ID 番号は 8 桁までです。たとえば 2 桁と指定した場合は記録可能なファイル数は 99

個までになります。 

 

データファイルの拡張子は「.dat」に、ヘッダファイルの拡張子は「.hdr」になります。 

 

ファイル名の最後の桁は数字にしないで下さい。数字にすると次のような不都合が起こりえます。 

   例）ファイル名を「LX10」とした場合 

         LX100001 

            ↓インクリメント 

         LX100002 

            ↓インクリメント 

         LX100003 

次にファイル名を新ためて「LX1」と指定して同じフォルダに記録すると、新たなファイル名は「LX100001」となるはずですが、上

書きを避けるために自動的に「LX100004」となってしまいます。 

 

■ コメントについて 

英数字で 128 文字までのコメントを入力できます。これはヘッダファイルに書き込まれます。 
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記録デバイスとファイル名の指定 

 メモリーに記録する 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PC のディレクトリ指定 

MEMORY を選択 

ファイル名 

PC の場合のファイル名 

ID 番号の桁数の指定 

チェックをすると 

 
ここでも MEMORY を選択可 メモリー記録停止後にメディアに自動保存 PC に同時記録 

 

メモリー記録では、記録停止後に「Do you copy data?」とメッセージが現れます。[はい]をクリックすると Copy ダイアログが現

れますので、データをメディアまたは PC にコピーして下さい。コピーする前にふたたび記録したり、本体の電源を切ったりすると、

メモリー上のデータは消失します。また、メディアからの再生動作を行った場合にもメモリー上のデータは失われます。 

 

上記の「Do you copy data?」のメッセージで[いいえ]をクリックしても、ふたたび記録したり、本体の電源を切ったりする前に

File→ Copy でコピーすることができます。 

 

1. File メニューから New を選択します。 

 

2. 保存先として<MEMORY>を選択します。 

 

3. Dataset に 5 文字までのファイル名を入力します。 

 

4. OK をクリックします。 
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記録デバイスとファイル名の指定 

■ メモリーフルになると 

記録中にメモリー容量がフルになると記録は停止し、PC 画面にメッセージが表示されます。 

 

■ メモリーに記録しながら PC に同時に記録する 

PC Recording をチェックし、PC のフィールドに保存先のディレクトリを指定し、その下のフィールドにファイル名を入力します。

さらに、ID 番号の桁数を指定します。 

 

この場合は、メモ音声はメモリーには記録されますが、PC には記録されません。 

 

■ 自動的にメディアに保存する 

メモリー記録停止後に自動的にデータをメディアに保存することができます。このNew ダイアログを開く前にメディアを挿入して

下さい。Auto Saving をチェックし、Directory にメディアのフォルダ名（8 文字まで、英字は大文字）を指定して下さい。た

だし、記録開始前にメディアを挿入し忘れた場合は、後からメディアを挿入しても自動的にはコピーできません。その場合は

File → Copy でコピーして下さい。 

 

Auto Saving を有効にしても LX 本体の電源を切るとリセットされ無効になります。したがって、有効にするには電源投入の

たびに Auto Saving をチェックして下さい。また、LX 単体でのメモリー記録ではメディアの残量を知ることができませんので、

この機能を使わないで下さい。メディアの残量が足りない場合、メディアに保存可能なサイズに切り詰められたファイルが作ら

れます。 
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記録デバイスとファイル名の指定 

 メディア(PCカード)に記録する 
 

 

 

 

 

 メディアのフォルダを選択 

 

 

 

 

 

 
メディアのディレクトリ指定 

 
ファイル名 

 

 

 

 

 

 

 
チェックをすると ここでもメディアを選択可 

 PC に同時記録 

 

設定可能な最大サンプリング周波数で記録する場合は、フォーマット直後の未記録のメディアを使用して下さい。記録済

みのメディアを使用すると記録が止まることがあります。 

 

1. フォーマット済みのメディアが本体に挿入されていることを確認します。 

 

2. File メニューから New を選択します。 

 

3. 保存先としてメディアの中のフォルダを選択します。初めて使うメディアの場合は Directory にフォルダ名を入力します。

フォルダ名は 8 文字まで（英字は大文字）です。 

 

4. Dataset に 5 文字までのファイル名を入力します。 

 

5. OK をクリックします。 

 

■ メディア記録では、メディアを挿入していないと記録を開始できません。（REC ボタンが有効になりません。） 
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記録デバイスとファイル名の指定 

■ メディアに記録しながら PC に同時に記録する 

PC Recording をチェックし、PC のフィールドに保存先のディレクトリを指定し、その下のフィールドにファイル名を入力します。

さらに、ID 番号の桁数を指定します。 

 

PC のデータ引き取り速度が遅い場合は PC 側の記録データが欠落することがあります。その場合でもメディアのデータは欠

落しません。 

 

この場合、メモ音声はメディアには記録されますが、PC には記録されません。 

 

■ メディアがフルになると 

記録中にメディア容量がフルになると記録は停止し、PC 画面にメッセージが表示されます。 

 

■ メディアをフォーマットする 

PC カードがフルになったら（データを消去してかまわなければ）再フォーマットして下さい。（但し指定 PC カードを初めて使うと

きは PC でフルフォーマットを一度実行して下さい。） 

 

 

1. LX Navi の File メニューから Format を選択します。 

 

 

 
PC カードのフォーマットタイプ 

 

8 文字までのボリューム名を入力  

 

 

 

 

2. Volume に 8 文字までのボリューム名を入力します。 

 

3. Format をクリックします。 

 

4. 表示が Now Formatting から Complete に変わったらフォーマットは終わりです。 

 

Windows のファイル操作で PC カードのフォーマットを行う場合は必ず FAT16 または、FAT32 で行って下さい 
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記録デバイスとファイル名の指定 

 PCに記録する 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ファイル名 

ID 番号の桁数の指定 ここで選択する場合は NO DEVICE を選択 

保存先フォルダの選択 

ディレクトリ指定 

 

1. File メニューから New を選択します。 

 

2. 保存先として PC のフォルダを選択します。 

 

3. ファイル名を入力します。 

 

4. ID 番号の桁数を指定します。 

 

5. OK をクリックします。 

 

 

 PC記録する場合の記録先指定の注意 
PC 記録する場合の記録先の指定は、NTFS でフォーマットされた HDD の領域を指定してください。 

 

1.記録先にHDD以外のデバイスを指定した場合は、継続的な記録動作が出来ない場合や正常に記録できない場合が

あります。 

2. FAT32 でフォーマットされた HDD の領域を指定した場合、FAT32 のファイルシステムの制限によりデータのファイルサイズ

が４GB 以上になるとファイル分割されます。そのようなデータを解析ソフト等で使用する場合 NTFS でフォーマットされた

HDD の領域にコピーしファイル結合して１つのファイルに変換してご使用ください。 
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記録デバイスとファイル名の指定 
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PC記録したファイルをLX本体で再生する場合の注意 
 
PC記録しPC内の記録ファイルをPCカードにコピーして記録データをLX本体で正常に再生するためには、下記の手順に従っ

て運用して下さい。 

 

1. PC記録したファイルがロングファイル名の場合は、PCのHDD上でショートファイル名（ファイル名8文字＋拡張子3文字）

に変更して下さい。1組の記録データ（データファイル、ヘッダファイル、メモ音声ファイル）は同じファイル名に変更し、拡張子名

はそのままにしてください。ファイル名に使用できる文字は半角英数字  および一部の半角記号文字です。（使用できない

記号 ．，；：<>[]*?="/\|   ） 

 

2. PCのHDD上で8文字以下のディレクトリ名（例："LX10_DIR"）のディレクトリを作成し、ショートファイル名のLX記録データ

ファイルをコピーします。 

 

3. PCカードのメディアをLX本体でフォーマットを実行したあと、PCに接続されているPCカードスロットにメディアを装着しま

す。 

 

4. PCカードのルートディレクトリの下に"TEAC_LX"というディレクトリがありますので 

  上記2番で作成したディレクトリごと、ここの"TEAC_LX"の下にコピーします。 

 

 

 

 

 

 

 

 

 

Root （メディアのルートディレクトリ） 

TEAC_LX (LX 本体でフォーマットすると自動的に作成されます） 

LX110DIR （PC 上のディレクトリをコピー） 

（ディレクトリは複数登録可能です） 

 

 

コピーしようとしているファイル（データファイル、ヘッダファイル、メモ音声ファイル）の合計サイズが、CF カードの容量より大きい

場合はメディアに全てコピー出来ないため LX 本体での再生は出来ません。 

 

LX-120 でタコチャネル有効で記録した記録データは、LX-110 では再生データが不正になり正常な波形再生出来ません。

（LX 本体メディアで直接記録した場合も同様です） 

 

購入した直後のPCカードは、PCで一度、ファイルシステムをFAT（FAT16、FAT32）形式で通常フォーマットしてからご使用く

ださい。この処理を行わないとLXで正常に使用できない場合があります。 

 

PC カードに作成して正常に操作できるフォルダ及びデータファイルの数の合計は最大 10,000 個です。10,000 個を超えて

の記録は可能ですが、10,000 個を超えて記録したファイルのコピー、再生は行えません。 

 

 



記録の操作 

 記録の操作 
File → New で記録デバイスとファイル名を指定すると記録モードになり、記録を開始することができます。 

ここでは 2 つの ID を記録してみます。また記録中に、データに目印となるイベントマークをつけてみます。 

 

1. ステータス表示のモードが RECORD であることを確認します。VIEW になっているときは画面左端の REC ボタンをクリック

して RECORD にします。 

 

2. メモリー記録停止後に自動的にデータをメディアに保存する場合（Auto Saving を有効にした場合）、またはメディア

記録の場合は、メディアが挿入してあることを確認します。 

 

3. ツールバーの     をクリックします。または本体の REC ボタンを押します。 

動作表示が「RECSTANDBY」になり、波形表示エリアに入力波形が表示されます。 

 

4. 3 秒以上おいてからツールバーの     をクリックします。または本体の FWD ボタンを押します。 

動作表示が「REC」になり、記録が始まります。 

メモリー記録またはメディア記録の場合は、全容量に対する使用率が USAGE の LED に表示されます。 

 

5. ツールバーの     をクリックします。または本体の EVENT ボタンを押します。 

イベントマーク数表示が「0001」になります。この瞬間のスキャン数がヘッダファイルに記録されます。あらたなイベントマークは

2 秒以上たたないと、つけられません。 

 

6. ツールバーの     をクリックします。または本体の PAUSE ボタンを押します。 

 

1 つ目の ID の記録が終わり一時停止状態になります。 

動作表示は「RECSTANDBY」になります。 

メディア記録の場合は、メディアへの書き込みが終わるまでは次の記録はできません。 

 

7. ツールバーの     をクリックします。または本体の FWD ボタンを押します。 

2 つ目の ID の記録が始まります。 

 

8. 3 秒以上おいてからツールバーの   をクリックします。または本体の STOP ボタンを押します。 

記録が停止します。 
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記録の操作 

9. メモリー記録の場合は、「Do you copy data? 」とメッセージが現れます。[はい]をクリックすると Copy ダイアログが現れま

すので、データをメディアまたは PC にコピーします（次項参照）。コピーする前にふたたび記録したり、本体の電源を切ったりす

ると、メモリー上のデータは消失します。または、メディアからの再生動作を行った場合にもメモリー上のデータは失われます。 

 

File → New で Auto Saving を有効にし、なおかつメディアを挿入してある場合は上記のメッセージは現れず、メモリー上

のデータは自動的にメディアに保存されます。 

以上の操作で下図のようなファイルが記録されます。 

 

 

 

 

 

  

 

 

 

REC FWD PAUSE FWD STOP 

EVENT

Aaaaa001.dat Aaaaa002.dat 
Aaaaa002.hdr Aaaaa001.hdr

 

 メディアの交換 
■ メディア記録の場合は 

記録中にメディアがフルになるとメッセージが表示され、記録は停止し、その時点までのファイルが作られます。メディアを交換

して新たに記録することができます。 

 

■ Auto Saving の場合は 

コピー中にメディアがフルになるとメッセージが表示され、コピーは中断し、その時点までのファイルが作られます。それからメディ

アを交換しても残りのデータを自動的にはコピーできません。その場合は、Copy ダイアログでコピーして下さい。メディアを交

換した後、新たに記録することができます。 

 

■ 交換後のディレクトリと ID 番号 

交換したメディアには New ダイアログで指定したディレクトリが作られ、指定したファイル名で記録されますが、ID 番号は再び

1 から始まります。また、交換したメディアに New ダイアログで指定したディレクトリがすでにあり、指定したファイル名と同名の

ファイルがそこに存在する場合は、ID 番号は最後の番号に続けて連番となります。 
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コピーする 

 コピーする 
記録したデータファイルを次の 3 つの方向でコピーすることができます。 

メモリー → メディア 

メモリー → PC 

メディア → PC 

 

■ データファイルをコピーすると、それとペアになるヘッダファイル、メモ音声ファイルも同時にコピーされます。 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

1. File メニューから Copy を選択します。 

 

2. コピー元のデバイスまたはフォルダを選択します。 

 

3. コピーするデータファイルをチェックして選択します。 

 

4. Device で、メディアにコピーするときは CARD を、PC にコピーするときは PC をクリックします。 

 

5. Directory で、コピー先のディレクトリを指定します。 

 

6. Store をクリックします。 

 

■ メモリーからのコピーの場合、コピーが終了後もメモリーにはデータが残っていますので USAGE LED は点灯しています。 

 

■ ファイル名を変更したいときは、変更したいファイルをクリックして表示を反転させ、Dataset に変更後のファイル名を入力

します。変更されたファイル名は上のリストの Copy Name に表示されます。(PC へのコピー時のみ有効です。) 

 

■ ファイル名を変更してコピーした場合のヘッダファイルの DATASET（「6 章 ファイルフォーマット」参照）はコピー元のファイル

名のままとなります。 

 

■ PC カードに作成して正常に操作できるフォルダ及びデータファイルの数の合計は最大 10,000 個です。10,000 個を超

えての記録は可能ですが、10,000 個を超えて記録したファイルのコピー、再生は行えません。 

コピーするファイルをチェック 

コピー先のデバイスを選択 

ディレクトリ指定 

ファイル名を設定する 

コピー元のデバイスを選択 
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再生する 

 再生する 
メモリーまたはメディアに記録したデータを再生することができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. File メニューから Open を選択します。 

 

2. 再生するファイルを選択します。 

 

3. OK をクリックします。（ステータス表示のモードが VIEW になります。） 

 

4. ツールバーの     をクリックします。または本体の FWD ボタンを押します。 

動作表示が「PLAY」になり、再生が始まります。 

 

■ 再生速度を変更する 

記録時とは異なる速度で再生することができます。速度を変えるには、上記の手順でファイルを開いてから、メイン画面左側

の Sample の値を変更するか、Setup → System ダイアログで Sample の設定値を変更します。 

 

これにより記録時のサンプリング周波数の設定が変わることはありません。 

 

メモ音声の再生速度は Sample を変更しても変わりません。Sample を変更してメモ音声を再生すると、再生データと音

声とのタイミングがずれることになります。 

 

再生速度の変更は同系列のサンプリング周波数内のみで有効です。 

 

低速サンプリング系列(1 kHz ～ 1/60 Hz)で再生時、モニター出力からのアナログ出力は使用できません。また、出力アン

プからのアナログ出力も使用できません。 

 

PC カードに作成して正常に操作できるフォルダ及びデータファイルの数の合計は最大 10,000 個です。10,000 個を超えて

の記録は可能ですが、10,000 個を超えて記録したファイルのコピー、再生は行えません。 

過去に開いたディ

レクトリの履歴 

開くディレクトリ

を指定 

再生するファイルを

選択 

再生するファイル

のファイル名 

ヘッダファイルに記録さ

れているコメント 

再生モードの選択 

Single: 選択されたファイルを再生 

Repeat: 選択されたファイルを繰り返して再生 

Continue: 選択されたファイルを再生し、その後のファ

イルも連続して再生 
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再生する 

 再生の操作 
LX Naviの場合                                      LX本体の場合 

 

 

 

 

 

 

 

 

 

 

 

■ スキップは一時停止または停止状態で有効です。詳細は次項をお読み下さい。 

 

 

 再生ポイントの移動(スキップ) 
スキップは再生ポイントを移動する機能で、再生モードの一時停止または停止状態で有効です。     をクリックすると現

在の位置から後のポイント、    をクリックすると現在の位置から前のポイントへ移動することができます。（波形が表示され

るのは移動後に再生を開始または再開してからです。） 

 

1 回のクリックで移動する範囲を指定することができます。 

 

移動範囲の指定は、ツールバーの     をクリックして現れる下図のダイアログで行います。 

 

 

 

 

 

 

 

 

次の 4 つから選択することができます。 

File 
現在のファイルと同じフォルダ内の新旧のファイル（ID）に移動できます。 

Scan 
指定したスキャン数だけ移動します。Scan を選択すると、下のフィールドに、現在のファイルの総スキャン数が表示されま

す。 

Mark 
前後のイベントマークに移動します。Mark を選択すると、下のフィールドに、現在のファイルの総イベントマーク数が表示され

ます。 

Time 
指定した時間(時:分:秒)だけ移動します。Time を選択すると、下のフィールドに、現在のファイルの記録開始時刻と記録終

了時刻が表示されます。 

後にスキップ 前にスキップ 

先頭へ戻って停止 

再生開始、一時停止後の再

開、スキップ後の再開 

その位置で停止 

再生ポイントの移動 

先頭へ戻って停止 

その位置で停止 

再生開始、一時停止後の 

再開、スキップ後の再開 

現在のファイルの総スキャン数など 
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再生する 

 高度な検索 
ステータス表示エリアを使って、より高度な検索を行うことができます。 

 

1. 再生モードの一時停止または停止状態で、ステータス表示の下図矢印のいずれかのフィールドをクリックし、文字の色

が変わったらもう一度クリックします。 

 

 

 

 

2. 検索目標を指定します。 

 

イベントサーチ 

指定のイベントマークを検索します。 

上部の 2 つのフィールドは検索可能範囲を示します。 

最下段に検索したい番号を入力して”OK”ボタンを押します。 

 

 

 

カウンタサーチ 

記録開始からの時間(時:分:秒)を指定して検索します。 

上部の 2 つのフィールドは検索可能範囲を示します。 

最下段に検索したい時間を入力して”OK”ボタンを押します。 

 

 

 

タイムサーチ 

記録日時を指定して検索します。 

日付(年:月:日)と時刻(時:分:秒)を入力して下さい。 

上部の 2 つのフィールドは検索可能範囲を示します。 

最下段に検索したい日時を入力して”OK”ボタンを押します。 

 

 

 

3. 検索目標を指定し終えたら”OK”ボタンをクリックしてボックスを閉じます。目標のポイントで停止状態になります。 

検索の操作をやめる場合は、”Cancel” ボタンをクリックしてボックスを閉じます。 

 

 

4. ツールバーの     をクリックします。目標のポイントから再生が始まります。 
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便利な機能 

 便利な機能 
 波形表示 
波形表示は、サンプリング周波数や表示のタイムスケールによってデータが間引きされて表示される場合があります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

波形を重ねて見る 表示チャネルの選択 

-100% 

設定レンジの 

+100%

設定レンジの 

表示チャネルの選択 

全グラフをウィンドウ内に表示 

グラフをチャネル順に並べる 

全チャネルを選択 

前面に表示するグラフを選択します。 

このチャネルが

前面に表示さ

れています。 

元に戻ります。 

クリックすると 

 

時間軸変更スライダ 

サイズ変更 

グラフ縦方向の 

CH をクリック、もう一度クリックすると消える。 

(1.5 kHz – 96 kHz サンプリング周波数が

選択された場合) 

 96 kHz 100 m 秒まで 

 48 kHz 200 m 秒まで 

 24 kHz 500 m 秒まで 

 12 kHz 1 秒まで 

 6 kHz 2 秒まで 

 3 kHz 5 秒まで 

 1.5 kHz 10 秒まで 

サンプリング周波数 表示時間幅 

チャネル番号のボックスを他のチャネルにドラッグ＆ドロップ。 

カーソル位置の時間軸目盛りを表示。

C1-C2 はその時間差。カーソルは一時

停止時にドラッグして移動可能。 

ここをクリックすると次

ページのリストが現れ

る。もう一度クリックす

ると消える。 
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便利な機能 

 チャネルのプロパティ 
 

カーソル位置の値 カーソル位置の 2 つの値の差 
 

 

 

 

 

 

 

 

希望のチャネルをダブルクリック 

係数と単位 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

単位変換式 

オフセット値 

デフォルトに戻す デフォルトに戻す 表示レンジの変更 

チャネル名 

グラフの色設定をデフォルトに戻す 

グラフの背景

グラフの線色 

次のチャネル前のチャネル  

 

単位の変換 

ヘッダファイルに書き込む単位（VERT_UNITS）を物理量ではなく工学単位で書き込み、それに合わせて係数（SLOPE）を

換算してヘッダファイルに書き込むことができます。 

上図は、加速度 9.8 m/s2 を 1 V で出力する加速度センサからの信号を記録する場合の換算式の入力例です。入力が 0 

V の時にオフセット値がある場合は、Offset Value に入力して下さい。これらを変更するとヘッダファイルの VERT_UNITS の

単位、SLOPE、Y_OFFSET の値が変更されます。 

 

Disp Range 
スライダをドラッグすると波形グラフのレンジを変更できます。 

Channel Name 
チャネルごとに名前をつけられます。 

Line Color 
グラフの線の色を選択します。Same をクリックすると全チャネルのグラフが同じ色になります。 

Back Color 
グラフの背景の色を選択します。Same をクリックすると全チャネルの背景が同じ色になります。 
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便利な機能 

 バーグラフ表示 
View → Bar でバーグラフを表示できます。 

 

 

 

 
スライダで紺色の部分の幅を

変えられます。レベル監視の目

安として便利。 

 

 

 

 

 

 

 

 

 

 %と dB の切り替え ピークホールドのクリア 

 

 ディジタル表示 
View → Digit でディジタル値を表示できます。表示できる個数は、タコパルス入力チャネルも含めた有効チャネル数分です。 

 

 

 

 

 

チャネル追加  

 

 

 チャネル名と単位 
チャネル選択 

Channel Property ウィンドウ

で設定します。 
 

 

 ヘッダ情報を見る 
View → Hdr でヘッダ情報を表示できます。再生モードでファイルを選択してから有効になります。 
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便利な機能 

 モード切り替え 
メイン画面左下のエリアで、記録デバイス、ファイル名の確認、再生するファイルの選択ができます。 

 

 

  
記録モード、再生モードの切り替え 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 
 

コメント 

サンプリング周波数の選択 再生速度の選択 

File → New で書き込んだコメント 

再生するファイルの選択 

保存する場所、ファイル名の表示 

<再生モード時> <記録モード時> 

再生するファイルに書き込まれている 

再生するファイルに書き込まれている 
メモ音声 ON/OFF の選択 

メモ音声 ON/OFF 条件 

モニターチャネルの選択 
モニターチャネルの選択 

選択したデバイスに記録可能な

時間 (時:分:秒) ※注意 1 

選択したデバイスの残量割合（％） 

PC に記録可能な時間  

(時:分:秒) ※注意 2 

ターゲットの LX のシリアル 

番号又はレコーダ名 

 
※注意 1：この残時間の表示がシアン色で表示されている場合、メディアに 4GB 以上の空き容量があり表示している時間

より多い残時間がある事を示しています。 

 

※ 注意 2：PC のデータ転送能力が遅い場合、この項目の表示が黄色または赤のリバース表示になり、PC へのデータ転

送が遅れていることを示しています。この場合 LX 本体内のメモリーがフルとなる可能性があり、表示されている記録可

能な時間より早く記録が終了する可能性があります。 
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便利な機能 

 ファンを止める 
ツールバーのファンボタンで LX 本体の冷却ファンを強制的に止めることができます。(一度ファンを止めて記録したら、次にまた

ファンを止めるまでは約 10 分間以上時間をおいて下さい。) このボタンの機能は System ダイアログの Fan の設定により変

わります。 

 

 

 

Fan が ON の場合 

ファンボタンは RECSTANDBY 後に有効になり、クリックするとその間だけファンを止められます。止められる時間は合計 10 分

間で、残り時間がステータス表示に表示されます。 

Fan が OFF の場合 

ファンボタンは RECSTANDBY 中のみ有効で、クリックすると 1 回だけファンを止められます。止められる時間は最大 1 分間で、

残り時間がステータス表示に表示されます。記録開始後にファンボタンは無効になり、10 分間だけファンが止まります。 

 

 

 データを音で聞く 
ツールバーのスピーカボタンでモニターチャネルのデータを音として聞くことができます。再生中にこのボタンをクリックすると、メモ

音声に代わり再生中のモニターチャネルのデータが本体内蔵スピーカから再生されます。また記録中にこのボタンをクリックす

ると、記録中のモニターチャネルのデータが本体内蔵スピーカから再生されます。 
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メッセージ表示内容 

 メッセージ表示内容 
 

種別 表示メッセージ内容 意味 対応 
INF Succeeded to adjust time. 日時の更新に成功しました。 表示されている日時を確認して下さい。 

QUE Do you adjust time on LX with PC 

clock? 

PC の日時と同期させます

か？ 

LX の日時と PC の日時と同期させる場合は"Yes"のボタ

ンを選択して下さい。 

QUE Do you copy data? 記 録 デ ー タ を コ ピ ー し ま す

か？ 

記録データをメディアまたは PC にセーブする場合"Yes"の

ボタンを選択して下さい。 

QUE Do you set file name? ファイル名を指定しますか。

（コピー機能時） 

ファイル名を指定してコピー動作を継続する場合"Yes"の

ボタンを選択して下さい。 

QUE There is same path name. 

Do you overwrite data? 

同一ファイル名が存在しま

す。上書きしますか？ 

同一ファイル名のファイルを上書きしてよい場合は"Yes"

のボタンを選択して下さい。 

WAR Cannot find amplifier unit. アンプが装着されていません。 アンプが正しく装着されているか確認して、LX 本体を立ち

上げ直して再度実行して下さい。 

WAR Cannot reproduce this file. このファイルは再生できませ

ん。 

このファイルは、再生出来ない属性データが含まれていま

す。 

WAR Check Start PreTrig Value. プリトリガの値を確認して下さ

い。 

プリトリガの設定値を確認・変更して下さい。 

WAR Couldn't close this application. 

Please set REC (IDLE) MODE. 

アプリケーションを終了できま

せん。記録モードのアイドル

状態にして下さい。 

記録モードのアイドル状態にしてから終了して下さい。 

WAR Device Not Selected. コピー先のデバイスが指定さ

れていません。 

コピー先のデバイスが指定して再度実行して下さい。 

WAR Failed to create new file. 

Please confirm the filepath. 

ファイルの作成に失敗しまし

た。パス名を確認して下さ

い。 

記録ファイルの作成に失敗しました。指定したパス名を確

認し、指定したデバイスが書き込み可能な状態か確認し

てから、再実行して下さい。 

WAR Failed to perform zero balancing. 

Please confirm a result. 

ゼロバランスの実行に失敗し

ました。ゼロバランス実行画

面で結果を確認して下さい。

ゼロバランス実行の結果 1 つ以上のチャネルで NG になり

ました。ゼロバランス実行画面を開き NG になったチャネル

を確認して再実行下さい。オープン状態のチャネルは NG

になる可能性があります。 

WAR Failed to Rec Standby. Rec Standby 状態に入れま

せんでした。 

記録できる上限を超えた設定になっています。量子化ビッ

ト数、サンプリング周波数、使用チャネル数の設定を見

直してください。 

WAR File increment number overflow. 

Move a figure some place to the 

left. 

ファイル番号がオーバーフロー

しました。ID 番号の桁数の指

定を増やして下さい。 

ファイル番号の数が上限に達しました。ID 番号の桁数の

指定を増やしてから再度実行して下さい。 

WAR Input parameter is invalid. 入力されたパラメータの値が

不正です。 

カーソルのある位置のパラメータの値を修正してください。

WAR Low battery. 

Please close this application. 

バッテリが低電圧になっていま

す。アプリケーションを終了し

て下さい。 

LX 本体の電源が落ちる可能性があります。実行中の処

理をクローズ処理し、アプリケーションを終了して下さい。 

WAR LX Dataset name is invalid. メディアのファイル名が不正で

す。 

記録する LX メディアのファイル名指定に不正な文字など

が含まれていないか確認・変更して下さい。 

WAR LX Directory name is invalid. メディアのディレクトリ名が不

正です。 

記録する LX メディアのディレクトリ名指定に不正な文字

などが含まれていないか確認・変更して下さい。 

WAR Media full. LX 本体の装着されているメ

ディアがフルになりました。 

更に記録を続ける場合、新しいメディアに交換して下さ

い。 

WAR Media Not Ready. メディアが Not Ready の為、

REC STANDBY になれませ

ん。 

メディアを装着しステータスが"Media Ready"になってから

実行して下さい。 
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メッセージ表示内容 

WAR Media UnFormat. メディアがフォーマットされてい

ない為、REC STANDBY に

なれません。 

メディアをフォーマットしてから実行して下さい。 

WAR Media Write Protected. メディアがライトプロテクト状態

の為、REC STANDBY にな

れません。 

メディアのライトプロテクトを解除してから使用して下さい。

WAR Memory full. LX 本体内のメモリーがフルに

なりました。 

記録が終了していますので、必要に応じて記録データを

コピー機能でメディアまたは PC にセーブして下さい。 

WAR Media Not Ready. パラメータファイルを書き込む

メディアが入っていません。 

LX 本体にメディアを装着してください。 

WAR Parameter file is invalid. パラメータファイルの内容が不

正です。 

ヘッダファイルが不正な為、再生は出来ません。 

WAR PC Dataset name is invalid. PC のファイル名が不正です。 記録する PC のファイル名指定に不正な文字などが含ま

れていないか確認・変更して下さい。 

WAR PC Directory name is invalid. PC のディレクトリ名が不正で

す。 

記録する PC のディレクトリ名指定に不正な文字などが

含まれていないか確認・変更して下さい。 

WAR Please install update Program 

KB885222 of Microsoft. 

マイクロソフト社の更新プログ

ラム(KB885222)をインストー

ルしてください。 

一旦 LX Navi を終了し、マイクロソフト社の更新プログラ

ム(KB885222)をインストールしたあとに、LX Navi を再度

立ち上げ直して下さい。 

WAR Please set file name. ファイル名をセットして下さい。 ファイル名を指定してから終了して下さい。 

WAR This file can't be selected. このファイルは選択できませ

ん。 

データファイル(*.DAT)が存在しません。メディアを確認して

下さい。 

WAR This unit has been Slave Mode. スレーブモードのため動作出

来ません。 

スレーブ機では、実行出来ない操作です。 

WAR The setting was initialized. LX の設定値が初期化されま

した。 

LX 本体と LxNavi で保持している設定値を初期化しまし

たので、設定内容を確認・再設定してください。アンプユ

ニットの変更などを行うと設定値が初期化されます。 

WAR There is not enough disk space. PC 側のディスクの空き容量

がありません。 

指定されている PC のディスクの空き容量を増やすか、PC

のディスクの指定先を変更して下さい。 

ERR Cannot Close LX SERIES. LX をクローズ出来ません。 アプリケーション終了時に LX 本体の切断処理ができませ

ん。繰り返し発生する場合は、弊社までご連絡ください。

ERR Cannot Open LX SERIES. LX をオープン出来ません。 既に別の LX Navi が立ち上がっていないか確認してくださ

い。もし立ち上がっていない場合は LX 本体の電源を入

れ直して再度実行して下さい。 

ERR error code (n). This application 

is closed automatically. 

コマンド実行エラーが発生し

ました。アプリケーションを終

了します。 

インターフェースケーブルの接続などが正しく接続されてい

るか確認して、再度実行して下さい。繰り返し発生する

場合は、弊社までご連絡ください。 

ERR Size of command parameter 

is invalid. 

コマンドのパラメータサイズが

不正です。 

LAN ケーブルの接続などが正しく接続されているか確認し

て、再度実行して下さい。繰り返し発生する場合は、弊

社までご連絡ください。 

ERR Failed to Calibration of Slot (n). n スロットのキャリブレーション

動作に失敗しました。 

LX 本体の電源を入れ直して再度実行して下さい。繰り

返し発生する場合は、弊社までご連絡ください。 

ERR Failed to Calibration. キャリブレーション動作に失敗

しました。 

LX 本体の電源を入れ直して再度実行して下さい。繰り

返し発生する場合は、弊社までご連絡ください。 

ERR Failed to get catalog data. カタログ情報（メディアのファイ

ル情報）の取得に失敗しまし

た。 

装着しているメディアが、不正な状態でないか確認して下

さい。 
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メッセージ表示内容 

ERR Failed to make a new folder. PC に新しいフォルダの作成に

失敗しました。 

記録・コピー先のディレクトリの作成に失敗しました。指定

したパス名を確認し、指定したデバイスが書き込み可能

な状態か確認してから、再実行して下さい。 

ERR Failed to Open file. (xxxx) ファイルのオープンに失敗しま

した。 

PC ファイルの読込にオープンに失敗しました。指定したデ

バイスが READY 状態か確認して下さい。 

ERR Failed to read file. (xxxx) ファイルの読込に失敗しまし

た。 

PC ファイルの読込に失敗しました。指定したデバイスが

READY 状態か確認して下さい。 

ERR Failed to write file. (xxxx) ファイルの書き込みに失敗し

ました。 

PC ファイルの書き込みに失敗しました。指定したデバイス

が READY 状態で書き込み可能状態か確認して下さ

い。 

ERR Failed to Zero Balanceing. ゼロバランスの実行に失敗し

ました。 

LX 本体の電源を入れ直して再度実行して下さい。繰り

返し発生する場合は、弊社までご連絡ください。 

ERR Failed to Update TEDS 

information. 

TEDS 情報の更新に失敗し

ました。 

LX 本体の電源を入れ直して再度実行して下さい。繰り

返し発生する場合は、弊社までご連絡ください。 

ERR Get LX Information Error. LX 本体の情報取得に失敗

しました。 

LX 本体の電源を入れ直して再度実行して下さい。繰り

返し発生する場合は、弊社までご連絡ください。 

ERR Illegal MAC Address (n). MAC アドレスが不正です。 弊社までご連絡ください。（MAC アドレスが不正です。） 

ERR Media Access Error. LX 本体内蔵メディアへのアク

セスがエラーになりました。 

このメディアの使用を中止し、新しいメディアをご使用下さ

い。 

ERR Please set MAC Address. MAC アドレスをセットして下さ

い。 

弊社までご連絡ください。（MAC アドレスが不正です。） 

ERR Invalid IP Address. 指定した IP アドレスが不正で

す。 

正しい IP アドレスを指定してください。 

ERR Failed to Update IP Address. IP アドレスの更新に失敗しま

した。 

ファイアウォールの設定が有効になっている場合一時的に

無効にし、LX 本体の電源を入れ直して再度実行して下

さい。繰り返し発生する場合は、弊社までご連絡くださ

い。 

    

メッセージ種別内容 

INF 通知内容 

QUE 処理選択確認 

WAR 警告 

ERR エラー 
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LX 単体での操作 

 LX単体での操作 
記録開始前に、記録デバイス、ファイル名、各種の設定をあらかじめ LX Navi で行って下さい。LX Navi から最後に指定した

内容が電源を切っても本体に保存されます。本体を PC から切り離すと、その設定に基づいて動作します。 

 

■ 単体で操作する場合の注意 

IEEE 1394 モデルの場合、IEEE 1394 はホットプラグ対応ですので、LX 本体、PC の電源を入れたままでの切り離し、接続が

可能です。（ただし LX 本体と PC の通信中は接続を切らないで下さい。） LX Navi は接続が切られるとエラーメッセージを

出して終了します。その場合は接続し直してから LX Navi を再起動すると LX 本体を再び認識することができます。 

 

LX 本体を移動する場合は電源を切る前にメディアを取り出して下さい。メディアを挿入したまま LX 本体を持ち運ぶと故障

の原因になります。 

 

メディア記録の場合は、記録開始前にメディアを挿入してあることを確認して下さい。メディアを挿入してないと記録を開始で

きません。（REC ボタンが有効になりません。） 

 

メモリー記録の場合は、記録停止後に電源を入れたまま PC に接続し、データをメディアまたは PC にコピーして下さい。コピ

ーする前にふたたび記録したり、本体の電源を切ったりすると、メモリー上のデータは消失します。また、メディアからの再生動

作を行った場合にもメモリー上のデータは失われます。 

 

LX 単体でのメモリー記録では自動メディア保存(File → New の Auto Saving)の機能を使わないで下さい。メディアの残

量を知ることができませんので、データを保存し損なうおそれがあります。また、Auto Savingを有効にしてもLX本体の電源

を切るとリセットされ無効になります。 
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LX 単体での操作 

 メディアに記録する 
1. LX 本体にメディアを挿入しておきます。 

 

2. LX Navi で File メニューから New を選択します。 

 

3. 記録デバイスとして PC CARD を選択し、ディレクトリとファイル名を指定して OK をクリックします。 

 

4. メディアを取り出し、LX Navi を終了します。 

 

5. LX 本体の電源を切り、背面から IEEE 1394/LAN ケーブルを抜き、計測現場に移動します。 

 

6. LX 本体の電源を入れ、同じメディアを挿入します。 

 

7. REC ボタンを押し、次に FWD ボタンを押します。記録が始まります。 

 

8. PAUSE ボタンを押します。記録一時停止状態になります。記録したデータが 1 つの ID として完結します。 

以後、FWD、PAUSE を繰り返すたびに ID が記録され、ID 番号が自動的にインクリメントします。 

 

9. 記録を終了するには STOP ボタンを押します。 

 

10.本体を移動する場合は本体の PC カードイジェクトボタンを押して手動で取り出して下さい。 

 

■ この後にいったん電源を切り、再び電源を入れて同じメディアに記録すると、自動的に ID番号が更新されたファイル名で

記録されます。左下図の例では次のファイルは「Aaaaa003」となります。 

 

  

 

 

 

 

 

停止 記録待機 開始 再開 一時停止 

REC FWD PAUSE FWD STOP 

Aaaaa001.dat 
Aaaaa001.hdr 

Aaaaa002.dat 
Aaaaa002.hdr 

 

 

 

■ メディアがフルになったら 

記録中にメディアがフルになると記録は停止し、その時点までのファイルが作られます。メディアを交換して新たに記録するこ

とができます。LX 単体ではメディアをフォーマットできませんので、あらかじめフォーマットしたメディアを用意しておいて下さい。

交換したメディアには New ダイアログで指定したディレクトリが作られ、指定したファイル名で記録されますが、ID 番号は再び

1 から始まります。また、交換したメディアに New ダイアログで指定したディレクトリがすでにあり、指定したファイル名と同名の

ファイルがそこに存在する場合は、ID 番号は最後の番号に続けて連番となります。  
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LX 単体での操作 

 メモリーに記録する 
LX 単体でメモリーに記録する場合は、記録停止後に電源を入れたまま PC に接続し、メモリーに取り込んだデータをメディア

または PC に転送します。 

 

1. LX Navi で File メニューから New を選択します。 

 

2. 記録デバイスとしてメモリーを指定し、ファイル名を指定して OK をクリックします。 

 

3. LX Navi を終了します。 

 

4. LX 本体の電源を切り、背面から IEEE 1394/LAN ケーブルを抜き、計測現場に移動します。 

 

5. LX 本体の電源を入れます。 

 

6. REC ボタンを押し、次に FWD ボタンを押します。記録が始まります。 

 

7. PAUSE ボタンを押します。記録一時停止状態になります。記録したデータが 1 つの ID として完結します。 

以後、FWD、PAUSE を繰り返すたびに ID が記録され、ID 番号が自動的にインクリメントします。 

 

8. 記録を終了するには STOP ボタンを押します。 

 

■ この状態でふたたび REC ボタンを押したり、LX 本体の電源を切ったりすると、メモリー上のデータは失われますので、ご注

意下さい。また、メディアからの再生動作を行った場合にもメモリー上のデータは失われます。 

 

9. IEEE 1394/LAN ケーブルで PC と接続します。 

 

10. LX Navi を立ち上げます。 

 

11. File メニューから Copy を選択し、メモリーに記録しデータを PC にコピーします。 

 

■ LX 単体でのメモリー記録では自動メディア保存(File → New の Auto Saving)の機能を使わないで下さい。メディア

の残量を知ることができませんので、データを保存し損なうおそれがあります。また、Auto Saving を有効にしても LX 本体の

電源を切るとリセットされ無効になります。 
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LX 単体での操作 

 再生する 
LX 単体でも、メモリーまたはメディアに記録された最後のデータ(最後の ID)を再生し、出力することができます。ただし、メモリ

ー上のデータは電源を切ると失われ、再生できなくなります。 

 

再生するにはフロントパネルの FWD ボタンを押します。 

再生を一時停止するには PAUSE ボタンを、停止するには STOP ボタンを押します。 

 

 

 

 

 

 

 

 

 
先頭へ戻って停止 

その位置で停止 

再生開始、一時停止後の再開 

 

 

5-27 



同期記録機能 

 同期記録機能 
同期記録機能は LX 本体のオプション機能です。LX Navi ソフトウエアで、同期記録を行う複数台の LX にマスター機とスレ

ーブ機（最大 3 台のスレーブ機、トータル同期ケーブル長 10m 以内）の設定を行います。 

 

■ IEEE1394 モデルの LX と LAN モデルの LX を混在して同期記録を行うことはできません。 

 

■ IEEE 1394 モデルの場合、すでにお使いになられている LX Navi を更新される場合にはデバイスドライバも同様に更新し

て下さい。 

 

■ 同期再生動作を行うことは出来ませんが、マスター機のみの単独再生動作は実行可能です。 

 

■ 記録時のサンプリング周波数、量子化ビット数および記録先メディア（Memory, PC カード）は、マスター機/スレーブ機

とも同じ設定にして下さい。またマスター機/スレーブ機を 1 台の PC で制御する場合（同期記録する複数台分の LX 

Navi を同時立ち上げ）は、記録するファイルのディレクトリ名・ファイル名が重複しない様に設定して下さい。 

 

■ サンプリング周波数 1kHz で LX-110 と LX-120 を混在させて同期記録を行った場合、位相がずれる可能性がありま

す。LX-110 と LX-120 が混在しないようにして下さい。 

 

■ 各種トリガ条件はマスター機のみに設定できます。スレーブ機には設定できません。 

 

■ マスター機/スレーブ機を 1 台の PC で制御する場合、最大サンプリング周波数での動作や LX Navi の設定内容の保

存機能に制限が生じる場合があります。 

 

■ 同期記録を行う場合 LX Navi の起動は、マスター機、スレーブ 1、スレーブ 2・・・の順序で立ち上げ、終了する場合は

起動時の逆の順序で終了させ最後にマスター機の LX Navi を終了して下さい。 

 

■ オプションソフトウエアである波形表示プログラム LX View PL-S1001、または、ファイル変換プログラム AFC NEO 

PL-S1002 を用いて各 LX 本体に分割して同期記録されたデータファイルを縫合して一つのファイルにすることができま

す。 

 

■ 複数のスレーブ機のメイン画面を表示したままで、記録を開始すると設定されたサンプリング周波数によってはモニターが

できなくなることがあります。開くメイン画面は必要最小限にとどめて下さい。 

 

■ 記録と記録の間の待機時間は 5 秒以上空けてください（メディア記録の場合等、それ以上の秒数が必要となることが

あります）。 

 

■ サンプリング周波数を変更後は 40 秒以上時間を空けてから記録を開始して下さい。 

 

■ アイドル状態から記録待機状態になった時に LX Navi の波形表示が一瞬乱れることがありますが、モニター出力、アナ

ログ出力、記録されるデータ等には影響ありません。 

 

■ 同期記録を行わない場合は、<SYNC IN> <SYNC OUT>コネクタに同期ケーブルは接続しないで下さい。 

 

■ 同期記録スレーブに設定されている LX と AQ-VU との同期はできません。AQ-VU との同期を行う場合は同期記録の設

定を解除するか、マスター機に接続して下さい。 
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同期記録機能 

 設定と記録動作 
各 LX 本体のアンプや入力レンジ、サンプリング周波数の設定は、マスター機/スレーブ機の設定後、各本体の LX Navi 画

面を立ち上げて、個別に行って下さい。サンプリング周波数の設定はマスター機/スレーブ機とも同じサンプリング周波数/同

じ収録メディアに設定して下さい。 

記録動作の開始・一時停止・再開・終了は、マスター機の LX Navi で操作を行うことで、スレーブに設定された LX も同期

して動作します。 

 

 

 同期記録ケーブル接続と電源の投入 
1. 同期記録を行う複数台の LX 本体を付属の同期ケーブルで接続します。 

 

 

SERIAL NO.

MADE IN JAPAN

RECORDING UNIT

12-28V ,

LX-110

6.0-2.6A

TEAC CORPORATION

BATTERY UNIT:BU-81

 

 

 

 

 

 

 

リアパネルの<SYNC IN> <SYNC OUT>コネクタが同期記録用のコネクタです。 

先頭の LX 本体（マスター機）の<SYNC OUT>と 2 番目の LX 本体（スレーブ 1）の<SYNC IN>を同期記録ケーブルで接続

します。3 番目の LX 本体（スレーブ 2）がある場合は、2 番目の LX本体の<SYNC OUT>と 3 番目の LX 本体の<SYNC IN>

を接続します。以下同様に最後の LX 本体（スレーブ N）まで接続します。 

 

 

2. お持ちの LX 本体が IEEE1394 モデルの場合は、LX 本体同士を IEEE1394 ケーブルでデイジーチェーンに接続します。

いずれかの LX 本体に LX Navi のインストールされた PC を接続します。 

 

お持ちの LX 本体が LAN モデルの場合は、スイッチングハブ経由で LX 本体を接続します。スイッチングハブに LX 本体に LX 

Navi のインストールされた PC を接続します。 

 

 

3. PC および LX 本体の電源を投入します。 

 

お持ちの LX 本体が 1394 モデルの場合、もし LX Navi (LX Network 画面)よりデイジーチェーンした LX の一部しか認識さ

れないような場合、PC からデイジーチェーン接続した順番に連続的に再度電源を ON にするか、デイジーチェーンしている末

端の LX のコネクタの抜き差しを実行してください。 
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同期記録機能 

 操作 
LX Navi を使って、マスター機とスレーブ機の設定を行います。 

 

1. PC から LX Navi を立ち上げると LX 選択ダイアログ (LX Network)に同一セグメント上に接続されている LX シリーズの

機械のシリアル番号等の情報が表示されます。 

"sync select"の列をマスター、スレーブ 1、スレーブ 2．．．の順序でクリックします。クリックした位置に設定内容が表示され

ます。（この作業は 1 度設定すれば次回以降省略可能です。） 

"Sync Check”ボタンをクリックします。これにより指定した LX の同期設定内容の確認・設定および同期接続の確認試験を

行います。 

下図の例は、同一グループ上に 2 台の LX シリーズの機械が接続されており、シリアル番号 535061 をマスター、 535064 

をスレーブ 1 に選択（"sync select"の列を設定したいマスター、スレーブ 1 の順序でクリック）した状態です。この状態

で”Sync Check”のボタンを押すことにより、同期モードの設定と同期接続の確認が実行されます。 

 

 
 

LX 選択ダイアログ(LX Network)の表の見方 

"serial" 同一セグメント上に接続されている LX シリーズのレコーダのシリアル番号を表示します。 

"if" LX 本体のインタフェース種別を表示します。 

"address" IP アドレスを表示します。 

"name" LX に設定した名前を表示します。(IEEE1394 モデルは固定名称) 

"status" 接続状況や同期接続の確認試験の結果を表示します。 

"sync mode" LX 本体の同期設定の内容が表示されます。 

"sync select" 同期運転の為のマスター機やスレーブ機の順番を設定（クリック）した内容を表示します。 
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同期記録機能 

プログラム立ち上げ直後および"Update List"実行時後の各表示の意味 

 

チェックボックスの表示状態 status sync mode 意味 

実行可能な機械 

（前回接続した機械） 
チェックマークあり状態     

チェックマークなし状態     実行選択可能な機械 

赤チェックマークあり状態 

[背景グレー] 
USE   

使用中の機械 

（実行選択不可） 

チェックマークなし状態 

[背景グレー] 
IP ERR   

IP アドレスがグループ外の機械 

（実行選択不可） 

 

 

2. 下図が"Sync Check”ボタンをクリックした結果画面となります。マスター機に設定した機械にチェックマークが付き、スレー

ブ機に設定した機械にグレー背景のチェックマークが付きます。同期接続の確認試験結果とチェックボックスにチェックマークが

付いているのを確認し”OK”ボタンを押します。 

 

下図はシリアル番号 535061 をマスター、 535064 をスレーブ 1 に設定し、同期接続確認が正常（”status”の項目にマス

ター機、スレーブ機共に”OK”が表示される）であったことを示し、シリアル番号の隣のチェックボックスに自動的にチェックマーク

が付きます。（スレーブ機は背景がグレーのチェックボックス） この状態で”OK”ボタンを押すことによりマスター機を制御する

LX Navi が実行開始されます。 
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同期記録機能 

"Sync Check"ボタン押下後の各表示の意味 

 

チェックボックスの表示状態 status sync mode 意味 

チェックマークあり状態 OK MASTER 同期運転のマスター設定機 

チェックマークあり状態 

[背景グレー] 
OK 

SLAVE n 

 （n はスレーブ番号） 

同期運転のスレーブ設定機 

 (接続試験 OK) 

チェックマークなし状態 NG 
SLAVE n 

 （n はスレーブ番号） 

同期運転のスレーブ設定機 

 (接続試験 NG) 

チェックマークなし状態  NO SYNC スタンドアロン設定機 

チェックマークなし状態  NOT SUPPORT 
同期運転の非対応モデル 

の機械 

赤チェックマークあり状態 

[背景グレー] 
ERROR   通信エラーが発生した機械 

赤チェックマークあり状態 

[背景グレー] 
(USE)   使用中の機械 

チェックマークなし状態 

[背景グレー] 
(IP ERR)   IP アドレスがグループ外の機械 

 

設定内容を変更したものは”sync mode”の表示の頭に"+"のマークが付きます。 

“使用中の機械”と”IP アドレスがグループ外の機械”は"Sync Check"の対象になりません。 
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同期記録機能 

3. マスター機の LX Navi メイン画面が表示されます。画面左下の Target Unit の項目に”M/name 又はシリアル番号”が

表示され、本メイン画面がマスター機のものであることを示します。またこのマスター機に接続されているスレーブ機”S*/ 

name 又はシリアル番号”もその下に表示されます。 

次にスレーブ機に設定された LX Navi の画面を立ち上げる為、表示されたマスター機のメイン画面を一旦最小化します。 
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同期記録機能 

 

4. 今度は、スレーブ機に設定された LX Navi の画面を立ち上げる為、再度 PC から LX Navi を立ち上げると項目 1 で示

した LX 選択ダイアログ (LX Network) が表示されますので、スレーブ機に設定した LX 本体の<serial>フィールドにあるボッ

クスをクリックして[OK]をクリックします。（チェックボックスに背景がグレーのチェックマークが入っている場合、2 回クリックして通

常のチェックマークが入った状態で[OK]をクリックして下さい。） 

選択されたスレーブ機の LX Navi メイン画面が表示されます。画面左下の Target Unit の項目に”S*/ name 又はシリアル

番号”が表示され、本メイン画面がスレーブ機のものであることを示します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

同様の操作で接続されている、他のスレーブ機のメイン画面を開きます。マスター機、各スレーブ機のメイン画面表示を最大化、

最小化しながら各 LX 本体の記録条件の設定を行います。 

 

5.同期記録を行うすべての LX 本体の設定が終了したら、マスター機のメイン画面と収録中のモニターを行う必要のあるスレー

ブ機のメイン画面を残し、あとのスレーブ機のメイン画面を終了します。 

マスター機のメイン画面を操作して、記録の開始と終了を行います。 

 

6. LX Navi を終了する時は、立ち上げた順序の逆の順番（スレーブ N・・・、スレーブ 2、スレーブ 1、マスター）で終了して下さ

い。 
 

 

5-34 



同期記録機能 

 

 その他 
■ LX Navi が前回実行した LX 本体のシリアル番号を記憶しているので、同一セグメント上に前回使用した LX 本体が

接続されている場合、初期状態でチェックマークが入っていますので、”OK”ボタンを押すだけのワンクリックで実行可能で

す。 

 

■ LX 本体の同期運転の設定は、一回設定すれば内容が記憶されますので、次回からは"Sync Check”ボタンをクリック

し同期接続の確認だけで構いません。（マスター・スレーブの選択は、2 回目以降は設定省略可能です。） 

 

■ 同期設定していた LX 本体を単独運転（通常の同期運転しないモード）で使用する場合、該当 LX の"sync select"

項目のセルを右クリック(”NO SYNC”と表示されます) して"sync check"を実行します。この作業は 1 度実行すれば

設定内容を本体が記憶しますので次回以降は通常の立ち上げ方法で構いません。 

■ 運転の設定に戻すため"sync select"の列を右クリックした状態

です。この状態で”Sync Check”ボタンを押します。 

接続ケーブルが確実に接続されているか確認し再

"Sync Check"ボタンを押して、同期接続確認を実行してください。 

を行う場合は、”Update List”

ボタンをクリックしてください。（LX Navi を立ち上げた後から LX の電源をいれた場合など） 

 

 

上図はシリアル番号 535061 を同期運転から単独

 

 

 

 

 

■ LX 選択ダイアログ(LX Network)が表示された状態で、"Sync Check"ボタンを押すと同期接続確認した結果

"status"の項目に表示されます。同期接続確認を実行したマスター機に”OK”と表示され、接続が確認されたスレーブ機

にも”OK”と表示されます。スレーブ機で”NG”と表示された場合、同期

度

同期設定していたLX本体をこの操作を行わずに単独運転として使用した場合、動作が不安定となることが

あります。単独運転として使用するためには、必ずこの操作を行い、単独運転の設定に変更して下さい。 

 

■ LX選択ダイアログ(LX Network)が表示された後に、再度同一セグメント上のLXの確認

の
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本体の仕様 

 本体の仕様 
記録媒体    PC カード/内蔵メモリー、または内蔵メモリーの選択 

内蔵メモリー容量   64 MB、オプションで拡張メモリーを追加して最大 576MB 

アンプスロット   本体 2 スロット 

外部インタフェース  IEEE 1394-1995 準拠、または 100BASE-TX LAN 

サンプリング周波数  （カッコ内は記録帯域、許容差±0.5 dB） 

LX-110        

96-1.5 kHz 96 kHz 

(DC-40 kHz) 

48 kHz 

(DC-20 kHz) 

24 kHz 

(DC-10 kHz) 

12 kHz 

(DC-5 kHz) 

6 kHz 

(DC-2.5 kHz) 

3 kHz 

(DC-1.25 kHz) 

1.5 kHz 

(DC-625 Hz) 

        

LX-120        

96-1.5 kHz 96 kHz 

(DC-40 kHz) 

48 kHz 

(DC-20 kHz) 

24 kHz 

(DC-10 kHz) 

12 kHz 

(DC-5 kHz) 

6 kHz 

(DC-2.5 kHz) 

3 kHz 

(DC-1.25 kHz) 

1.5 kHz 

(DC-625 Hz) 

100-1 kHz 100 kHz 50 kHz 20 kHz 10 kHz 5 kHz 2 kHz 1 kHz 

65.536-1.024 

kHz 

65.536 kHz 32.768 kHz 16.384 kHz 8.192 kHz 4.096 kHz 2.048 kHz 1.024 kHz 

102.4-1.28 

kHz 

102.4 kHz 51.2 kHz 25.6 kHz 12.8 kHz 5.12 kHz 2.56 kHz 1.28 kHz 

 

低速サンプリング系列(1 kHz ～ 1/60 Hz) 

変換方式    128 倍オーバーサンプリング デルタシグマ方式 2 kHz サンプリング 

ディジタルフィルタ特性  5 Hz 以下のサンプリングではエイリアシングが発生します。 

Sampling Frequency (Fs) Cut-off Frequency (Fc) Attenuation 

1 kHz 400 Hz - 80dB (at 500 Hz) 

500 Hz 200 Hz - 80dB (at 250 Hz) 

200 Hz 80 Hz - 80dB (at 100 Hz) 

100 Hz 40 Hz - 80dB (at 50 Hz) 

50Hz 20 Hz - 80dB (at 25 Hz) 

20Hz 8 Hz - 80dB (at 10 Hz) 

10Hz, 5 Hz, 2 Hz, 1 Hz,1/2 Hz, 
1/5 Hz, 1/10 Hz, 1/30 Hz, 1/60 Hz 

4 Hz - 80dB (at 5 Hz) 

 

メモ音声    サンプリング周波数: 8 kHz、量子化ビット: 8 bit、WAV ファイル 

内蔵時計精度   ±1 ppm(25℃時) 

動作温度範囲   0～45℃ 

保存温度範囲   －20～60℃ 

動作湿度範囲   10～85%(非結露) 

保存湿度範囲   5～90%(非結露) 

電源     +11～30 V DC   AC アダプタ付属 

消費電力    約 36 W (LX-110 AR-LXDC100 AR-LXAO100 の場合) 

外形寸法    LX 本体 300W × 65H × 200D (mm) (突起部除く) 

質量     LX 本体 約 3.9 kg(LX-110 AR-LXDC100 AR-LXAO100 の場合) 
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本体の仕様 

 外形寸法図 
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本体の仕様 

 ブロックダイアグラム 
LX-110 8 チャネル入力 8 チャネル出力 タイプ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Input Amp 

Output Amp 

Microphone Amp
Speaker Amp 

Front Panel 
I/F 

PCCARD I/F

SDRAM 

SRAM 

ROM 

CPU 

Front Keys

Front LEDs

Drive 
(PC Card) 

 
 
 
 
 
 
 
BUS 

I/F (IEEE1394 
or 
100BASE-TX) 

PLD 
(Clock/Decode) 

External 
Trigger Circuit

Monitor D/A

Remote 
Control I/F 

Input 

PC 

Output 

MEMO IN 

DIGITALCONTROL

MON OUT

External Trigger
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タコパルス入力の仕様 

 タコパルス入力の仕様 
本体が LX-120 のとき、リアパネルの PULSE IN A/B コネクタにタコパルス入力が可能です。 

入力チャネル数   16 ビットモード: 2 チャネル、32 ビットモード: 1 チャネルまたは 2 チャネル 

入力形式    スレショルドレベル ±0.5 V、±1 V、±2.5 V、±5 V、±10 V、±20 V 切り替え 

      (最大入力電圧 ± 50 V) 

      (入力可能周波数 最大 450 kHz) 

入力インピーダンス   100 kΩ 

計測モード    (1) pulse (gate): ゲート時間内のパルス数カウントモード 

       測定レンジ: サンプリング周期の 1 ～ 255 倍 

       測定精度: ± 2 カウント 

     (2) pulse (total): 計測のスタートからストップまでのトータルカウント 

       測定精度: ± 5 カウント 

     (3) period: 周期カウントモード 

       測定レンジ: 1 msec、5 msec、10 msec、50 msec、 

100 msec、500 msec、1 sec 

       測定精度: ± 0.3 % (16 ビットモード設定時)、± 0.2 % (32 ビットモード設定時) 

     (4) frequency: 周波数計測モード 

       測定レンジ: 10 Hz、20 Hz、50 Hz、100 Hz、200 Hz、 

500Hz、1 kHz、2kHz、5kＨｚ、10 kHz、20 kHz 

       測定精度: ± 0.3 % (16 ビットモード設定時)、± 0.2 % (32 ビットモード設定時) 

     (5) rpm: 回転数計測モード 

       測定レンジ: 1500 rpm、3000 rpm、6000 rpm、9000 rpm、 

          12000 rpm、15000 rpm、18000 rpm、24000 rpm 

       測定精度: ± 0.3 % (16 ビットモード設定時)、± 0.2 % (32 ビットモード設定時) 

       分周比設定: 1 ～ 255 

       移動平均設定: 1 ～ 16 

       一回転あたりのパルス数設定: 1 ～ 255 

タコパルスタイミング  計測モードが周期カウントモード,  周波数計測モード,  回転数計測モードの場合、 

最下位 1 ビットをタコパルスタイミングに使用。 

ただしサンプリング周波数 1kHz ～ 51.2 kHz で有効 

■ 16 ビット AD の場合、タコパルス入力チャネルは、16 ビットモードのときは、1 x  タコパルス入力チャネルが 1 x  アナログ

入力チャネル数に、32 ビットモードのときは、1 x タコパルス入力チャネルが 2 x アナログ入力チャネル数に相当します。24 ビッ

ト AD の場合、タコパルス入力チャネルは、32 ビットモードのときは、1 x タコパルス入力チャネルが 1 x アナログ入力チャネル

数に相当します。タコパルス入力チャネルを ON とした場合、同じアナログ入力チャネル数の記録を確保するためには、選択

されたタコパルス入力チャネルに応じて、サンプリング周波数を低く設定します。 

■ 102.4 kHz、 100 kHz、96 kHz、 65.536 kHz、 51.2 kHz、 50 kHz、48 kHz、または、32.768 kHz サンプリング周波数

選択時 Moving Average は[1]以外は設定しないで下さい。 

■ 102.4 kHz、100 kHz、96 kHz、または、65.536 kHz サンプリング周波数を選択しタコパルス入力チャネル 32 ビットモード

で使用する場合は、1 x タコパルス入力チャネルのみ使用可能です。 

■ LX Navi ではタコパルス入力チャネルを波形表示することはできません。入力値をモニターする場合は Digital Display 画

面を開いてディジタル値でモニターを行って下さい。 

■ 記録されたタコパルス入力の信号を再生することはできません。ディジタルデータとして処理して下さい。 

■ タコパルス入力とジェネレータ出力機能を同時に使用することはできません。 

■ 24 ビット AD の場合、タコパルス入力チャネルで 16 ビットモードは選択できません。 

■ エイリアシングが発生する場合があります。 

■ アナログデータとタコパルスデータのサンプリングは非同期です。 

■ 収録時途中よりタコパルス入力が無い場合最後のタコパルスデータが保持されます。 
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タコパルス入力の仕様 

 

 ジェネレータ出力の仕様 
本体が LX-120 のとき、リアパネルの MON OUT コネクタよりジェネレータ出力が可能です。 

出力チャネル数   1 チャネル 

出力レベル    1 ～ 5 V   0.1 V ステップ (モニター出力と同じ） 

出力コネクタ   MON OUT (モニター出力) BNC 

出力の種類   SIN 波、SWEEP SIN 波、パルス、ピンクノイズ、ホワイトノイズ 

ノイズレベル    -70 dB 以下(SIN 波選択時) 

 

■ タコパルス入力とジェネレータ出力機能を同時に使用することはできません。 

■ 低速サンプリング系列(1 kHz ～ 1/60 Hz)で記録時、モニター出力からのアナログ出力は使用できません。 

■ ジェネレータ出力で出力できる sine、sweep sine の周波数はサンプリング周波数の 1/2．4 までとなります。 

■ サンプリング周波数が 102.4kHz に設定されている場合、ジェネレータ出力は使用できません。 
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拡張ユニットの仕様 

 拡張ユニットの仕様 
<AU-LX100EPIO> 

DC100 アンプ/PA100 アンプ/ST100 アンプ/AO100 アンプ用拡張ユニット 

アンプスロット   2 スロット 

外形寸法    300W × 45H × 200D (mm) (突起部除く) 

質量     約 2 kg 
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拡張ユニットの仕様 

 外形寸法図 
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DC 入力アンプの仕様 

 DC入力アンプの仕様 
<AR-LXDC100> 

入力チャネル数   8 

入力形式    不平衡 

入力インピーダンス  1MΩ以上 

入力レンジ    ±0.5、1、2、5、10、20、50 V (オーバーレンジ±127%) 

絶対最大入力電圧  ±100 V 

フィルタ    ディジタルフィルタ＋アナログフィルタ併用 

量子化ビット数   16 ビット/24 ビット切り替え(同時サンプリング) 

変換方式    128 倍オーバーサンプリング デルタシグマ方式  

     ただし 96 kHz サンプリング時は 64 倍オーバーサンプリング 

サンプリング周波数  LX 本体のサンプリング周波数による 

レンジ精度    ±2%以下 

非直線性    ±0.1%以下 

歪率     96 kHz サンプリング時 ±0.1%以下 

48 kHz サンプリング時 ±0.07%以下 

24 kHz サンプリング以下の時 ±0.4%以下 

ドリフト    ±0.1%以下(電源投入 10 分後以降) 

ダイナミックレンジ   86/96 dB(帯域内、48 kHz サンプリング以下) 82/90dB(帯域内、96 kHz サンプリング) 

S/N     84/94 dB(帯域内) 、48 kHz サンプリング以下) 80/88dB(帯域内、96 kHz サンプリング 

クロストーク    -82/-88 dB(帯域内、48 kHz サンプリング以下) -80/-86dB(帯域内、96 kHz サンプリング) 

チャネル間位相差  1°以内(同一レンジ、帯域 20 kHz 以下にて) 

     3°以内(同一レンジ、帯域 40 kHz 以下にて) 
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DC 入力アンプの仕様 

■ フィルタ特性 

アナログフィルタは 2 次バターワースフィルタで、カットオフ周波数は折り返し周波数(1/2Fs)の約 1.2 倍です。128 倍デルタシ

グマ AD の高次の折り返しを防止します。 

ディジタルフィルタは 128 倍デルタシグマ AD のデータをダウンサンプリングする際に使用します。その減衰特性は 1/2Fs で約

－6 dB です。－6 dB 以内の折り返し成分が 1/2Fs の 1 から 1.1 倍位の周波数で発生します。減衰率は急峻ですのでノ

イズレベルまですぐに減衰します。 

 
1/2 Fs 

 

Analog filter  
(-12 dB/oct) 

 -6 dB Digital filter 
 

 

 1.1 x 1/2 Fs 
 

■ キャリブレーション 

電源投入時に DSP を用いて全チャネル、全レンジのセルフキャリブレーションを行います。その動作は、まず電源投入時にゼ

ロと＋フルスケールの 2 つの基準信号を AD 変換し、レンジごとにゼロ点誤差とゲイン誤差を算出し保存します。記録時には

AD 変換したデータを、各レンジに応じたキャリブレーションデータにより補正します。 

 

 ブロックダイアグラム 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Input Amp A/D

 
 
PLD 

FIFO DSP FIFO 

RAM 

Input Amp A/D

IN 1 

IN 8 
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PA アンプの仕様 

 PAアンプの仕様 
<AR-LXPA100> 

チャネル数    8 

入力形式    平衡/不平衡 

入力結合    平衡 AC 結合/不平衡 AC 結合/平衡 DC 結合/不平衡 DC 結合 

入力インピーダンス  1MΩ以上 

入力レンジ    ±0.01 V、0.0316 V、0.1 V、0.316 V、1 V、3.16 V、 

      10 V、50 V (オーバーレンジ ±127 %) 

絶対最大入力電圧  ± 50 V (±0.01 ～ 3.16 V)  ± 100 V (±10 V、± 50 V) 

フィルタ    ディジタルフィルタ＋アナログフィルタ併用 

HPF     3 次バターワースフィルタ 10 Hz (±0.5 dB 以内)、20 Hz(±0.5 dB 以内) 

ウェイティング   A カーブ、C カーブ、フラット  IEC-TYPE1 

周波数特性   平坦度 ±0.5 dB 

 AC モード時  1 Hz ～ LX 本体各帯域 

 DC モード時  DC ～ LX 本体各帯域 

量子化ビット数   16 ビット/24 ビット切り替え(同時サンプリング) 

変換方式    128 倍オーバーサンプリング デルタシグマ方式  

     ただし 96 kHz サンプリング時は 64 倍オーバーサンプリング 

サンプリング周波数  LX 本体のサンプリング周波数による 

レンジ精度    ±2%以下 

非直線性    ±0.1%以下 

歪率     48 kHz、96 kHz サンプリング時: 

     入力レンジ 0.316 V 以上  ±0.1%以下 

     入力レンジ 0.1 V 以下  ±0.2%以下 

     24 kHz サンプリング以下の時 ±0.4%以下 

ドリフト    ±0.1%以下(入力レンジ 1.0 V にて、電源投入 10 分後以降) 

S/N クロストーク   下記の表を参照 

チャネル間位相差  1°以内（同一レンジ、帯域 20 kHz 以下にて） 

     3°以内（同一レンジ、帯域 40 kHz 以下にて） 

センサ供給電源   28 V DC/4 mA、24 V DC/4 mA (切り替えスイッチ) 

TEDS    LX Navi および専用リモコンにて TEDS 情報読み取り (IEEE1451.4 準拠) 

     対応 TEDS テンプレートは以下の表を参照 

消費電力    約 7 W 

 

S/N クロストーク 

 S/N  Crosstalk  

Input Range 
Within Bandwidth 

20 kHz or less 
Within Bandwidth 

40 kHz or less 
Within Bandwidth 

20 kHz or less 
Within Bandwidth 

40 kHz or less 

+/- 0.01 V 64/67 dB 60/63 dB - 64 dB -60 dB 
+/- 0.0316 V 74/77 dB 69/72 dB - 73 dB -69 dB 
+/- 0.1 V 83/86 dB 77/80 dB -78 dB -74 dB 
+/- 0.316 V 87/93 dB 77/80 dB -78 dB -74 dB 
+/- 1.0 V 87/93 dB 77/80 dB -78 dB -74 dB 
+/- 3.16 V 87/96 dB 77/80 dB -78 dB -74 dB 
+/- 10 V 87/96 dB 77/80 dB -78 dB -74 dB 
+/- 50 V 87/96 dB 77/80 dB -78 dB -74 dB 

 

対応 TEDS テンプレート 

Template ID Type TEDS Version 

0 - 3 Accelerometer 

12 - 23 Microphones IEEE P1451.4 (v0.9)

24 Accelerometer 

25 Accelerometer/Force transducer w. const. curr. ampl. 

27 
IEEE 1451.4 (v1.0)

Microphones w. built-in preamp. 
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ST アンプの仕様 

 STアンプの仕様 
<AR-LXST100> 

チャネル数    8 

入力形式    平衡差動入力 

入力結合    平衡 DC 結合 DC ブリッジ方式 

入力インピーダンス  1 MΩ以上 

入力レンジ    ST モード ±0.25 mV/V、0.5 mV/V、1 mV/V、2.5 mV/V、5 mV/V、10 mV/V、 

       25 mV/V、50 mV/V(オーバーレンジ±127%)  

     DC モード ±1 V、2 V、5 V、10 V(オーバーレンジ±127%) 

絶対最大入力電圧  ±25 V 

フィルタ    ディジタルフィルタ＋アナログフィルタ併用 

LPF     10/30/100/300/1 k/3 k/10 k/30 kHz/Pass: - 48 dB OCT バターワース方式  

     (スイッチドキャパシタフィルタ) 8 チャネル独立 

周波数特性    

 ST モード時  DC ～ 30 kHz (-3 dB)  

 DC モード時  DC ～ 40 kHz (-3 dB) 

量子化ビット数   16 ビット/24 ビット(同時サンプリング) 

変換方式    128 倍オーバーサンプリング デルタシグマ方式  

     ただし 96 kHz サンプリング時は 64 倍オーバーサンプリング 

サンプリング周波数  LX 本体のサンプリング周波数による 

レンジ精度    ±1%以下 

非直線性    ±0.1%以下 

歪率     DC モード時 

     96 kHz サンプリング時 ±0.1%以下 

48 kHz サンプリング時 ±0.07%以下 

24 kHz サンプリング以下の時 ±0.4%以下 

     ST モード時(SCF:10kHz,30kHz)10000uST 

24kHz,96kHz サンプリング時 ±0.1%以下 

適用ゲージ抵抗   120 ～ 2000 Ω 

ゲージ率    2.0 

ブリッジ電圧   2 V (±1 V) / 10 V (± 5V) 

ブリッジ接続   フルブリッジ 

リモートセンス   あり 

温度ドリフト   ±0.1%/1℃(電源投入 10 分後以降) 

平衡調整方式   電子式オートバランス 

平衡調整範囲   ±10000μST （ブリッジ電圧 2V の場合） 

ゼロバランス    16 ビット D/A によるオート&マニュアルキャリブレーション 

S/N クロストーク 

 

ST Mode SCF SCF SCF  

Bridge 

Voltage=2V 
1kHz 3kHz 10kHZ  

  SNR(dB) Cross Tark(dB) SNR(dB) Cross Tark(dB) SNR(dB) Cross Tark(dB)  

±0.5mV 67 67 62 62 58 58  

±1mV 73 73 68 68 64 64  

±2mV 75 75 74 74 71 71  

±5mV 75 75 75 75 75 75  

±10mV 75 75 75 75 75 75  

±20mV 75 75 75 75 75 75  

±50mV 75 75 75 75 75 75  

±100mV 75 75 75 75 75 75  

        

DC Mode SCF bypass SCF bypass SCF bypass DC Mode 

Input 

Range 
Input Level Sampling Frequency(24kHz) Sampling Frequency(48kHz) Sampling Frequency(96kHz) 

  SNR(dB) Cross Tark(dB) SNR(dB) Cross Tark(dB) SNR(dB) Cross Tark(dB)   

±1V 87/93 -77/-83 87/93 -77/-83 77/83 -74/-80 ±1V 

±2V 87/93 -77/-83 87/93 -77/-83 77/83 -74/-80 ±2V 

±5V 87/93 -77/-83 87/93 -77/-83 77/83 -74/-80 ±5V 

±10V 87/93 -77/-83 87/93 -77/-83 77/83 -74/-80 ±10V 
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ST アンプの仕様 
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チャネル間位相差   1°以内（同一レンジ、帯域 20 kHz 以下にて） 

      3°以内（同一レンジ、帯域 40 kHz 以下にて） 

コネクタ     Lemo 7-pin  10 ø (EGG0B Type) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

消費電力    約 8 W 

 

 

リモートセンス + 

S 
ブ リ ッ ジ 電 圧  + 

VB 

GND 

信号入力 IN  - リモートセンス - 

S 

ブ リ ッ ジ 電 圧  - 

VB 

信号入力 IN  + 



出力アンプの仕様 

 出力アンプの仕様 
<AR-LXAO100> 

出力チャネル数   8 

出力電圧    ±1～5 V（0.1 V ステップ可変） 

インピーダンス   75Ω不平衡 

出力電流    ±10mA（20Ω負荷時） 

フィルタ    ディジタルフィルタ＋アナログフィルタ併用 

周波数特性   DC100/PA100との組合せ 

DC～(サンプリング周波数/2.4) 

平坦度 ±0.5dB  (サンプリング周波数 48KHz以下)    

平坦度 +0.5dB ～ -1.0dB   (サンプリング周波数 96KHz) 

ST100との組合せ 

DC～(サンプリング周波数/2.4) 

平坦度 +0.5dB ～ -3.0dB 
直線性    ±0.1%以下 

歪率     ±0.2%以下 

ドリフト    ±0.1%以下 

ダイナミックレンジ   89/95 dB（帯域内）25℃ 

S/N     87/93dB（帯域内）25℃ 

クロストーク    -78 dB（帯域内、48 kHz サンプリング以下） 

     -75 dB（帯域内、96 kHz サンプリング） 

チャネル間位相差  1°以内（同一レンジ、帯域 20 kHz 以下にて） 

     3°以内（同一レンジ、帯域 40 kHz 以下にて） 
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出力アンプの仕様 

■ フィルタ特性 

アナログフィルタは 2 次バターワースフィルタで、カットオフ周波数は折り返し周波数（1/2Fs）の約 1.2 倍です。 

ディジタルフィルタの減衰特性は 1/2Fs で約－6 dB です。入力信号に対しては入力アンプと出力アンプの両方が加算され

ますので、折り返し周波数（1/2Fs）では下図のように－12 dB の減衰となります。 

 

1/2 Fs  

 Analog filter 
(-12 dB/oct)  

-6 dB Digital filter  

 

 
1.1 x 1/2 Fs 

 

 

 

 ブロックダイアグラム 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Output Amp D/A

 
 
PLD 

Output Amp D/A

OUT 

FIFO DSP FIFO 

RAM 

OUT 
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ファイルフォーマット 

 ファイルフォーマット 
 ファイルの種類 
本機では記録を一時停止または停止するごとにバイナリ形式のデータファイルと ASCII 形式のヘッダファイルがそれぞれ 1 つず

つ作成されます。 

データファイル:  A/D データを書き込む。 バイナリ形式、拡張子「dat」。 

ヘッダファイル:  記録条件などを書き込む。 テキスト形式（ASCII 形式）、拡張子「hdr」。 

 

■ メディアには DOS フォーマットで保存されます。 

 

■ メモ音声を録音した場合は、これらに加えてメモ音声ファイル（拡張子 「wav」）が作成されます。このメモ音声ファイルは

Windows の Media Player で再生することができます。 

 

 

 ファイル名 
データファイルとヘッダファイルのファイル名は共通で、指定のファイル名に ID 番号がつきます。ID 番号は、新たなファイル名を

指定するたびに「1」から始まり、記録を停止後（または一時停止後）に再開するたびに自動的にインクリメントします。また、

メディア、PC に記録時に同名、同一 ID 番号のデータファイルがすでにある場合は、その次の ID 番号になります。 

 

●メモリー/メディアに記録する場合 

ファイル名は File → New の Dataset で指定します。半角英数字で 5 文字まで指定できます。（使用できない記

号 ．，；：<>[]*?="/\|   ） この 5 文字に 001 から始まる 3 桁の ID 番号がつき、合計で 8 文字になります。4 文字以内

にすると、3 桁の番号との間は「0」で埋められ、合計で 8 文字になります。 

 

●PC に記録する場合 

PC に記録する場合、またはメモリー/メディアに記録しながら PC に同時に記録する場合には半角英数字で、ファイル名の

長さに制限はありません。（使用できない記号 ．，；：<>[]*?="/\|   ）そのファイル名に8桁までのID番号をつけられます。 
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ファイルフォーマット 

 メディア上のディレクトリ構造 
メディア上のディレクトリ構造は下図のようになります。 

 

 
Root 

TEAC_LX 1
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. TEAC_LX 

メディアをフォーマットすると自動的に生成されるディレクトリ。メディアを LX 本体に挿入した時にディレクトリがないと自動的に

生成される。 

 

2. TEST0001 

File → New で Directory に入力したディレクトリ名。 

 

3. Aaaaa001.dat、Aaaaa001.hdr、 Aaaaa001.wav 

1 つの「ID」ごとに生成されるデータファイルと、ヘッダファイル、メモ音声ファイル（メモ音声を録音した場合）。 

 

 

TEST000 2
Aaaaa001.dat
Aaaaa001.hdr
(Aaaaa001.wav)

Aaaaa002.dat
Aaaaa002.hdr
(Aaaaa002.wav)

TEST000
Bbbbb001.dat
Bbbbb001.hdr

3
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ファイルフォーマット 

 データファイル 
AD 変換されたデータは 16 ビット AD の場合－32768～＋32767 の 2 バイト整数値、24 ビット AD の場合－8388608～＋

8388607 の 4 バイト整数値として記録されます。負数は 2 の補数で表わされます。 

 

バイト順は下位バイト→上位バイトのいわゆるインテルフォーマット*1 です。 

 

データの順は第 1 サンプリングのチャネル順→第 2 サンプリングのチャネル順→ … →最終サンプリングのチャネル順となります。

これを INTERLACED 形式*2 と称し、ヘッダファイルの STORAGE_MODE に形式名が記述されます。 

 

データファイルの構造を下図の例で示します。例に示すひとかたまりのデータを本書では 1 つの「スキャン」と呼びます。データフ

ァイルはこのスキャンの繰り返しです。 

 

【例】 

 

サンプリング周波数 6 kHz で記録したときの 1 スキャンのデータ 

 
データの順序 

 

ch 1  
ch 2  
ch 3 

 ch 4 1/6000 秒 
ch 5  

ch 6  

 

 

 

 

【参考】 

*1: 上位バイト→下位バイトの順がいわゆるモトローラフォーマットで、ワークステーション、モトローラ系の CPU を使用した

FFT アナライザ等で採用されています。 

 

*2: これに対してSEQUENTIAL形式のデータ順は、第1チャネルのサンプリング順→第2チャネルのサンプリング順→ … →

最終チャネルのサンプリング順、となります。 

 

 

ch 7 
ch 8 
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ファイルフォーマット 

 タコパルス入力ON時のデータファイル 
LX-120 では、下記の 4 つのうちいずれか 1 つの入力モードを選択し、タコパルス入力データをアナログ信号とともに記録する

ことができます。  

 

2 x 16 ビットタコパルス入力チャネル (タコパルス入力チャネル A とタコパルス入力チャネル B となります。) 

1 x 32 ビットタコパルス入力チャネル (タコパルス入力チャネル A となります。) 

1 x 32 ビットタコパルス入力チャネル (タコパルス入力チャネル B となります。) 

2 x 32 ビットタコパルス入力チャネル (タコパルス入力チャネル A とタコパルス入力チャネル B となります。) 

 

16 ビットモードでのレンジ 100%の値は 25,000 

32 ビットモードでのレンジ 100%の値は 1,638,400,000 となります。 

 

24 ビット AD の場合は、16 ビットタコパルス入力チャネルは選択できません。 

 

LX-120 では、設定された一回転あたりのパルス数や分周比設定が反映された値がデータとして記録されます。 

 

各スキャンでのタコパルス入力チャネルのデータは、そのシステムで設定された最後のアナログチャネルの次に記録されます。 

次の例を参考にして下さい。 
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ファイルフォーマット 

【例】 

アナログ入力が 8 チャネルで、2 つの 16 ビットタコパルス入力チャネルが設定されたとき: 

(ヘッダファイルの該当するキーワードは PULSE_CH_A 9 and PULSE_CH_B_10 となります。) 

 

1 スキャン 

Channel 1 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 2 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 3 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 4 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 5 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 6 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 7 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Channel 8 (Analog) 
Bit7.............................Bit0 

 
Bit15............................Bit8

  

Tachometer Pulse Input 
Bit7.............................Bit0 

Channel A 
Bit15............................Bit8

  

Tachometer Pulse Input 
Bit7.............................Bit0 

Channel B 
Bit15............................Bit8

  

 

 

アナログ入力が 8 チャネルで、2 つの 32 ビットタコパルス入力チャネルが設定されたとき: 

(ヘッダファイルの該当するキーワードは PULSE_CH_A 9 and PULSE_CH_B_10 となります。) 

 

1 スキャン 

Channel 1 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 2 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 3 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 4 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 5 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 6 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 7 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Channel 8 (Analog) 
Bit7..............................Bit0 

 
Bit15............................Bit8

  

Tachometer Pulse Input 
Bit7..............................Bit0 

Channel A 
Bit15............................Bit8

 
Bit23..........................Bit16 

 
Bit31..........................Bit24

Tachometer Pulse Input 
Bit7..............................Bit0 

Channel B 
Bit15............................Bit8

 
Bit23..........................Bit16 

 
Bit31..........................Bit24
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ファイルフォーマット 

 データを物理量に換算するには 
AD 変換値は、16 ビット AD の場合は－32768～＋32767 の整数値で、設定した入力レンジに対して入力が±100％のと

きに±25000 になります。24 ビット AD の場合は－8388608～＋8388607 の整数値で、設定した入力レンジに対して入力

が±100％のときに±6400000 になります。入力値は次の式で求められます。 

 

入力値 ＝ データファイルの AD 変換値 × SLOPE ＋ Y_OFFSET 

 

■ LX-120 のタコパルス入力のデータについて 

16 ビットモードでのレンジ 100%の値は 25,000 

32 ビットモードでのレンジ 100%の値は 1,638,400,000 となります。 

 

LX-120 では、設定された一回転あたりのパルス数や分周比設定が反映された値がデータとして記録されます。 
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ファイルフォーマット 

 ヘッダファイル 
ヘッダファイルは記録条件などを書き込む ASCII 形式のテキストファイルで、波形解析ソフトウエア“DADiSP”のフォーマットに

準じています。テキスト形式ですので、“メモ帳”、“NOTEPAD”などの Windows アプリケーションでも読み出せます。 

ヘッダファイルには記録条件を項目ごとに 1 行で記述してあり、各パラメータは「,」で区切られています。以下にヘッダファイルの

例を示します。 

 

■ ヘッダファイルの例(LX-110 の例) 

DATASET TEST0001 

VERSION 1 

SERIES CH1_LX-110_DC100K,CH2_LX-110_DC100K,CH3_LX-110_DC100K,CH4_LX-110_DC100K, 

CH5_LX-110_DC100K,CH6_LX-110_DC100K,CH7_LX-110_DC100K,CH8_LX-110_DC100K  

DATE 06-23-2001 

TIME 16:32:55.00 

RATE 1500 

VERT_UNITS V,V,V,V,V,V,V,V  

HORZ_UNITS Sec 

COMMENT <LX-110> 

NUM_SERIES 8 

STORAGE_MODE INTERLACED 

FILE_TYPE INTEGER 

SLOPE 8.000000e-005, 8.000000e-005, 8.000000e-005, 8.000000e-005, 8.000000e-005, 

8.000000e-005, 8.000000e-005, 8.000000e-005  

X_OFFSET -5.0 

Y_OFFSET 0.000000e+000, 0.000000e+000, 0.000000e+000, 0.000000e+000, 0.000000e+000, 

0.000000e+000, 0.000000e+000, 0.000000e+000  

NUM_SAMPS 59200 

DATA 

DEVICE LX-110 

SLOT1_AMP DC100_AMP,8,V1.00 ,V1.00  

SLOT2_AMP AO100_AMP,8,V1.00 ,V1.00  

CH1_1 LX110_DC100K,RANGE=2V,FILTER=ON 

CH2_2 LX110_DC100K,RANGE=2V,FILTER=ON 

CH3_3 LX110_DC100K,RANGE=2V,FILTER=ON 

CH4_4 LX110_DC100K,RANGE=2V,FILTER=ON 

CH5_5 LX110_DC100K,RANGE=2V,FILTER=ON 

CH6_6 LX110_DC100K,RANGE=2V,FILTER=ON 

CH7_7 LX110_DC100K,RANGE=2V,FILTER=ON 

CH8_8 LX110_DC100K,RANGE=2V,FILTER=ON 

ID_NO 1 

TIME 20010623163255,20010623163335 

REC_MODE MEMORY 

START_TRIGGER COMMAND,PRE 

STOP_CONDITION COMMAND,POST 

START_PRE_COUNT 7500 

STOP_POST_COUNT 15000 

MARK 100,200,300 

ID_END 

VOICE_MEMO 8BITS,327680 

LX110_VERSION V1.00 ,V1.00 ,V1.00 ,00022EE02000 ,MEMORY=63MB,IF=1394(G),NAVI 

MEMO_LENGTH 8,0,0,0,0,0,0,0 

MEMO <LX-110> 
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ファイルフォーマット 

■ ヘッダファイルの解説 

DATASET   ファイル名 

VERSION   1 に固定 

SERIES   記録に使用したチャネル番号。アンダーバーの後はチャネル名。 

DATE   記録開始日（月-日-年） 

TIME    記録開始時刻(時:分:秒) 

RATE   サンプリング周波数(単位:Hz) 

VERT_UNITS  各チャネルの物理/工学単位 

HORZ_UNITS  時間軸の単位(Sec に固定) 

COMMENT   File → New で入力したコメント。 

NUM_SERIES  記録チャネル数。  

STORAGE_MODE データ順。スキャン順なので INTERLACED に固定 

FILE_TYPE   16 ビット AD の場合は、1 データ 2 バイト整数なので INTEGER 

24 ビット AD の場合は、1 データ 4 バイト整数なので LONG 

SLOPE   データを物理/工学単位に変換するための係数 

X_OFFSET   先頭データの時間軸上の位置。通常は 0。 

    プリトリガ時はマイナスで設定値（秒数：小数点以下 3 桁）が書き込まれる。 

    Pre Trigger をスキャン数で設定しても秒の単位になる。 

Y_OFFSET   データを物理/工学単位に変換するための加算定数。 

NUM_SAMPS  チャネルあたりの記録データ数 

DATA   これより下の情報は本機に特有のものであり、DADiSP のフォーマットとは異なることを示す。 

DEVICE   LX-110/LX-120 

SLOT1_AMP  スロット 1 に実装されたアンプの識別名、チャネル数、PLD バージョン、ファームバージョン 

    以下構成により、SLOT2_AMP ..... 

CH1_    アンダーバーに続き、チャネル番号、アンプの種類、レンジの設定、 

    フィルタの設定（DC アンプでは常に ON） 

ID_NO   ID 番号 

TIME    記録開始日時、記録終了日時(YYYYMMDDhhmmss) 

REC_MODE  記録先デバイス（MEMORY、PC カード、PC） 

START_TRIGGER 記録開始条件 COMMAND: インタフェースコマンド 

       PANEL: フロントパネルの FWD ボタン 

       LEVEL: レベルトリガ 

       DATE: インターバル動作で Repeat Count が 1 回の場合 

       TIMER: インターバル動作で Repeat Count が 2 回以上の場合 

       EXT: 外部トリガ 

       TIME_OUT: タイムアウト 

       ,PRE: プリトリガの場合に追加される 

STOP_CONDITION 記録終了条件 COMMAND: インタフェースコマンド 

       PANEL: フロントパネルの STOP ボタン 

       LEVEL: レベルトリガ 

       TIMER: 記録時間指定 

       EXT: 外部トリガ 

       MEMORY_FULL: メモリーフル 

       MEDIA_FULL: メディアフル 

       ,POST: ポストトリガの場合に追加される 

START_PRE_COUNT プリトリガで記録したスキャン数 

STOP_POST_COUNT ポストトリガで記録したスキャン数 

MARK   イベントマークがつけられた瞬間のスキャン数 

ID_END   これ以下は LX のハードウエア情報など 

VOICE_MEMO  メモ音声データの 1 サンプルあたりのビット数、データサイズ(バイト) 

LX110_VERSION  LX 本体の PAL とファームウエアのバージョン、MAC アドレス、メモリサイズ、インタフェース種別 

(LX120_VERSION) LX-120 の場合 

MEMO_LENGTH  MEMO の文字数。コンマ以降は,0,0,0,0,0,0,0 固定 

MEMO   <LX-110> 
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ファイルフォーマット 

■ LX-120 では、DEVICE 以下に、設定されたモードにより次の情報が追加されます。 

タコパルス入力が設定された場合 

TACHO_PULSE  タコパルスファームバージョン、タコパルス PAL バージョン 

PULSE_CH_A  タコパルス入力チャネル番号、アナログ入力が 8 のときは 9 となる。 

PULSE_MODE_A  タコパルス入力モード、ビット数、測定モード番号、レンジ設定 

    測定モード  0: パルスカウントモード ゲート 

       1: パルスカウントモード トータル 

       2: 周期カウントモード 

       3: 周波数モード 

       4: RPM モード 

PULSE_LEVEL_A スレショルドレベル 

DIVIDE_RATE_A  分周比 

MOVE_AVERAGE_A 移動平均 

PULSE_PER_1R_A 一回転あたりのパルス数 

 

以上の項目は、測定モードによっては生成されない項目があります。 

 

タコパルス入力チャネル B が有効になった時は、上記の「A」が「B」となり項目が生成されます。 

 

 

■ メディア記録において、最大サイズで自動分割された場合は、DEVICE 以下に、次の情報が追加されます。 

DEVIDED n-m  m 分割されたうちの n 個目のファイル 

 

 

■ 同期記録を行った場合は、DEVICE 以下に、設定されたモードにより次の情報が追加されます。 

SYNC MASTER  同期記録マスター機の場合 

(SYNC SLAVE n ) 同期記録スレーブ機(n)の場合 
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コネクタの仕様 

 コネクタの仕様 
 DIGITAL CONTROLコネクタ 
<機能> 

接点入力    REC FWD、REC、FWD、STOP、PAUSE、イベント、パネルロック、内部時計校正 

ステータス出力   REC、FWD、STOP、PAUSE、イベント、パネルロック 

<入出力回路形式> 

入力形式    L レベル: 0.4 V 以下 

     H レベル: オープンもしくは 2 V 以上 

     パルス幅: 100 msec 以上 

出力形式    オープンドレイン、最大シンク電流: 8 mA 

<コネクタ> 

角型ハーフピッチ 36 ピン DHA-RC36-R1xxx シリーズ 

 

ピン配列 

Pin No. Signal Function Pin No. Signal Function 

1 GND Ground 19 GND Ground 

2 RESERVED Reserved 20 RESERVED Reserved 

3 RESERVED Reserved 21 RESERVED Reserved 

4 GND Ground 22 AGND Reserved 

5 RESERVED Reserved 23 AGND Reserved 

6 RESERVED Reserved 24 AGND Reserved 

7 GND Ground 25 AGND Reserved 

8 RESERVED Reserved 26 RESERVED Reserved 

9 RESERVED Reserved 27 RESERVED Reserved 

10 RTCADJIN Internal clock 
adjustment input 

28 NC  

11 RECFWDIN REC FWD input 29 NC  

12 RECIN REC input 30 RECSTS REC output 

13 FWDIN FWD input 31 FWDSTS FWD output 

14 STOPIN STOP input 32 STOPSTS STOP output 

15 PAUSEIN PAUSE input 33 PAUSESTS PAUSE output 

16 EVENTIN EVENT input 34 EVENTSTS Event output 

17 PLOCKIN Panel Lock input 35 PLOCKSTS Panel Lock output 

18 GND Ground 36 GND Ground 

 

PANEL LOCK 入力は LX 本体のフロントパネルのボタン操作を禁止するためのものです。始めの信号でロックし、次の信号

でロックを解除します。 

 

 

 
100 ms 以上 1 s 以上  

 
ロック ロック解除 

 

 

 

■ RTCADJIN 入力は内部時計校正用で、H レベルから L レベルへの立下りで校正実行、内部時計の秒数が 0 から 29 の

ときはそのときの分の 0 秒に戻し、30 から 59 のときは次の分の 0 秒に進めます。 
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コネクタの仕様 

 

 AQ-VU 同期コネクタ 
AQ-VU の記録スタート・ストップコントロール及び時刻合わせを行います。 

<機能> 

入力     ALARM IN 

コントロール出力   CLOCK  、START STOP 、EVENT TRG 

シリアル出力   S-IF OUT  38400bps  

<入出力回路形式> 

入力形式    L レベル: 0.4 V 以下 

     H レベル: オープンもしくは 2 V 以上 

出力形式    オープンドレイン(4.7kΩで 5v にプルアップ)、最大シンク電流: 8 mA 

<コネクタ> 

丸型コネクタ   ヒロセ HR25-7R-8S(71) 

 

 

 ピン配列   

 Pin No. Signal Function 

 1 EVENT TRG OUT イベントトリガ出力 

 2 ALARM IN アラーム信号入力 

 3 START STOP OUT スタート・ストップ コントロール出力 

 4 GND Ground 

 5 CLOCK OUT サンプリングクロック出力 

 6 S-IF IN Reserved 

 7 GND Ground 

 8 S-IF OUT 内蔵時計シリアル出力 

 

 

■ 同期記録スレーブに設定されている LX と AQ-VU との同期はできません。AQ-VU との同期を行う場合は同期記録の

設定を解除するか、マスター機に接続して下さい。 
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同期記録機能の仕様 

 同期記録機能の仕様 
同期記録可能台数  4 台 

チャネル間位相差  異なるユニット間のチャネルにおける位相差 

     5°以内(同一レンジ、帯域 20 kHz 以下にて) 

     7°以内(同一レンジ、帯域 40 kHz にて） 

トータル同期ケーブル長  10 m 以内 

 

■ IEEE 1394 モデルの LX と LAN モデルの LX を混在して同期記録を行うことはできません。 

 

■ IEEE 1394 モデルの場合、すでにお使いになられている LX Navi を更新される場合にはデバイスドライバも同様に更新し

て下さい。 

 

■ 同期再生動作を行うことは出来ませんが、マスター機のみの単独再生動作は実行可能です。 

 

■ 記録時のサンプリング周波数、量子化ビット数および記録先メディア（Memory, PC カード）は、マスター機/スレーブ機と

も同じ設定にして下さい。またマスター機/スレーブ機を1台のPCで制御する場合（同期記録する複数台分のLX Navi

を同時立ち上げ）は、記録するファイルのディレクトリ名・ファイル名が重複しない様に設定して下さい。 

 

■ サンプリング周波数 1kHz で LX-110 と LX-120 を混在させて同期記録を行った場合、位相がずれる可能性がありま

す。LX-110 と LX-120 が混在しないようにして下さい。 

 

■ 各種トリガ条件はマスター機のみに設定できます。スレーブ機には設定できません。 

 

■ マスター機/スレーブ機を 1 台の PC で制御する場合、最大サンプリング周波数での動作や LX Navi の設定内容の保存

機能に制限が生じる場合があります。 

 

■ 同期記録を行う場合 LX Navi の起動は、マスター機、スレーブ 1、スレーブ 2・・・の順序で立ち上げ、終了する場合は

起動時の逆の順序で終了させ最後にマスター機の LX Navi を終了して下さい。 

 

■ オプションソフトウエアである波形表示プログラム LX View PL-S1001、または、ファイル変換プログラム AFC NEO 

PL-S1002 を用いて各 LX 本体に分割して同期記録されたデータファイルを縫合して一つのファイルにすることができま

す。 

 

■ 複数のスレーブ機のメイン画面を表示したままで、記録を開始すると設定されたサンプリング周波数によってはモニターが

できなくなることがあります。開くメイン画面は必要最小限にとどめて下さい。 

 

■ 記録と記録の間の待機時間は 5 秒以上空けてください（メディア記録の場合等、それ以上の秒数が必要となることがあ

ります）。 

 

■ サンプリング周波数を変更後は 40 秒以上時間を空けてから記録を開始して下さい。 

 

■ アイドル状態から記録待機状態になった時に LX Navi の波形表示が一瞬乱れることがありますが、モニター出力、アナ

ログ出力、記録されるデータ等には影響ありません。 

 

■ 同期記録を行わない場合は、<SYNC IN> <SYNC OUT>コネクタに同期ケーブルは接続しないで下さい。 

 

■ 同期記録スレーブに設定されている LX と AQ-VU との同期はできません。AQ-VU との同期を行う場合は同期記録の

設定を解除するか、マスター機に接続して下さい。 
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トラブルシューティング 

 トラブルシューティング 
下記のような症状が発生したときは、修理をご依頼になる前にもう一度ご確認下さい。 

 

症状 考えられる原因と対処方法 

電源が入らない ・電源ケーブルは正しく接続されていますか？ 

・DC電源電圧が低くありませんか？ 

LX NaviからLX本体を認識できない 

(LX Network 画面に接続しているLXが 

表示されない) 

IEEE 1394モデルの場合 

・IEEE 1394ケーブルは正しく接続されていますか？ 

・IEEE 1394インタフェースカードは正しく認識されていますか？ 

 （デバイスマネージャ → 1394バスコントローラ） 

・IEEE 1394インタフェースカードは推奨品をお使いですか？ 

・LXのデバイスドライバは正しく認識されていますか？ 

 （デバイスマネージャ → TEAC Device） 

・同期記録の場合、デイジーチェーン接続したLXを順番に連続的に

再度電源をONにするか、デイジーチェーンしている末端のLXのコネク

タの抜き差しを実行してみて下さい。 

・LX本体の電源を入れ直してからLX Naviを再起動してみて下さい。 

 

LAN モデルの場合 

・LANケーブルは正しく接続されていますか？ 

・PCとLX本体を1対1で接続している場合にはクロスケーブルを使用し

ていますか？ 

・PC、LX本体ともIPアドレス・サブネットマスクなどが正しく設定されて

いますか? 

・PCのファイアウォールを有効にしている場合は、ファイアウォールでブロ

ックされている可能性があります。LXNaviをファイアウォールのブロック

対象から除外する設定をしてください。但しファイアウォールでブロックさ

れている場合でもLX本体のIPを直接指定して実行することは可能で

す。 

・LX本体の電源を入れ直してからLX Naviを再起動してみて下さい。 

Newダイアログでメディアを認識できない ・メディアはフォーマット済みですか？ 

・動作検証済みのメディアをお使いですか？ 

・メディア記録可能な記録条件ですか？メディア記録が出来ない記

録条件ではNewダイアログでメディアは表示されません。 

メディアに記録できない ・メディアを挿入してありますか？ 

・メディアはフォーマット済みですか？ 

PC記録したデータを再生できない ・PC記録したデータはLxNaviでは再生できません。 

「5-9 PC記録したファイルをLX本体で再生する場合の注意」を参照

下さい。 

メディア自動保存（Auto Saving）の動作にな

らない 

・メディアはフォーマット済みですか？ 

・メディアがフルではありませんか？ 

・Auto Savingの設定は有効になっていますか？ Auto Savingは電源

を切るとリセットされ無効になります。電源投入のたびに有効にして下

さい。 

本体のボタンが効かない ・パネルロックされていませんか？解除して下さい。 

サンプリング周波数が設定できない ・メディア記録のため、そのサンプリング周波数では記録できるチャネル

数が多すぎませんか？ 

・タコパルス入力チャネルがONにしたため、そのサンプリング周波数では

記録できるチャネル数が多すぎませんか? 

ジェネレータ出力が選択できない。 ・タコパルス入力とジェネレータ出力機能を同時に使用することはでき

ません。ジェネレータ出力を使用する場合はタコパルス入力チャネルを

OFFにして下さい。 

再生時にメモ音声が再生されない。 ・データを音で聞くモードになっていませんか？ツールバーのスピーカボタ

ンでメモ音声を再生させるかデータを再生させるかの選択が出来ま

す。 

 

上記の処置をしても直らない場合は当社のサービス部門にご相談下さい。 
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付属品とオプション 

 付属品とオプション 
 付属品 
DC 電源コード     1 

マイクロホン      1 

イヤホン      1 

フェライトコア     2 

CD-ROM（付属ソフト）    1 

（取扱説明書） 

簡易取扱説明書    1 

インストールマニュアル    2 

AC アダプタ     1 

 

 

 オプション 
拡張ユニット     AU-LX100EPIO 

バッテリエンクロジャー    BU-81 

バッテリパック     HP-30L （パコ電子工業製） 

バッテリパック充電器    KH-2S （パコ電子工業製） 

車載アダプタ     TZ-LXVM 

フロントハンドル     TZ-LXFH 

カラー液晶リモコン    ER-LXRC100 
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保証規定 

 保証規定 
 ハードウエア保証規定 
■ 保証期間はお買い上げ日から 1 年間です。 

取扱説明書、本体貼付ラベルなどに従った正常な使用状態で、保証期間内に故障が発生した場合には、最寄りのティア

ック株式会社(以下、弊社といいます)営業所、またはサービス部門が無料修理いたします。 

 

■ 保証期間内に故障して無料修理を受ける場合は 

本製品の取扱店、最寄りの弊社営業所、またはサービス部門にご依頼下さい。なお、離島および離島に準ずる遠隔地へ

の出張修理を行った場合には、出張に要する実費を申し受けます。 

※ データ、記録媒体、弊社製以外の装置又は部品、機構、付加物、改造を事前に本製品から取り外して下さい。 

 

■ 次の場合には保証期間内でも有料修理となります。 

1) ご使用上の誤りおよび不当な修理や改造による故障および損傷 

2) お買い上げ後の輸送、移動、落下などによる故障および損傷 

3) 火災、地震、水害、落雷、その他の天災地変、公害や異常電圧による故障および損傷 

4) 接続している他の機器に起因する故障および損傷 

5) 異常摩耗、異常損傷を除き、自然消耗とみなされた消耗部品による故障および損傷 

6) 特殊業務または特に苛酷な条件下において使用された場合の故障および損傷 

7) 点検のためのメンテナンス 

 

■ 上記保証は、日本国内においてのみ有効です。 

 

■ 上記は、弊社の保証の全てを規定したものであり、法律上の瑕疵担保責任を含む全ての明示又は黙示の保証責任

に代わるものです。弊社の保証責任は、本製品の修理又は交換に限られます。弊社は、いかなる場合にも、お客様の逸

失利益及び第三者からお客様に対してなされた賠償請求に基づく損害については責任を負いかねます。 

 

■ 保証期間経過後の修理は 

本製品の取扱店、最寄りの弊社営業所、またはサービス部門にお問い合わせ下さい。 

 

 ソフトウエア保証規定 
ティアック株式会社(以下、弊社といいます)は、ご購入日から 90 日間、本ソフトウエアが、取扱説明書に記載の環境を満た

すコンピュータ上に正しくインストールされた場合、取扱説明書に記載の機能を履行することを保証します。但し、弊社は、

本ソフトウエアの操作が中断しないことや誤りのないことを保証するものではありません。本ソフトウエアが保証期間中に所定

の機能を履行しない場合、お客様は、ご購入店を通じて修正を要求することができます。万一修正不能な場合は、返金

手続きをとらせていただきます。 

派生的損害の免責: 弊社は、本ソフトウエアの使用や使用不能から生じたいかなる損害（事業上の損失、営業の中断、

営業上の情報の損失、その他の金銭上の損害など）についても責任を負いません。たとえ、その損害の可能性が弊社に事

前に知らされていたとしても同様です。 

 

上記保証は、日本国内においてのみ有効です。 

 

 

7-4 



ユーザー登録のおすすめ 
 ユーザー登録のおすすめ 

登録いただいたお客様には本製品のサポートについての情報や新製品などの情報をお知らせいたします。 

また、当社が妥当と判断した特定のバージョンアップを無償にて実施させていただきます。 

登録いただくには次の3つの方法があります。 

 

■ オンライン登録 

下記ウェブサイトにて登録して下さい。 

URL: http://www.teac.co.jp/industry/measurement/index.html 

 

■ ファックスによる登録 

下記の<ユーザー登録記入欄>に必要事項を記入いただき、 

このページをコピーしてファックスして下さい。(FAX: 042-356-9185) 

 

■ 郵送による登録 

下記の<ユーザー登録記入欄>に必要事項を記入いただき、このページをコピーして郵送して下さい。 

 

宛先: 〒206-8530 東京都多摩市落合1-47 

ティアック株式会社 情報機器事業部 BS ビジネスユニット 営業部 

 

 

ユーザー登録記入欄 

型名 LX- 

シリアル No.  

ご購入日  

貴社名  

ご所属  

ご担当者  

ご住所  

TEL  

FAX  

E-mail  

E-mail による情報提供 □ 希望しない 

備考  

 

 

 

 

 

 ティアック株式会社  http://www.teac.co.jp/ 
 
 本社・営業部 〒206-8530 東京都多摩市落合 1-47 TEL 042-356-9161 

 大阪営業所 〒564-0052 大阪府吹田市広芝町 4-1 ミタカビル 4F TEL 06-6330-0291 

 広島駐在 〒738-0053 広島県廿日市市阿品台 2-5-31 TEL 0829-39-7061 

 名古屋営業所 〒465-0093 愛知県名古屋市名東区一社 1-79 TEL 052-709-5077 

     第六名昭ビル 2F(A-5)  
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